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1 Introduction

The digital photographic medium is currently on an unprecedented roll, and 
ever-increasing numbers of people are beginning to experiment with the chal-
lenges and rewards of this most modern medium. Thanks to the digital revolu-
tion, architectural photography, with its endless variety of exciting subjects, has 
won many new fans among beginners and experienced photographers. Architec-
tural photographers today are blessed with endless creative ways to capture and 
display their subjects. 

It is said that a picture is worth a thousand words, and this is particularly 
true in the field of architectural photography. There is no better medium than 
a balanced, well-taken photograph for capturing and displaying the look and 
feel of a building. This book uses numerous pictures to illustrate the concepts 
described in the text, and it provides answers to many theoretical and practical 
questions regarding equipment, technique, and the reasons buildings sometimes 
look so different in a photo than they do in reality. There are also comprehensive 
sections on ways to improve your images and the opportunities presented by the 
magic of digital image processing.

You will quickly find that architectural photography is a unique and fasci-
nating photographic genre. 



2 Introduction

1.1  What Is Architectural Photography? 

The term “architectural photography” describes both the subject (architec-
ture) and the means of capturing it (photography). 

The word “architecture” comes from the Greek “arkhitekton,” which consists 
of roots meaning “chief” and “builder.” Architecture is ubiquitous in our lives, 
and its primary function as shelter encompasses a great many functional uses. 
Architecture is practically a human’s second skin. Le Corbusier once said, “Ar-
chitecture is one of the most urgent needs of man, for the house has always 
been the indispensable and first tool that he has forged for himself.” 

Architecture takes on an extremely broad range of forms, from simple, pri-
meval huts, to the ornate temples of antiquity, the purely functional factories 
of the industrial revolution, and the urban concrete and glass landmarks of 
today. Without architecture, mankind would have remained anchored in the 
stone age with few options of places to live, sleep, eat, work, trade, produce, 
withdraw, rest, administer, and educate. In many regions, climatic conditions 
would make life without architecture impossible. 

The word “photography” comes from the Greek “photos” and “graphé,” 
which means “drawing with light,” and describes a technical means of optically 
capturing the likeness of objects and making them palpable in places where 
they cannot normally be seen. Photography thus propagates images of build-
ings into the wider world, enabling people to view them in a wide variety of 
circumstances—whether in newspapers, books, posters, the Internet, or in 
galleries or museums. 

1.2  The History of Architectural Photography 

1.2.1  Early History

The history of architectural photography stretches back to the beginning of 
the 19th century when the very first photographic attempts were made. Prior 
to these experiments, the extreme significance of architecture to mankind 
gave rise to the first paintings of buildings in ancient times (fig. 1). Paintings of 
buildings are two-dimensional representations of three-dimensional objects, 
although they are not as directly connected to specific buildings as architec-
tural photographs. Renaissance painters like Michelangelo or Raphael painted 
bold architectural visions (fig. 2). During the Baroque period, painting was 
used as an integral part of many architectural designs—wall and ceiling fres-
cos often served to enhance the design of the building itself, and painted sur-
faces were used to extend the appearance of architectural space (fig. 3). 

Around the same time, architectural subjects began to represent an inde-
pendent genre, especially in the context of Dutch Baroque painting. Public 
squares and buildings were reproduced in context and in great detail (fig. 4). 
Other artistic techniques, such as etchings that were popular at the time, also Fig. 1: A mural in Pompeii, 1st century AD
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Fig. 2: Raphael, The School of Athens, Stanza della Segnatura, Vatican City, 16th century fresco

Fig. 5: Matthäus Merian, Lübeck, 17th century, etchingFig. 4: Jan van der Heyden, The Church at Veere, 17th century,  

oil on canvas

Fig. 3: Cosmas Damian Asam, ceiling fresco in 

Ettlingen, late Baroque period

used architecture as their subject. European cityscapes by 
Matthäus Merian (fig. 5) are a particularly good example 
of this subgenre. In 18th century Italy, the popular veduta 
paintings represent extremely realistic landscapes and 
cityscapes. While creating his famous paintings of Venice 
and Dresden (fig. 6), Bernardo Bellotto used the camera 
obscura as a technical aid to producing realistic work. The 
idea, which goes back to Renaissance times and was also 
used by the Dutch Baroque painters, is considered to be 
the forerunner of the modern photographic camera. In 
Bellotto’s era, the device took the form of a portable box 
with a lens that projected the view in front of the lens 

Fig. 6: Bernardo Belotto, View of Dresden, mid- 18th century, oil and 

tempera on canvas
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onto a ground glass screen. This enabled the artist to accurately reproduce the 
perspective of the chosen scene (fig. 7). This guarantee of precise perspective 
in paintings and drawings encouraged continued development of the camera.

1.2.2  The Invention of Photography

Although the camera obscura and light-sensitive materials had already been 
discovered, the invention of the modern photographic process did not take 
shape until the beginning of the 19th century. In 1827, Nicéphore Niépce used 
an exposure of several hours and an asphalt-coated plate to capture the view 
from his window. He called the resulting image a heliograph (fig. 8). This earli-
est surviving photograph encapsulates one of the hallmarks of an architec-
tural photo, namely, a depiction of perspective. This image is, coincidentally, 
also the first architectural photograph, even if the subject was chosen for prac-
tical rather than aesthetic reasons. Alongside still lifes, the static nature of ar-
chitectural subjects made them popular in the early days of photography 
when extremely long exposure times made it impossible to capture moving 
subjects. 

At around the same time as Niépce, Louis Jacques Mandé Daguerre and Wil-
liam Henry Fox Talbot were experimenting with ways to capture photographs 
that involved exposure times of just a few minutes. Daguerre’s street scenes 
(fig.  9) are famous examples from this period. His Daguerrotype images were all 
unique and unfortunately cannot be duplicated. Fox Talbot’s Calotype process 
couldn’t reproduce the same level of detail as Daguerre’s plates, but its nega-
tive/positive principle made it possible to duplicate images once they had been 
captured (fig. 10).

The new medium developed quickly in the following years (fig. 11). An album 
of photographs of the world’s most famous buildings was presented in Paris in 
1841, and by the end of the 19th century, photographs were becoming an im-
portant element of architectural books and magazines. The disassembly, relo-
cating, and reassembly of Joseph Paxton’s Crystal Palace and the building of 
the Eiffel Tower in Paris were both documented photographically (fig. 12). Archi-
tectural photography began to be used to make foreign countries and cultures 
accessible to the general public, as well as to document the possessions of indi-
viduals and institutions. At this time, reproducibility and documentation were 
the main motivations behind architectural photography, so the resulting im-
ages were correspondingly static, conservative, and often cumbersome.

1.2.3  The Twentieth and Twenty-First Centuries

Changes in architectural styles following World War I brought changes in how 
buildings were photographed. The Bauhaus movement founded by Walter 
Gropius in 1919 began to consider photography as an art form, viewing the 
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Fig. 9: Louis Jacques Mandé Daguerre, Boulevard du Temple, Paris, 1838

Fig. 8: Joseph Nicéphore Niépce, View from the Window at Le Gras, 

Chalon-sur-Saône, 1827

Fig. 7: The Camera Obscura

Fig. 12: Pierre Petit, The Building of the Eiffel Tower, Paris, 1888Fig. 11: Mid-19th century cameras

Fig. 10: William Henry Fox Talbot, Boulevard des Capucines, Paris, 1843 
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medium as “the perfect combination of manual dexterity, technical progress, 
and artistic expression.” The German photographers Albert Renger-Patzsch, 
August Sander, and Karl Bloßfeldt practiced a photographic style termed “New 
Objectivity.” American artists like Walker Evans began to photograph purely 
functional subjects such as grain silos and factories. Using selective composi-
tion and unusual viewpoints of existing structures in their images, photogra-
phers began to give architecture a dynamic of its own. 

Technical progress in the following years increased the quality of architec-
tural photos, while outstanding photographers like Andreas Feininger experi-
mented with self-built cameras. It was Feininger who developed the world’s 
(then) largest telephoto lens, and with it a new way of taking photographs. The 
advent of pocket-sized 35mm cameras prior to World War II (fig. 13) encour-
aged spontaneous, subjective photography, and the medium became avail-
able to the masses. The flexibility of smaller camera systems transformed the 
camera into a new kind of notebook and gave birth to modern photojournal-
ism. Post-war architectural photography developed into a purely practical 
form of documentation, especially in Germany, and served mainly press and 
advertising purposes.

Artistic architectural photography began to develop as a genre toward the 
end of the 1950s. Artists such as Hilla and Bernd Becher systematically photo-
graphed anonymous, monumental industrial architecture, creating extensive 
sequences of images showing buildings in various states of decay. The idea of 
the documentary photo series gained worldwide popularity and blurred the 
distinction between “good” and “bad” architecture. Buildings that didn’t con-
form to the perceived aesthetic of modern architecture received just as much 
attention, and the advent of art galleries and the large-scale production of 
coffee-table books in the 1970s underscored the importance of the genre as a 
whole. Whether ancient or modern, grouped or freestanding, well known or 
unfamiliar, the range of potential architectural subjects is virtually unlimited. 

The popular photographic boom continued toward the end of the 20th 
century. International exhibitions travelled the world, and prices of photo-
graphs at auction reached previously unheard-of levels. The introduction of 
digital technology brought with it the ability to correct image perspective and 
distortion—tasks that were previously extremely difficult to perform. Tradi-
tional aspects of architectural photography, such as the documentation of 
construction sites, began to take on artistic aspects, giving architectural pho-
tography a twin role as an artistic and documentary medium.

The development of digital photography over the last 10 years hasn’t 
changed architectural photography per se, but has brought about enormous 
changes to the methods used to perform it. Although digital technology has 
banished 35mm and medium-format photography to the role of niche prac-
tices, large-format cameras capable of producing higher quality images than 
their digital cousins are still in widespread use, despite the high cost involved. 

Fig. 13: Leica II, 1932
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Fig. 14: A documentary architectural photo

1.3  Authenticity in Architectural Photos

Just like the field of architecture itself, there are various approaches available 
to shoot architectural photographs, ranging from purely functional to com-
plete artistic abstraction. 

Documentary architectural photography walks a narrow path between pre-
senting a neutral visual experience and an authentic representation of the in-
herent values of a building (fig. 14). Here, the composition has to limit itself to 
communicating information—otherwise, the building will lose its central im-
portance and the photo itself will become the center of attention. 

This raises the question of whether it is possible to shoot truly authentic ar-
chitectural photos. Even the most perfect, realistic architectural photo has a 
certain degree of intrinsic abstraction, if only due to the artificial scale of the 
reproduction or the lack of a third dimension. Ergo, it is impossible to portray a 
building absolutely authentically using external media. Additionally, a photo 
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can only reproduce the emotions felt by the viewer in a given situation. In oth-
er words, the way a building is perceived where it stands is often completely 
different from the way it is perceived in a photograph. In his essay “Medien 
zwischen Sein und Schein” (”Media Between Myth and Reality”), published in 
2000, the architect Meinhard von Gerkan said, “An architectural photo is al-
most bound to be a visual lie because the medium seems to represent the 
greatest possible potential objective authenticity, …true to the fact that a lens 
is an incorruptible technical device. We know it is an illusion.”

At what point does architectural photography become art, and how can we 
differentiate between artistic architectural photography and its documentary 
sibling? The transition between the two is difficult to pinpoint, but it is safe to 
say that art begins where the intervention of the photographer begins to influ-
ence the purely documentary nature of a photo. This is where the choice of 
subject is no longer intrinsically connected with the impression made by the 
building. A building can be the central element of an image without actually 
divulging its function. This process makes us increasingly independent from 
architecture itself, and objective representation loses significance. 

Further extrapolation of this line of thought unavoidably leads to the notion 
that a photo of a building can have a visual impact that is completely indepen-
dent from the nature of the building’s architecture. The quality of the resulting 
image will then, logically, be judged on the basis of its own artistic merits, and 
not on the quality of the building it portrays. Compositional techniques such 
as deliberate exaggeration, emphasis and omission, or simplification and dis-
tortion can be used to influence specific effects to the point where the build-
ing itself becomes the photographer’s plaything—a clear indication that we 
are, after all, dealing with art (fig. 15).

1.4  Forms of Architectural Photography

Architectural photography in various forms is part of our everyday lives.

Documentary architectural photography: Many documentary architectural 
photographs can be found in books, magazines, brochures, and construction 
documents. In these cases, architectural photography takes the form of multiple 
images with accompanying explanations, plans, or drawings that are designed 
to precisely describe a building and its attributes.

Postcard photography: Architecture is often the subject of postcards, even 
if the photographer’s intentions and degree of precision are not the same as 
those found in documentary situations. Postcards often serve simply as proof 
that the sender was actually in a particular place. Such photos serve only as 
a means of recognition and are often reproduced with oversaturated colors, 
over-the-top effects, and scant regard for technical prowess. 
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Fig. 15: An artistic architectural photo
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Vacation photography: Tourists often have similar intentions when they pho-
tograph churches, castles, and other landmarks: Such photos form personal 
memories. While architecture is part of the subject, the location is usually more 
important than the type of building. Interestingly, these types of photos are 
taken almost exclusively while on vacation. If located where one lives, buildings 
like these are considered neither newsworthy nor photogenic (fig. 16).

Advertising photography: Architecture often plays a role in poster, magazine, 
and TV advertising, and is often used to enhance the apparent significance of 
a product. Modern architecture stands for progress, technology, high quality 
of life, and glamour. For example, the automobile industry uses many manipu-
lated architectural images in its advertising, employing stylistic devices such 
as color adjustments, deliberate distortion, stylization, image blending, and 
artificial reflections.

Artistic architectural photography: Artistic architectural photographs can 
often be found in galleries and exhibitions, usually in the context of a particular 
theme or artist. Here, architecture serves only as a means to an end, with no 
particular connection between the message of the image and the message 
conveyed by the architecture itself. In this case, it is the photographer and not 
the architect who is the focus of the activity.

Fig. 16: Although architecture is the subject of this vacation photograph, the building is much less important than the location 
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2 Camera Technology

This chapter will help you to decide which equipment to use for your architec-
tural photography. I will consider your personal requirements and intentions 
and how they can influence your choice of camera. I will also discuss which 
lenses and accessories are best suited for capturing a variety of architectural 
subjects. 

First and foremost, I would like to stress that you don’t need a lot of equip-
ment to take high-quality architectural photos. A good photographer can make 
fascinating photos with the simplest of cameras, while less talented people are 
unable to produce quality images using even the most elaborate and expensive 
gear. Expensive equipment is not the key to successful architectural photos—the 
crucial factor is always the person behind the camera. The camera is only a tool 
used to help you realize a photographic idea. 

The photographer Andreas Feininger once said, “The fact that a (in the 
traditional sense) technically deficient photograph can have greater emotional 
impact than a technically flawless picture probably comes as a shock to those 
who are naive enough to believe that technical excellence alone is a measure of a 
value of a photograph.”

Nevertheless, a set of equipment selected for its suitability to your personal 
shooting style greatly simplifies the photographic process and forms the ideal ba-
sis for successful photos. 
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2.1  Advantages and Disadvantages of Digital Cameras

Until recently, the most important choice a photographer had to make was 
between digital and analog systems. Nowadays, digital technology has super-
seded analog equipment for virtually all types of photography. However, digi-
tal technology has its shortcomings too, and every photographer has to learn 
to deal with them in the course of his/her work.

2.1.1  The Number and Availability of Images

One of the great advantages of digital cameras is their ability to display results 
immediately. The data captured by the sensor can be instantaneously ana-
lyzed and processed. Poorly exposed images no longer represent a waste of 
expensive material and can be quickly analyzed and deleted. In contrast to the 
analog process, shooting digital photos doesn’t require the purchase and use 
of film and no longer involves complex development or digitizing processes. 
Once an image file has been transferred to a computer—either wirelessly or by 
using a memory card—it can be immediately viewed, processed, published, or 
printed. 

A digital memory card holds many more images than the limited number of 
shots analog film allows, making it (theoretically) possible to simply keep 
shooting until you have captured the perfect picture. For analog photogra-
phers, more photos means more time and more money on film and process-
ing. This apparent disadvantage can, however, make the photographer think 
harder about each individual shot and prevent excessive use of the shutter 
button. The compulsion to shoot the next free digital image can lead to hur-
ried compositions. If they are not careful, digital photographers can easily end 
up producing a huge number of images of insufficient quality.

2.1.2   Resolution and Tonal Range

Today’s digital image sensors provide higher resolution than analog film with 
the same format. Only large format sheet film cameras used in combination 
with high-quality digitizing processes can offer greater resolution and better 
detail rendition. The sheer number of pixels built into a digital image sensor 
means that you are virtually unlimited in the size of the prints you can make, 
especially if you consider that viewing distance normally increases with the 
size of a print anyway and that it is effectively impossible to perceive fine de-
tails—or the absence thereof—at these greater distances.

Things look rather different when it comes to reproducing the dynamic 
range (i.e., the range of contrast) in a scene (fig. 17). Depending on the expo-
sure metering setup and the equipment used, negative film can reproduce 12 
stops or more of contrast and reacts less sensitively to critical, high-contrast 



13Advantages and Disadvantages of Digital Cameras

Fig. 17:  

The limited dynamic 

range that digital cam-

eras (especially digital 

compacts) can reproduce 

has caused burned-out 

highlights in the sky 

(shown at top). These 

areas contain virtually no 

image data that can be 

rescued during process-

ing. A camera with 

greater dynamic range 

(due to a larger and/or 

higher quality sensor) 

reacts better in this type 

of high-contrast situation 

and gives the photogra-

pher more room to 

maneuver during subse-

quent image processing 

(shown at bottom).
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situations. If you use a reputable photo lab that employs good development 
and scanning techniques, you will retain high-quality image data even after 
digitizing your images. Analog material also has fewer problems than digital 
capture techniques in potentially overexposed image areas, and tends not to 
produce the burned-out highlights common to digital image sensors. Digital 
photographers have to pay more attention than their analog counterparts to 
lighting conditions and exposure settings, or they can alternatively play it safe 
by shooting a bracketed sequence and merging the exposures later during 
photo editing (section 3.9.5).

Nowadays, some medium format digital backs and some high-quality digi-
tal cameras (especially those that feature a full-frame image sensor) are capa-
ble of reproducing 11 or 12 stops of contrast at low ISO values, and are thus 
rapidly catching up with the equivalent analog processes. Skillful use of RAW 
processing tools (section 4.1.1) can also help to recover details that initially ap-
pear lost in under- or overexposed image areas without dramatically reducing 
image quality.

Because maximum reproducible dynamic range is directly related to the 
size of each pixel in the sensor, cameras with considerably smaller sensors are 
only capable of reproducing up to nine stops of contrast.

2.1.3  Image Noise and the “Look” of an Image

Compared directly, digital images appear much less noisy than digitized ana-
log images taken at the same ISO sensitivity. While analog film grain usually 
appears as uniform background noise (fig. 18), digital cameras set to high ISO 
values tend to produce blotchy color noise (fig. 19) alongside the more com-
mon luminance noise, and banding (fig. 20) in darker images areas. These digi-
tal artifacts are generally considered to be more distracting than analog grain 
effects. Therefore, most digital cameras have noise reduction algorithms built 
into their firmware, although this usually causes a loss of detail definition when 
it is switched on.

Noise (or a lack thereof) is a relative notion that very much depends on the 
individual viewer’s perception, and which is often overstated when judging 
the quality of an image. Analog grain and digital noise are both much less irri-
tating when viewed in a print or at reduced size on a website than when 
judged at 100 percent magnification on a computer monitor. 

Many people consider analog images to look somehow more natural and 
harmonious than their often slightly sterile or artificial-looking digital counter-
parts. This is partly because the random arrangement of the silver halide crys-
tals in analog film more closely represents the chaos present in nature than the 
strict, geometrical arrangement of pixels in an image sensor. Many analog 
photographers use the grain present in high-sensitivity films deliberately as a 
stylistic device, and there are a number of software manufacturers who offer 
programs and plug-ins that digitally simulate the look of analog film material. 

Fig. 20: Striped noise artifacts—an effect also 

known as banding

Fig. 19: Typical digital color noise

Fig. 18: Analog film grain
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Fig. 24: A dust particle on an image sensor

Fig. 21: Moiré artifacts caused by superimpos-

ing two patterns

Fig. 22: False Color artifacts may appear in the 

form of colorful stripes that aren’t actually 

present in the subject

Fig. 23: “Staircase” aliasing artifacts

2.1.4  Image Artifacts 

For technical reasons, digital image sensors produce a number of types of 
artifacts that confront photographers under various circumstances. 

Moirés (fig. 21) occur where patterns intersect and cause interference. 
These appear in digital images when fine textures in the subject interfere 
with the pattern of pixels on the surface of the image sensor. Bayer Pattern 
sensors (page 17) also produce additional False Color, due to the necessity 
of interpolating color values from neighboring pixels (fig. 22). The geometric 
patterns created by the arrangement of the pixels on the sensor also cause 
so-called aliasing artifacts, which take the form of zigzag (or staircase) pat-
terns in diagonal lines (fig. 23). To counteract these effects, camera manufac-
turers often insert multi-layered low-pass filters in front of the camera’s sen-
sor. Simply put, these filters apply a soft focus effect to the incident light, 
which reduces the strength of the effects described above. This causes a re-
duction in image detail and the maximum sharpness the sensor can repro-
duce. 

Camera manufacturers are constantly stiving to develop systems that pro-
duce the best possible compromise between image sharpness and the inci-
dence of digital artifacts. Meanwhile, there are some (mostly professional) 
camera models on the market that deliberately do not include low-pass fil-
ters to avoid the resulting loss in sharpness. Nature photographers, for ex-
ample, whose images document fine organic patterns and textures, benefit 
from capturing the utmost detail resolution and therefore may choose to use 
cameras without low-pass filters. Conversely, for architectural photography, 
low-pass filters help to avoid patterns and artifacts in building structures, 
which are very difficult to correct afterward, so this benefit heavily outweighs 
the modest gains in sharpness when not using a low-pass filter. 

Because the silver halide crystals in analog film are of varying sizes and are 
arranged randomly, these problems do not occur in analog images. Another 
reason for the lack of artifacts in analog images is that, in contrast to the pix-
els in the widely used Bayer Pattern image sensors, the crystals in color film 
are arranged on multiple layers, rather than on a single flat plane. 

In spite of their built-in ultrasonic dust-removal mechanisms, digital cam-
eras with interchangeable lenses are prone to getting dust and dirt stuck in-
side the camera body. Particles of dust that settle on the image sensor often 
produce obvious blotches, especially in images taken using small apertures 
(fig. 24). The best way to avoid this problem is to clean your sensor manually, 
even if this does involve quite a lot of effort. Make sure you use the proper 
tools when cleaning your sensor if you want to avoid damaging it perma-
nently, or have it cleaned professionally. 

Although dust or hair that sticks to analog film is simply wound on with 
the film, analog photographers still have to make sure there is no dust on the 
original or the scanner when digitizing their images, and the first processing 
step after scanning large format negatives is often dust artifact removal. 
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Therefore, modern scanners for 35mm films and slides usually have auto-
matic dust and scratch correction software built in.

2.1.5  Lens Quality

The rapid development of image sensors in recent years has seen a parallel 
increase in the demands made on camera lenses. High-resolution digital sen-
sors react more acutely than film not only to the quality and optical design of 
a lens, but also to the angle of incidence of the light reaching them. Light that 
hits film at an angle produces no specific problems (e.g., color shifts or lens 
casts), but in the case of digital sensors, light entering at an angle increases the 
risk of artifacts and vignetting, especially at the edges of the light-sensitive 
area. This effect is particularly prevalent when using wide-angle lenses due to 
the special nature of their optical construction and the flat angles at which in-
cident light can pass through the lens and strike the sensor. 

Retrofocus lenses, such as those often encountered with DSLRs, have highly 
complex optical constructions. You can easily recognize them because the ap-
erture looks noticeably narrower when viewed from the front than it does 
when viewed from the back. Retrofocus lenses are less susceptible to vignett-
ing and color shifts because of the substantial distance between the rear lens 
element and the image sensor. In contrast, perfectly or nearly symmetrical 
lenses, which are often found in view cameras or rangefinder cameras, have a 
much simpler optical design and accordingly are more compact, and they pro-
duce fewer aberrations and less pronounced distortions. On the other hand, 
the narrow gap between the rear lens element and the image sensor can be a 
problem, and this is especially true of wide-angle lenses, because the incident 
light can strike outside regions of the sensor at very flat angles. The result is a 
marked vignetting, especially seen with technical cameras, which is why you 
will often see photographers who are shooting with short focal lengths using 
a center filter to compensate for the light falloff at the outside of the image 
(without harming image quality). 

Color shifts are another potential consequence of having the rear lens close 
to the sensor. Such shifts occur near the edges of an image when using wide-
angle lenses and high-resolution digital backs (or when adapting a foreign 
lens from a rangefinder camera to a mirrorless camera). These color shifts can 
be corrected only with the involved process of using a so-called LCC (lens cast 
calibration) image. An LCC image can be created by holding an opaque filter, 
such as a milky pane of glass or a white balance filter, in front of the camera and 
then using the resulting exposure to correct the original image in a photo-ed-
iting program. This process effectively removes color casts, light fall-off, and 
even dust particles, if necessary, but not without some loss in image quality.

Nowadays, camera manufacturers design and build their lenses specifically 
to avoid these various artifacts. In other words, all newer lenses are construct-
ed with the requirements of digital cameras in mind. Many sensor  manufacturers 
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Bayer Pattern Sensors and Interpolation

The pixels in an image sensor capture the brightness, not the color, of the individual 
points in a subject. To create a color image from the data captured by its image 
sensor, a digital camera has to produce red, green and blue color values for each 
pixel. The RGB color model uses different brightnesses of these three primary colors 
to reproduce virtually all colors that occur in nature. 

Various techniques are used to convert the data captured by image sensors into 
color images, all of which use colored filters to create color data from the light en-
tering the lens. So-called “multi-shot” cameras shoot three separate images of the 
subject and position either a red, green, or blue filter in front of the sensor while doing 
so. The resulting images are then merged into a single full-color image.

Conventional DSLRs have to make do with a single shot in which each pixel can 
capture the brightness of just one of the subject’s three color components–the other 
two are then created using a simple trick. The sensor pixels are coated with a matrix 
of red, green, and blue microfilters, and the two missing color values for each pixel 
are then calculated on the basis of the colors captured by neighboring pixels. This 
process is called interpolation. 

The most widely used filter matrix pattern is the Bayer Pattern, which consists of 
50 percent green and 25 percent red and blue filters. These are arranged in groups 
of four pixels, each of which consists of two green, one red, and one blue pixel. This 
predominance of green reflects the physiology and sensitivity of the human eye. 
The use of neighboring pixels during interpolation ensures that each pixel in the 
converted color image contains color data that is not actually captured by the cor-
responding sensor pixel.

The arrangement of microfilters in a Bayer Pattern sensor 
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now use microlenses or concentrator lenses positioned in front of the individ-
ual pixels in the sensor to direct the incident light to the light-sensitive part of 
the pixel. For some combinations of cameras and lenses, it is even possible to 
use software algorithms to eliminate some artifacts in-camera immediately 
after a shot has been taken.

2.1.6  Digital Image Processing

In contrast to analog images, all digital image-processing techniques can be 
applied to digital images in the course of a computer-based workflow without 
the risk of image quality loss. Shooting in extreme situations suddenly be-
comes a lot easier when armed with the knowledge that most artifacts, anom-
alies, and distortion can be corrected later on a computer. Computer-based 
image processing is of central importance to architectural photographers, and 
new techniques such as panorama stitching (section 4.4) and high dynamic 

Fig. 25: This room interior features dramatically varied levels of brightness. Use of a bracketed sequence and post-processing helped manage this 

potential problem [focal length: 17mm, 0.5 – 1/60 sec. at f/11 and ISO 100].
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range imaging (HDRI) (section 4.5), give us a completely new view of our sub-
ject and make shooting in cramped spaces or under extreme lighting condi-
tions easier than ever before (fig. 25). 

2.1.7  Image Authenticity

Because of the difficulties involved in manipulating images captured on nega-
tive or slide film, they are often thought to be more authentic than digital im-
ages. Most people wouldn’t consider a digital image to be particularly well 
protected against forgery, as it is not a unique original, but is instead an end-
lessly reproducible and manipulable collection of bits and bytes. Nevertheless 
a new form of digital image forensics that concerns itself with the evaluation of 
the authenticity of digital images has emerged. The primary goal of image fo-
rensics is to determine the origin of particular images, but the field also con-
cerns itself with the detection of any form of manipulation to the digital image 
files. Digital image forensic scientists develop various algorithmic methods 
and processes for determining when it is highly likely that alterations to an im-
age have been made after the fact—but only when the picture at hand has a 
sufficient resolution with minimal compression artifacts present. In many cas-
es, the traces of manipulation are eliminated when pictures are dramatically 
reduced in size, as is often the case for JPEGs widely circulated on the Internet.

2.1.8  Archiving Images

Film may have a greater claim to authenticity, but digital photography has 
many advantages when it comes to image archiving: It’s not as easy to acci-
dentally lose a digital original because digital technology makes it possible to 
save, copy, and archive your images losslessly and, theoretically, forever. How-
ever, digital archiving must be planned and executed properly to avoid losing 
irrecoverable data. As a rule of thumb, files should be backed up in at least two 
separate physical locations. It’s all too common that data stored in only one 
location ends up getting lost because physical drives are susceptible to faults 
in reliability. In addition, various other threats ranging from material defect, to 
water damage, to heat, to strong magnetic fields can be enough to damage or 
completely destroy data files. Even the reputed external RAID-1 or RAID-5 sys-
tems, which automatically mirror files on two or more distinct drives, are not 
sufficient enough on their own for a sound digital backup process. These sys-
tems may be effective against single drive failures, but they don’t offer protec-
tion against software malfunctions, defective RAID controllers, viruses, or ac-
cidental deletion. Burglary, fire, and flood are other threats that justify ar-
chiving your files in two physically separate locations. Based on your 
preferences, you can store your duplicated files at a friend’s house, in a safe 
deposit box, or in the cloud using an online data backup service.

Advantages and Disadvantages of Digital Cameras
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2.2  The Camera

A camera has been the photographer’s primary tool for more than 150 years. 
This device is designed to depict everything within a certain angle of view in 
three-dimensional space and to capture it for posterity in two dimensions. Dif-
ferent types of cameras are suitable for different types of photography, and 
certain functions and capabilities determine whether a particular camera is 
suited to the field of architectural photography. 

So which camera is best for the job? You will see in the following sections that 
this is less a question of brand and more one of system type and sensor format. 

2.2.1  Types of Digital Cameras

The cameras available for shooting architectural photos range from normal 
compacts with tiny image sensors, through full-frame analog or digital camer-
as, right up to analog large-format models.

Digital Compacts and Bridge Cameras

The smallest image sensors available today are built into digital compact cam-
eras. These cameras are small and light and are therefore easy to carry. They are 
also simple to use, even for beginners. They are best suited for everyday snap-
shots.

Sensor size and efficiency: The greatest disadvantage of digital compacts is 
their tiny sensors. Large numbers of pixels packed into such a small space pro-
vide a relatively low light yield per pixel, making it necessary to artificially amplify 
the signals the sensor produces. This in turn reduces the dynamic range and 
increases the background noise in the resulting images. Noise is then combated 
in-camera at the cost of a further reduction in image detail. 

Fixed lenses: The small, fixed lenses built into digital compacts tend to produce 
a relatively large number of lens errors, especially toward the edges of the frame 
and especially for lenses with a large zoom range or particularly compact dimen-
sions. Fixed lenses also have a limited range of focal lengths, especially at the 
wide-angle end of the scale. This makes digital compacts particularly unsuitable 
for use in an architectural context. 

Other features of digital compacts: Composition is made difficult by small 
viewfinders and small, glossy monitors. The manual or semi-automatic exposure 
modes that are so important in architectural photography are rarely found or 
are difficult to handle in compacts. The lack of a RAW shooting mode (section 
4.1.1) is also a serious handicap.
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Although they look a lot more like DSLRs, so-called bridge cameras are subject 
to many of the same drawbacks as compacts, including small sensor size and 
limited wide-angle capabilities. But, unlike compacts, most bridge cameras 
support RAW image data formats and often have manual or semi-automatic 
exposure modes. 

 Four Thirds,  APS-C, and DX  DSLRs

Most DSLRs have sensors that are signifi cantly smaller than the traditional 
35mm image format (fi g. 26), often due to the simple fact that smaller sensors 
are cheaper to produce. 

The smallest DSLR sensors were built to the Four Thirds standard developed 
by Olympus and Kodak. These had a diagonal measurement about half the size 
of a 35mm fi lm frame and a corresponding crop factor (or focal length multi-
plier) of 2. This factor is a conceptual value aimed at helping the photographer 
to estimate the angle of view a lens will produce relative to the size of a 35mm 
frame. A 14mm lens used on a Four Thirds camera will depict an angle of view 
equivalent to that produced by a 28mm lens used with a full-frame camera. The 
focal length itself doesn’t change, and the equivalent focal length is calculated 
by multiplying the real focal length of the lens by the crop factor (in this case, 
14mm x 2 = 28). A newer system, the Micro Four Thirds system, uses the same 
sensor, but removes the mirror box from the camera design (see mirrorless 
cameras, page 25).

Compared with the Four Thirds standard, the APS-C format used by Nikon 
(DX format), Pentax, Sony, and others has a crop factor of about 1.5, while the 
APS-C format used by Canon has a crop factor of about 1.6. 

Due to the signifi cantly smaller image circle they have to cover, APS-C, DX, 
and Four Thirds lenses are more compact and lighter than their full-frame cous-
ins (fi g. 27). 

 Sensor size and light yield: The pixels in these types of sensors are distributed 
over a much larger area than those found in digital compacts, which means that 
each individual pixel is larger and can capture more light. This gives us greater 
dynamic range and better detail resolution in the resulting images. Today’s 
multi-megapixel sensors and high-end lenses virtually guarantee high-quality 
images that are perfect for subsequent computer-based perspective correction. 

 Viewfi nder image and  live view: The large, bright viewfi nders built into most 
DSLRs make composing architectural photos a lot easier, even in diffi  cult light-
ing conditions. Unlike the optical viewfi nders built into compact cameras, the 
mirror system ensures that you see exactly the same image in the viewfi nder 
as the one that will be captured by the sensor. But be warned, some entry-
level cameras don’t have a 100 percent viewfi nder image, which means that 
the photo you capture will actually be slightly larger than the visible frame. Live 

Fig. 26: The relative sizes of various digital 

image sensor formats compared with the 

traditional 35mm/full-frame format

The Camera
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Fig. 27 Full-frame (35mm) image circle
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view is now virtually standard in all DSLRs and is a great aid to manual focusing, 
especially when coupled with a magnifier function that enlarges a selected 
portion of the image on the monitor. Live view is especially useful if you are 
using manual lenses, and it often includes live histogram functionality, which 
simplifies the selection of appropriate exposure settings. 

Disadvantages of image sensor size: The general focal length shift toward 
the telephoto end of the scale caused by the crop factor is a welcome bonus 
for sports and wildlife photographers, but creates new challenges for architec-
tural photographers. Full-frame tilt/shift lenses (section 2.3.3) lose their wide 
angle of view when used in conjunction with smaller sensors, making them less 
useful than their designers intended. The same is true of many high-end, wide-
angle lenses that are relegated to the role of standard lenses by the crop factor. 
Nevertheless, the enormous range of interchangeable lenses available today 
ensures that you will usually be able to find a lens that suits your purposes—a 
huge advantage over fixed-lens cameras. 

Conclusions: Despite some limitations, APS-C, DX, and Four Thirds DSLRs used 
with wide-angle lenses are perfectly adequate in a range of situations and are a 
good choice for photographers who want to pursue architectural photography 
at a hobby level without making a large investment in specialized equipment.
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Analog and Digital Full-Frame Cameras

The 35mm analog format: Fixed, non-wide-angle lenses make analog 35mm 
compact cameras completely unsuitable for architectural photography, so 
they do not form part of our overall considerations. In contrast, in spite of the 
cost of buying, processing, and digitizing the photographic film, analog SLR 
cameras are a workable option for taking  architectural photos. The unique 
look of analog images is often a welcome change for photographers who have 
hitherto only taken and processed digital photos. 

The digital full-frame format: In the digital sector, manufacturers including 
Canon, Sony, and Nikon all offer full-frame (or FX) format DSLRs with sensors 
that are the same size as a traditional 35mm film frame. The 1:1 focal length 
equivalence means that you don’t have to get used to dealing with crop fac-
tors and equivalent focal lengths, and you can use tilt/shift lenses with their 
intended angles of view (section 2.3.3). Please note: all lenses that are not ex-
plicitly built for use with full-frame cameras (Canon EF-S, Nikon/Tokina DX, 
Sigma DC, Sony DT, and Tamron Di II), can only be used with full-frame cam-
eras under certain circumstances. Some optical elements in non-full-frame 
lenses protrude too far into the camera’s mirror box, and the smaller image 
circles they produce usually cause severe vignetting (fig. 27).

The viewfinder image: Larger image sensors require the use of larger reflex 
mirrors and viewfinder prisms, usually resulting in a large, bright viewfinder 
image that, in combination with a physical or virtual grid pattern, makes precise 
image composition much easier. 

Sensor size and light yield: The size of each individual pixel in a full-frame sen-
sor is significantly greater than that found in APS-C, DX, or Four Thirds sensors 
(fig. 28), which improves the reproducible dynamic range, noise characteristics, 
and basic per-pixel sharpness.

Disadvantages of the full-frame format: The full use of the image circle 
means that lens errors occurring toward the edges of the frame are more obvi-
ous, especially when you shoot at wide angles and/or at a wide aperture. These 
take on the form of distortion, vignetting, chromatic aberrations, or blurred 
details (fig. 37). To get the best out of a large sensor, it is recommended that 
you use the best quality lenses you can afford. Because full-frame sensors are 
expensive to produce, cameras incorporating them are also more expensive 
than models that use smaller sensors. If you are on a limited budget, it therefore 
makes more sense to use a less expensive camera with a smaller sensor and 
spend more on your lenses than it does to use an expensive full-frame camera 
with low-quality lenses. 
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Fig. 28: Comparison of pixel sizes: light yield per pixel

Fig. 29: Dispensing with the space required for a reflex mirror allows for adapting practically any nonsystem lens on a digital 

mirrorless camera
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Conclusions: If the quality of the lenses you use matches that of the camera, 
a full-frame DSLR is an ideal tool for architectural photography. The best mod-
els with very high pixel counts can even compete with digital medium format 
backs.

Mirrorless Cameras

A relatively new camera class is composed of digital mirrorless cameras ca-
pable of having their lenses swapped out but with a mirrorless design. These 
cameras dispense with the tilted mirror (and its swinging motion) that one 
finds in SLRs, allowing for a compact construction while still being able to pro-
duce an image quality on par with DSLRs, and they have sensor sizes that are 
comparable to those of the SLRs (fig. 29). Because the range of sensor sizes in 
this camera class varies so dramatically, however, not every mirrorless camera 
can be recommended for architectural photography. You generally should 
avoid using models with sensors smaller than the Micro Four Thirds standard 
(e.g., the CX format from Nikon with its crop factor of 2.7), opting instead to use 
cameras with larger sensor options, such as those with APS-C format or full-
frame sensors. The big advantage of cameras in this class is they feature dra-
matically smaller flange focal distances (section 2.5.7) because of their mirror-
less construction, which means practically any nonsystem lenses are at your 
disposal with the right adapter. When you do adapt lenses in this manner, 
though, take care to ensure that the lens in use has an aperture ring or that the 
adapter is capable of electronically relaying the exposure instructions from the 
camera to the lens.

Of course, these cameras also have their drawbacks: Mirrorless cameras lack 
the optical viewfinder that allows photographers to inspect the image area as 
is possible with standard DSLRs. Without this tool, you have to consult the 
camera display when setting up your shot, which can be difficult on sun-flood-
ed afternoons, or you can use the electronic viewfinder, if your camera has this 
feature. These options are limited by the sensor’s dynamic range, of course, 
but they also have potential advantages: a histogram can be superimposed on 
the live view and dark viewfinders don’t pose a problem because they can be 
electronically amplified and brightened. Furthermore, an electronic viewfind-
er presents the image exactly as it will ultimately be captured. Its live view, in 
other words, reflects the current white balance, for example, or any manual 
exposure settings. Cameras in this class tend to have a slightly slower autofo-
cus, but that isn’t usually a critical issue for architecture photography. Finally, 
the compact construction of these cameras can make them harder to handle 
and you have to be careful to avoid inadvertent movements while shooting. 
Users may find them less ergonomic owing to their smaller size, their fewer 
and smaller knobs and dials that can be difficult to reach, and the awkward 
balance caused by attaching a heavy lens to a light camera body. 

The Camera
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Analog and Digital Medium Format Cameras

Medium format cameras have always been less common in an architectural pho-
tography context than they are in studio or fashion photography. This is primar-
ily due to the fact that the construction of large format cameras makes them 
better for correcting perspective errors than their medium format cousins. 

Analog medium format cameras use roll film (the most common is the 120 
film format) with a larger surface area per frame than 35mm (full-frame) cameras 
(fig. 30), resulting in a kind of reverse crop factor. Classic film formats range from 
6 x 4.5 cm to 6 x 9 cm. For example, a 35mm medium format lens covers an angle 
of view that is equivalent to ultra-wide-angle for a full-frame camera. Compared 
with 35mm film, the increased surface area of medium format stock improves 
potential detail resolution and overall image quality. But again, these advantag-
es are gained at the price of increased material, processing, and digitizing costs. 
Medium format cameras are usually constructed in module form and consist of 
a mirror box, waist-level or pentaprism viewfinder, film holder (or back), and a 
lens. In contrast to 35mm cameras, most medium format models are fully manu-
al, although increasing numbers of autofocus models are beginning to appear. 
Because they are heavier, slower, and less flexible to use, medium format cam-
eras are hardly ever used for action, sports, or wildlife photography. Studio and 
landscape photography, conversely, is where these cameras show their 
strengths.

Ultra-high-resolution digital backs for medium format cameras, designed to 
be used in lieu of film, have been around for a while now. Today, many systems 
are designed strictly for digital-only uses, such as those from Hasselblad (fig. 31) 
or Phase One. Image sensors in digital backs range from being one and a half 
times bigger than full-frame sensors on the smaller end to double the size on 
larger end. You use a divisor of 1.27–1.56 depending on the model at hand to find 
the 35mm equivalent; in other words, the diagonal sensor length of a full-frame 
camera sensor is proportionally smaller based on this conversion value. As far as 
dimensions go, the largest digital medium-format sensors are comparable to 
“small” 6 x 4.5 cm medium format film, but still noticeably smaller than the di-
mensions you would find at the larger end of the medium format film world, 
such as in Hasselblad’s V or Mamiya’s RB/RZ series. Accordingly, the sensor cap-
tures only a fraction of the circular image area theoretically available from the 
medium format lens. 

Modern digital cameras in this class come equipped with autofocus capabili-
ties, but the speed of these systems is not comparable to what you find with 
standard full-frame cameras. There are excellent lenses with outstanding optical 
performance capable of providing exacting digital sensors with the finest of de-
tails across the entire image area. But the few wide-angle lenses often reveal 
various weaknesses such as pronounced field curvature and edge blurring with 
these cameras. Because of this particular deficiency and the lack of ability to use 
tilt/shift lenses, many architectural photographers opt for different camera sys-
tems, such as a technical camera.
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Fig. 30:  Image sensor and fi lm formats shown to scale

Fig. 31: A medium format digital camera
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Large Format Cameras 

Around since the mid 1800’s, large format analog cameras have no digital 
equivalent. They still represent the crème de la crème in the architectural pho-
tography arena and are also still used in product and advertising photography. 
They work on a principle that is almost as old as photography itself. These spe-
cialist tools are usually mounted on an optical bench or monorail (fig. 32) and 
are perfect for making perspective adjustments to an image during composi-
tion. The purely manual approach required when using large format cameras 
makes them much more time-consuming than other systems. They possess 
neither automatic exposure metering nor autofocus and their skilled use mir-
rors the skills required of a photographer 100 years ago. However, this lack of 
flexibility plays only a secondary role in the context of architectural photogra-
phy because the extremely high resolution and wide angles of view are unpar-
alleled. One of the major drawbacks of large format work is the high cost of film 
and processing, which can cost $50 and more for a single exposure. 

Digital sensors in large format sizes are practically unheard-of due to the as-
tronomical costs involved and the virtually nonexistent market. Nevertheless, it 
is possible to attach some medium format digital backs to large format techni-
cal cameras. Smaller manufacturers such as Alpa, Arca-Swiss, and Cambo pro-
duce high-end cameras for this niche market, which are capable of being paired 
with technical lenses from Schneider-Kreuznach or Rodenstock. Using this set-
up requires the use of ultra-wide-angle lenses when shooting architectural 
photos, though, because the sensor area is so small in relation. Such lenses have 
focal lengths from 35mm (24mm full-frame equivalent) to ultra-wide 23mm. 
For lenses with focal lengths of less than 35mm, the narrow image circle no 
longer allows you to make effective perspective corrections using shift move-
ments. One disadvantage to using these wide-angle lenses, which have nearly 
symmetric constructions, is that it’s impossible to get around needing to use a 
center filter and needing to always expose additional LCC images as a matter of 
regular practice because pronounced vignetting and color shifts are unavoid-
able. These cameras are definitely not suitable for working quickly on location. 
Without any sort of distance or exposure metering, photographers are com-
pletely dependent on their own experience or external tools such as laser dis-
tance meters and light meters. The live view available on modern digital backs 
compensates for the lack of an optical viewfinder. Other less precise alterna-
tives include external attachment viewfinders (fig. 34) or special mounts that 
can hold smartphones equipped with special optics run by apps that integrate 
with the camera to simulate a viewfinder image with an image border (fig. 33). 

 Again, for completeness’s sake, I feel I should mention scanning backs, 
which, when inserted into a large format camera like a film holder, capture the 
image line by line like a scanner. Needless to say, the lighting conditions and the 
subject mustn’t change during the scanning process, which is why this tech-
nique is used only for scientific or art reproduction purposes, and even those 
applications are becoming less common. 

Fig. 32: An analog large format camera

Fig. 33: Digital technical camera with a special 

smartphone attachment to serve as a view-

finder



29The Camera

Conclusions: Digital large format architectural photography, too, has its draw-
backs. The sophisticated capture methods result in extremely high quality im-
ages but at a great expense of time invested. Then there’s also the very high 
costs of equipment, which can be difficult even for professional photogra-
phers to justify. Many professional architectural photographers who use digi-
tal technical cameras also regularly use standard full-frame digital cameras as 
an additional tool. The future prevalence of technical cameras in the architec-
tural arena depends on this competition from full-frame devices that, by com-
parison, are relatively affordable yet still deliver great image quality. For the 
large-format class to establish a firm foothold, the development of affordable 
digital backs with large medium-format sensors, higher resolution, a very large 
dynamic range, and better image quality at high ISO values is needed. Another 
helpful development would be new lenses—especially in the wide-angle 
range—designed specifically for digital sensors that allow for significant ad-
justment without vignetting or color shifts. Additional innovative develop-
ments similar to the ALPA 12 FPS (fig. 34) or the HCam-B1 would also go a long 
way in attracting professional architectural photographers. These cameras 
have a focal-plane shutter, which renders the use of leaf-shutter lenses unnec-
essary, meaning you can combine powerful digital backs with a seemingly 
endless range of lenses, from technical to medium-format to full-frame lenses 
with a large image area (such as shift lenses). This is how a digital back can be 
paired up with, for example, the Canon TS-E 17mm 1:4L shift lens designed for 
digital full-frame cameras (fig. 35), resulting in previously unthinkable angles 
of view for digital medium-format equipment.

Fig. 35: A camera platform capable of allowing the pairing of a digital 

medium-format back with, for example, a full-frame shift lens 

Fig. 34: The ALPA 12 FPS is a shutter module that can function as an inde-

pendent camera when connected to a back, a lens, and the appropriate 

adapters
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2.2.2  Conclusions Regarding Cameras

The considerations detailed above show that there is no ideal choice of cam-
era for use in architectural photography, and every system has its strengths 
and weaknesses. Professionals are still hoping that a flexible, large format 
digital solution will be developed—one that approximates the quality of 
comparable analog cameras but are much easier to use. For now, some pros 
continue to use large format film which they later digitize, others use techni-
cal cameras with digital backs, and yet others use full-frame digital cameras 
with tilt/shift lenses or correcting perspective and converging verticals using 
image processing software. Currently, full-frame digital is the most flexible 
system available for shooting photos of buildings. It fulfills all of the genre’s 
basic requirements regarding sensor size, dynamic range, availability of 
wide-angle lenses, manual exposure settings, viewfinder quality, low run-
ning costs, etc. For hobbyists and advanced photographers on a budget, 
DSLRs with smaller sensors are a useful, lower-priced alternative. Mirrorless 
cameras are the best bet for anyone whose top concern is minimizing heavy 
or cumbersome gear. Analog SLRs still have their devotees too, although to-
day, it is virtually impossible to use the resulting images without digitizing 
them first. One thing is certain: digital and analog compact cameras are not 
suitable for architectural photography, as they offer neither wide-angle lens-
es nor sufficient image quality and handling flexibility (fig. 36).

Fig. 36: Keeping a small, high-quality compact camera on hand for the occasional snapshot is 

always a good idea, even though it’s no substitute for more advanced equipment
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2.3  Lenses

The lens you use largely determines the angle of view 
you can capture, the sharpness of detail, the minimum 
depth of field in your image, the possible shutter speed, 
and the degree to which lens errors are visible in the fin-
ished image. In short, the lens dictates image quality. If 
weaknesses in the construction of the lens mean that 
certain details don’t reach the sensor, these simply can-
not be captured. Most currently available analog and 
digital SLR bodies are suited to architectural use, but 
more care is required when choosing a lens. 

While sports photographers require long telephoto 
lenses with fast autofocus, and portrait photographers 
prefer medium telephotos with good detail definition at 
wide apertures, a lens that is to be used for architectural 
photography has to provide extremely good reproduc-
tion characteristics, an appropriate angle of view, and 
the ability to tilt and/or shift.

2.3.1  Reproduction Characteristics

Architectural photography requires the use of lenses 
that provide consistent reproduction with minimum 
lens errors and anomalies (fig. 37).

The large size of the subject, the wide angles of view, 
and the relatively large subject distances mean that se-
lective focus doesn’t play a significant role in our consid-
erations. Especially when shooting for documentary 
purposes, architectural photographers need to be sure 
that the entire subject is captured in sharp detail. For this 
reason, we often shoot with the lens stopped right 
down—a technique that also reduces vignetting effects, 
chromatic aberration (color fringing), and softness at the 
edges of the frame. Fringing and some softness are al-
most impossible to completely avoid, even at very small 
apertures. While chromatic aberration can be effectively 
counteracted using software tools, the edges of photos 
often remain less sharp than the center, especially if they 
were shot using cheap or mid-range lenses. The distor-
tion that a lens produces is independent of the aperture 
you use, and both barrel and pincushion distortion are 

Fig. 37: Lens errors (from top to bottom): Vignetting, chro-

matic aberration, edge softness, barrel distortion
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more evident at the extreme wide-angle and telephoto ends of the zoom 
scale. It is therefore important to compose your image with enough space 
around the subject to allow effective subsequent distortion correction. 

It is often said that the simpler optical construction of fixed focal length 
lenses generally produces better image quality than more complex zooms. 
This is, however, not always true, especially if we compare the image quality 
produced by older, analog fixed focal length lenses with that produced by 
newer zooms that are designed specifically for use with digital cameras, but 
only if the range covered by the zoom is not too extreme.

As long as the lens produces results of adequate quality, it is immaterial 
whether you use a fixed focal length or a zoom to take architectural photos. 
Price is often a good indicator of the quality you can expect to achieve; more 
expensive lenses are often constructed with better optical quality than en-
try-level or mid-range lenses. Don’t scrimp in the wrong place if you can help 
it: A cheaper camera with a more expensive lens is nearly always a better 
choice than the other way around.

2.3.2  Focal Length

In general, architectural photography requires the use of a range of wide-
angle lenses that capture a greater angle of view than standard or telephoto 
lenses. This also means that objects appear smaller on the image sensor or 
film. Ultra-wide-angle lenses are those with an equivalent focal length of 
24mm or less and an angle of view of more than 84 degrees (fig. 38).

If all buildings were constructed in an open environment with no interfer-
ing surroundings, we could, theoretically, take all of our architectural photos 
using one medium wide-angle lens. We could simply move around until we 
found the best possible viewpoint for a shot. However, in reality, the oppo-
site is nearly always true, and the choice of places from which a building can 
be successfully photographed is extremely limited. Most of the buildings we 
want to photograph are located in densely developed urban environments, 
and we can only take photos from the surrounding streets and squares. Op-
timum shooting locations are often inaccessible. Additionally, street signs, 
lamps, and vehicles intrude on a composition, so it is important to be flexible 
in your approach. This often means moving closer to the subject and using a 
shorter focal length lens. 

For exterior shots, we usually use lenses with focal lengths between 20 
and 35mm (fig. 39), while interior situations normally require focal lengths 
between 14 and 24mm (fig. 40). A short telephoto lens is also a great addi-
tional tool for capturing details of a building or shooting from greater dis-
tances. A useful architectural photography kit will therefore include lenses 
ranging from ultra-wide-angle to medium telephoto. Ideally, you will also 
include a tilt/shift lens or two in the mix.
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12 mm 24 mm 48 mm 100 mm 200 mm

12 mm 24 mm 48 mm 100 mm 200 mm

Fig. 39: The frequency of use of various focal lengths in exterior situations (full-frame equivalent)

Fig.40: The frequency of use of various focal lengths in interior situations (full-frame equivalent)

Fig. 38: 12mm full-frame, ultra-wide-angle interior shot
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Fig. 41: A 17mm full-frame wide-angle  

tilt/shift lens

Fig. 42: Converging verticals in this scene were prevented by using a 17mm tilt/shift lens

2.3.3  Tilt/Shift Lenses

Tilt/shift lenses (fig. 41) allow the photographer to make physical adjustments 
to the perspective in an image while shooting. They can be used to prevent 
the occurrence of converging verticals (section 3.4) and obviate the need for 
various quality-reducing correction steps during subsequent image process-
ing (fig. 42). They also make it easier to compose images, as they give the pho-
tographer more freedom in the choice of viewpoint and framing. Tilt/shift 
lenses allow you to create perspective-corrected two- to four-shot panoramas 
with increased angles of view and resolution (section 3.6.3). Apart from aper-
ture control, these lenses are usually fully manual and thus require you to se-
lect distance settings. 



35The Perfect Camera/Lens Combination for Every Budget

2.4  The Perfect Camera/Lens Combination for Every Budget 

Beginners: If you are a complete beginner, or if you are stepping up from a 
compact camera, an entry-level DSLR or a mirrorless camera in a bundle with a 
kit lens is a good starting point. All major manufacturers offer such kits for $1000 
or less, and they are a great way to take your first steps in architectural photog-
raphy. Thanks to modular systems with interchangeable lenses, it is simple to 
upgrade your system later on.

Hobbyists: For photographers who want to deepen their experience of archi-
tectural photography, I recommend the purchase of an additional ultra-wide-
angle zoom lens. These lenses generally cost around $500 and open up a whole 
new world of possibilities, especially in interior situations.

Ambitious amateurs: If you are serious about coming to grips with archi-
tectural photography, you should get hold of a mid-range DSLR or mirrorless 
camera, an ultra-wide-angle zoom lens, and a high-quality, mid-range zoom 
with a range that extends up to short telephoto. Selected fixed focal length 
lenses—one with a 35mm-equivalent focal length of 24mm, for example—are 
useful additions to a setup like this. But remember, you can easily spend $2,500 
or more kitting yourself out this way. 

Semi-pro: Photographers who are already experienced in various areas and 
who want to progress in the architectural arena should consider acquiring a 
full-frame DSLR and a set of high-end zoom and fixed focal length lenses. A tilt/
shift lens is also a useful addition to any full-frame kit, and a 24mm model is a 
good starting point. At this level, you can easily spend several thousand dollars 
on your equipment. 

Professionals: For most pros, the best is just about good enough. This usually 
means large format cameras with medium format digital backs supplemented 
by a top-of-the-line, full-frame camera and high-end, wide-angle lenses. Most 
pros have one or more tilt/shift lenses with them at all times, and sometimes use 
shift adapters to combine medium format lenses with their everyday camera 
bodies. Here, the costs quickly reach five figures. 

2.5  Accessories

The requirements for every architectural photographer don’t stop at just cam-
era and lens—some accessories are essential while others simply make life a 
whole lot easier. The following sections describe some useful items you can 
add to your collection of gear.
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2.5.1  Tripod

A tripod is a fundamental part of every architectural photographer’s kit 
(fig. 43). It is responsible for helping to deliver sharp, shake-free images, es-
pecially in low-light situations, whether indoors or out. But in daylight situa-
tions, too, gray filters and small apertures can increase shutter speeds to lev-
els at which a tripod is indispensable. You can, of course, shoot handheld 
whenever circumstances allow, but remember that a tripod is also a great aid 
to aligning your camera (page 38), and the steady viewfinder image a tripod-
mounted camera delivers also helps when composing an image. Using a tri-
pod, you have more time to make precise adjustments to your framing and 
to wait for the right moment to release the shutter. This way, you can simply 
wait until all the elements of your image (clouds, vehicles, passersby, etc.) are 
in the right positions and then release the shutter at leisure. 

Always use a stable tripod and make sure that you are not using it to the 
limits of its load capacity. If your camera is too heavy, even a light breeze can 
cause camera shake. Maximum mobility is not as important for architectural 
photographers as it is in other fields, so don’t worry too much about the 
weight of your gear. I can recommend tripods made by Gitzo, Really Right 
Stuff, or Berlebach if you can afford them, or by Manfrotto if you are on slight-
ly tighter budget.

While traditional tripods come in heights up to about 2 meters, super-
high camera stands may be used for special circumstances in architectural 
photography, particularly to establish a shot by rising above a distracting 
object in your line of view or to create a perspective from a bird’s-eye view. 
The maximum extension for medium models is in the 6 to 7 meter range and 
the tallest models range from 12 to 16 meters, or even taller yet. Super-high 
stands often feature a motorized pan/tilt head that can be controlled re-
motely from the ground. They tend to be difficult to transport due to their 
significant weight.

2.5.2  Tripod Head

The head you use is just as important as the tripod itself. Many heads are avail-
able separately, making it easier to choose exactly the right model for your in-
dividual purposes. The two main types are ball heads (fig. 44) and 3-way pan/
tilt heads (fig. 45), such as those controlled by gear mechanisms. Ball heads 
require the movement of just a single grip to move them in any direction and 
are consequently very quick to align. In contrast, pan/tilt and geared heads do 
not have the same agility and ease of use, but their separated planes of adjust-
ment are more precise and allow the most miniscule adjustments. Gear-con-
trolled heads, in particular, allow for the subtlest adjustments down to the mil-
limeter; a level of control that is not possible to replicate on a ball head. As al-
ways, the system you prefer is a matter of personal taste. Recently, some hybrid 

Fig. 43: A high-quality tripod is an essential 

tool for every architectural photographer

Fig. 44: A high-end ball head and quick-

release plate mounted on a tripod

Fig. 45: A premium pan/tilt tripod head with 

quick release plates



37

tripod head models have emerged that combine the mechanisms of ball heads 
and gear-controlled pan/tilt heads to offer the best of both worlds (fig. 46). 

As with your tripod, using an inferior-quality head can quickly cause frustra-
tion, especially if it slips once you have set it up. A ball head that you can’t 
properly lock makes aligning your camera a game of chance, so avoid purchas-
ing cheap tripod/head bundles if you can. The best tripod heads are manufac-
tured by Arca Swiss, Linhof, Markins, and Really Right Stuff. Saving money by 
purchasing a low-quality tripod will only lead to an additional investment fur-
ther down the line. Spending $200 or more on a tripod and about $150 on a 
high-quality head should ensure you years of trouble-free shooting. If this 
seems like a lot to you, just compare it with the total cost of your other camera 
gear and view it as a long-term investment in your photographic future. 

Quick-release plates and clamps (fig. 47) are a great option, and save a lot of 
time and effort when mounting and removing your camera from your tripod. 
Many tripods come with their own proprietary quick-release plate built in, al-
though the Arca-Swiss system has become something of a standard in profes-
sional photographic circles. 

2.5.3  L-Bracket and Panorama Head

For photographers who shoot a lot of portrait-format images, an L-bracket can 
also be a worthwhile investment. L-brackets are not cheap, but greatly simplify 
the switch from landscape to portrait format while keeping the center of grav-
ity of the camera/lens combination directly above the center of the tripod 
(fig. 48). L-brackets are available in generic form or as custom models designed 
to keep the controls and contacts for specific camera models easy to access. 
Panorama enthusiasts require their own special panorama heads (or nodal 
point adapters as they are often called), which are designed to preserve per-
spective and simplify camera alignment while shooting in the round.

2.5.4  Remote Release

Used in combination with a stable tripod and your camera’s mirror lockup 
function, a remote release is the final link in the chain of tools that ensure 
shake-free photos. You need to be able to shoot perfectly superimposed 
source images to create effective high dynamic range (HDR) images (section 
3.9.5), making a perfectly stable camera setup essential. Even pressing the 
shutter button can cause the camera to shift by a few pixels, which is where 
remote releases come into play. They are available in cable form or as radio and 
infrared controlled wireless versions, and some older SLR cameras even work 
with mechanical Bowden cables. Manufacturers’ own remote releases are of-
ten more expensive than third-party solutions, although both are usually 
equally as good. 

Fig. 47: An Arca-Swiss compatible quick-

release system atop a ball head

Fig. 48: An L-bracket, custom designed for 

the camera body shown

Fig. 46: A specialized tripod head that 

marries the control and advantages of a 

pan/tilt system with the flexibility of a ball 

head

Accessories
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Camera Orientation

Orienting your camera perfectly atop a tripod involves making minor adjustments 
to the tripod head while carefully examining the picture frame, ideally by using the 
camera’s viewfinder. One of the beauties of using a tripod is that it lets you focus 
entirely on your viewfinder image—everything outside of the image area can fall 
away. It’s always advisable to use a grid-focusing screen, if available, or to activate 
your camera’s digital gridlines to assist in precisely orienting your camera. These 
guiding lines make it much easier to capture the various straight lines in the exterior 
of a building, its windows and doorjambs, and even interior edges and corners at 
your desired orientation, making the entire composition process easier and reducing 
the time required for post-process corrections. If you’re orienting your camera so that 
it’s level, the integrated levels found on many tripod heads can be a big help in archi-
tectural photography in general, as well as when using a shift lens or when creating 
a panorama. Another useful method is to align the central horizontal gridline or the 
central measuring field in the viewfinder with the horizon line. If the horizon line is 
not visible in your photo, you can substitute various architectural elements of your 
subject that are located at the same height as the camera (= on the horizon). Doors 
are particularly useful for this because they generally stand out and they provide 
photographers with a strong sense of the dimensions and scale of the subject. A 
panning clamp on top of the tripod head can be particularly helpful for horizontal 
panning. If your camera is not level but is instead tilted slightly up or down, a  pan-
ning base, as you often see with ball mounts, makes panning the camera sideways 
easier (in which case the tripod should be positioned as straight as possible).
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Fig. 49: The user interface for a software 

application capable of wirelessly controlling  

a digital camera

If you don’t have a remote release on hand, you can also use your camera’s self-
timer function to release the shutter without touching the camera. The disad-
vantage of this approach is that you cannot precisely determine when the shut-
ter fires. Many wireless remote releases send an additional focus command to 
the lens before firing the shutter, so if you want to be sure that your focus setting 
stays put, you should deactivate autofocus before taking your shot. 

There are various other options for controlling your camera remotely via 
cable or wireless connection to a tablet, smartphone, or radio release trigger. 
These systems have several exposure modes such as interval or time-lapse ex-
posures, or even motion detection. Some systems are capable of streaming 
the camera’s live view over a smartphone and enabling the photographer to 
adjust focus, shutter speed, aperture, ISO, white balance, exposure compensa-
tion, and so on even while at a significant distance from the camera (fig. 49). 
Controlling these settings remotely is extremely helpful when working with a 
high camera stand. 

2.5.5  Lens Hoods

A lens hood (or sunshade, fig. 50) is an important accessory that should be pack-
aged with every lens. Unfortunately, this is not always the case, and accessory 
lens hoods are often quite expensive. They are designed to prevent stray light 
from entering the lens while not causing additional vignetting effects of their 
own (fig. 51). Unless you are using filters, there is no reason not to leave a lens 
hood attached to your lens at all times. Even at night, a lens hood can prevent 
light from streetlights or passing cars from spoiling a shot. They also protect the 
front element of the lens from dings, scratches, and the weather. If you do use a 
lens hood, make sure it is correctly locked into place, as a misaligned hood can 
cause unwanted shadows at the edges of the frame. You can also use your hand 
to block incident sunlight if a lens hood isn’t available.

Fig. 50: A “tulip” lens hood 

Fig. 51: A lens hood would have helped to 

block the sunlight and prevent the lens flare 

that is clearly visible in this image 
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2.5.6  Filters

Because of the ease with which we can apply effects to digital photos during 
post-processing, recent years have seen a significant decline in the use of lens-
mounted filters. However, some filter effects cannot be simulated digitally, and 
these are the filters that are still frequently used in architectural situations (sec-
tion 3.10). 

Polarizers: These filters (fig. 52) only transmit light that oscillates in the plane the 
filter is aligned to. They are used to suppress unwanted reflections from smooth, 
non-metallic surfaces such as windows or water, or to intensify the blue of the 
sky in areas at a 90-degree angle to the sun. They also increase the contrast 
between white clouds and blue skies. It is preferable to use circular polarizers 
with SLR cameras, as only these work correctly with the camera’s exposure and 
autofocus systems. The strength of the polarizing effect is regulated by rotating 
the foremost ring on the filter. 

Graduated filters: The most practical shape for a graduated filter is either 
square or rectangular. They are mounted in a special holder that is attached to 
the front of the lens, which allows you to selectively darken a chosen portion 
of the frame (fig. 53). This effect is particularly useful for balancing exposure in 
the two halves of high-contrast scenes, such as a landscape view with a dark 
foreground and a very bright sky. For our purposes, the most useful filters are 
those that do not darken in a linear way from the lower edge, but rather begin to 
darken in the middle and have a progressively darker tint toward the upper edge.

Neutral density filters: Neutral density (ND) filters (fig. 54) reduce the intensity 
of the light entering the lens by a predetermined amount, allowing you to use 
longer shutter speeds than would otherwise be possible. They are available in 
various densities in a range between one and 10 f-stops or more. A common use 
for ND filters in an architectural context is to create motion blur in brightly lit situ-
ations. I tend to use 3-stop to 6.66-stop ND filters, which correspond to density 
values of 0.9 and 2 respectively. There are are wide range of ND filters available, 
but be warned that quality is not worth skimping on because low-end ND filters 
tend to result in pronounced color casts. The higher the quality of filter glass and 
its coating, the lower the risk of reducing overall image quality. The best filters I 
know of are manufactured by B+W, Hoya, Heliopan, LEE Filters, and Haida.

2.5.7  Lens Adapters

Many DSLR owners assume they will only be able to use lenses made by the 
camera manufacturer or compatible third-party lenses from well-known man-
ufacturers like Sigma, Tamron, or Tokina. However, lens adapters allow you to 

Fig. 54: A neutral density (ND) filter  

mounted on a lens

Fig. 52: Circular polarizer

Fig. 53: A square graduated filter mounted 

in a holder
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attach older, manual lenses with M42, Olympus OM, Pentax K, Contax/Yashica, 
Leica R, or medium format mounts to various DSLR bodies (fig. 55). When used 
with contemporary DSLRs, Zeiss or Leica lenses, especially, can often produce 
better quality images than many modern high-end lenses. 

Adapted lenses have to be focused manually, which can be a problem with-
out the use of a split-image focusing screen. Recently, adapters have appeared 
with built-in focus-confirm chips. These allow the appropriate focus indicators 
to light up in the viewfinder when correct focus is achieved. You can also use 
the magnifier function in combination with your camera’s live view mode, 
which greatly simplifies focusing for stationary subjects. Focus peaking sys-
tems, which highlight in-focus contours in the live view, offer yet another po-
tential solution.

Unless using a so-called active adapter with electronic connections capable 
of relaying aperture information between the camera and the lens, adapted 
lenses won’t transmit aperture data to the camera, so any lens you use needs 
to have its own aperture ring. You then have to focus with the aperture wide 
open before stopping down to the working aperture and metering exposure 
using your camera’s built-in light meter. Once you have taken your photo, you 
have to reopen the aperture to focus your next shot. Of course, this all takes 
time, but is not a major hindrance in most architectural situations. 

Not all lenses can be adapted to work with all types of camera bodies. If the 
flange focal distance (i.e., the distance between the front of the lens mount 
and the sensor) is too large, the adapted lens will no longer be able to focus at 
infinity. This means that DSLRs with an especially large flange focal distance 
(such as Nikons) or lenses with an especially small flange focal distance (such as 
older Canon FD lenses) have particular limitations in terms of adaptability. If 
you really want to use unusual camera/lens combinations, you either have to 
simply do without an infinity focus setting or use a special adapter with addi-
tional built-in optical elements. The latter option can, however, lead to a re-
duction in overall image quality. Due to their short flange focal distance and 
the large diameter of the bayonet opening, Canon EOS cameras are the most 
easily adaptable DSLRs on today’s market.

Mirrorless cameras are without peer when it comes to the ability to use 
alternative lens brands. Thanks to their mirrorless design, these cameras have 
a particularly small flange focal distance. This characteristic means there is 
enough physical space for a large number of adapters, which, in turn, makes 
practically all DSLR lenses and many rangefinder lenses available (even when 
lenses without aperture rings necessitate the use of an adapter with integrat-
ed aperture control capabilities, fig. 56). You can, for example, use Leica’s re-
markable lenses from its M series. This breadth of options is not available for 
DSLRs, because of their significantly larger flange focal distance. Note that us-
ing ultra-wide-angle rangefinder lenses with full-frame image sensors in this 
way sometimes produces very strong color shifts (section 2.1.5) that have to be 
corrected afterward.

Fig. 55: Mount adapter for the use of  

other systems’ lenses

Fig. 56: : The user interface for a software 

application capable of wirelessly control-

ling a digital camera
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2.5.8   Grid Focusing Screens

As an aid to composition (section 3.8) and camera alignment, many cameras 
have built-in electronic grid lines that can be displayed over the image on 
the monitor.If your DSLR camera doesn’t have such a function, it is possible 
on some models to replace its standard focusing screen with one that has a 
permanent grid etched onto its surface. The vertical and horizontal lines give 
you a useful reference for lining up the edges and features of a building and 
they prompt you to hold the camera level, often reducing the amount of im-
age processing required later (fig. 58).

2.5.9  Memory Cards

Ever-changing shooting conditions make it difficult to judge in advance how 
many shots you will need to take to complete a job. There are days when it 
seems the pictures almost want to jump into camera on their own, while on 
other days all the pictures seem to be hiding. Always make sure you have a 
sufficient number of memory cards (or films) with you. If you like to shoot 
panoramas (section 3.7.1) or HDR or DRI images (section 3.9.5), the multiple 
shots necessary to create a single image quickly use up memory. RAW format 
image files often use more memory than you think, and files of 20 MB and 
more quickly eat up the available space. It can be useful to save additional 
JPEG copies of your images to make sorting them easier, but these too take up 
additional space on your memory media. Today’s low prices make carrying 
spare memory cards a must. In general, architectural photographers don’t 
need the fastest memory cards on the market (fig. 57), because midlevel ver-
sions tend to be fast enough to process even a bracketing sequence from the 
camera’s buffer. It’s best to stick with brand name products, however, because 
defects in low-end memory cards are to some degree inevitable.

2.5.10  Batteries

Always keep a spare battery charged and ready to use, especially in situa-
tions with no easily available charging facilities—and remember, the capac-
ity of rechargeable batteries is reduced in low temperatures (fig. 59). Exces-
sive use of the monitor and/or live view quickly drains a camera’s batteries, as 
does the use of an image stabilizer, whether it is lens or camera based. If you 
find your battery running down with no opportunity to recharge or replace 
it, switch off your camera’s automatic sensor cleaning function and auto-
matic monitor playback function. Switching the camera off between shots 
also helps to conserve power. An accessory battery grip with an additional 
portrait format shutter release button is a good alternative power source 

Fig. 57: A very fast SDXC memory card
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Fig. 58: The view-

finder produced by a 

grid-type focusing 

screen

Fig. 59: In low tem-

peratures, the capac-

ity of rechargeable 

batteries is notice-

ably reduced
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Fig. 60: In this photo,  

the otherwise unlit foreground  

has been brightened using off-camera flash
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and, in an emergency, most battery grips can also be 
powered using conventional batteries purchased from a 
nearby store. A battery grip also improves camera han-
dling for handheld portrait format shots. 

2.5.11  Flash

Flash is seldom used in architectural photography. Even 
the most powerful flash systems are too weak to illumi-
nate the entire exterior of a building. But for interior situ-
ations, off-camera accessory flash is used—usually in 
conjunction with reflectors or other light shapers—to 
provide accents or to brighten areas that are not illumi-
nated by natural or artificial light (fig. 60) and to match 
outside lighting conditions. Built-in pop-up flash or flash 
units mounted on the camera’s flash shoe have no prac-
tical use in architectural photography. Most architectural 
lighting is carefully planned during construction and 
therefore looks more natural without the use of artificial 
highlights anyway. Merging multiple images from a 
bracketing sequence using HDR or DRI techniques (sec-
tion 3.9.5) is a better way to enhance lighting accents.

2.5.12  Other Accessories

Other useful and inexpensive accessories include rain 
covers to protect your equipment from wet conditions 
and blower brushes for cleaning your sensor and lenses. 
Just in case dust or dirt sticks to the inside of your cam-
era, it is a good idea to carry some sensor cleaning wands 
with you. A two- or three-way spirit level with a mount-
ing foot that fits into your camera’s flash shoe is a great 
little tool for ensuring precise camera alignment. A high-
quality strap with sufficient padding and a pocket tripod 
(fig. 61) for spontaneous use on walls or tabletops both 
save hassle on long photo tours. It’s also practical to 
keep a gray card on hand to achieve proper white bal-
ance or to use as a makeshift tool (affixed to a flexible 
arm with a clamp) to shield your lens from unwanted 
stray light or sunlight. And, if you find you cannot get 
quite the right view using the camera monitor, an angle 
viewer is also a very useful accessory when  circumstances Fig. 61: A pocket tripod

Accessories
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demand that you position your camera very close to the ground. Finally, an 
LCD hood can be particularly helpful when bright conditions make it other-
wise difficult to view and adjust your photo.

To conclude: The importance of each accessory becomes most obvious at 
the moment you need it but don’t have it with you. 

2.6  Creative Tips and Tricks

The following sections are intended to give you a few ideas for increasing the 
level of creativity in your architectural photos. 

2.6.1  Lensbaby Lenses

Lensbaby accessory lenses are available in a wide range of types that are all 
designed to apply selective focus in one way or another (fig. 62). They allow 
you to produce creative focus effects in a way similar to tilt/shift lenses, with 
objects at the “sweet spot” in sharp focus while surrounding objects and 
scenery remain blurry. Lensbaby optics are not intended to produce ex-
tremely high-quality images, but rather to encourage artistic use of the opti-
cal characteristics embodied in the lens.

2.6.2  Black-and-White Film

A particularly creative approach to photographing buildings involves using 
black-and-white film (fig. 63) or simulating it digitally, either in-camera or 
during post-processing. Monochrome images offer increased potential for 
the interpretation of a scene and, under certain lighting conditions, contrast-
ing colors can end up producing exactly the same gray tone when converted 
to black-and-white. This loss of visual information often gives monochrome 
images a more abstract look, making the shapes and structures of a building 
a perfect playground for visual experimentation. Even in the digital age of 
bubble-gum colors, monochrome images still haven’t lost their appeal. Many 
people perceive black-and-white photos as having a special, more personal 
touch—an effect that can be enhanced by the grain effects produced by 
high-sensitivity film. Black-and-white photography becomes especially in-
teresting if grain is deliberately used as a stylistic device (fig. 180); the age of 
the building in question is then only of secondary importance. Regardless of 
its subject, a good monochrome photo immediately attracts the viewer’s at-
tention. Fig. 63: 400 ASA black-and-white film 

Fig. 62: A third-generation Lensbaby
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2.6.3  Fixed Focal Length Lenses

The additional brightness offered by fixed focal length lenses is less signifi-
cant in architectural photography than in other genres, and a many photog-
raphers think the added brightness doesn’t really compensate for their lack 
of adjustable focal length. It is nevertheless instructive to use just one or two 
fixed focal length lenses for a couple of sessions, as this forces you to pay 
more attention to the intricacies of your immediate surroundings. If you 
want to give it a try, consider using a single lens with a focal length of 28mm 
or two lenses, one in the 20–24mm range and another in the 35–45mm range 
(fig. 64). You will need more time to find exactly the right viewpoint, and you 
are sure to find yourself considering more alternatives. This exercise sharp-
ens your eye for your subject and helps you to become more familiar with 
your own approach to shooting. At the end of a day’s work, most photogra-
phers find that using fixed focal length lenses is not as limiting as they ini-
tially expected. 

Fig. 64: A photographer using this 21-mm wide-angle fixed focal-length lens in combination with a 

35-mm alternative would be prepared for a high percentage of shooting opportunities

Creative Tips and Tricks
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3 Shooting Techniques

This chapter addresses the “how” of architectural photography, and discusses 
all the aspects of a photo that should be considered during the shoot. A whole 
range of factors influence the look of an architectural photo, from things you can 
regulate (such as your own behavior), to things you cannot influence at all, like 
the weather or the ambient light. I will also show how different approaches to a 
shoot can produce very different results. You can portray a building in an imme-
diate, authentic way; as a more diffuse representation that has little to do with 
the original purpose of the structure; or even as a completely independent piece 
of abstract art.
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Fig. 65: A documentary architectural photo with a clear, uncluttered composition

3.1  What Makes a Great Architectural Photo?

A successful architectural photo depends on a well-thought-out composi-
tion and a clear form of expression. If a building is to be the central element 
of an image, there should be no other major elements that compete for the 
viewer’s attention. If, however, an image is designed to portray the relation-
ship between two buildings, the relationship has to be unequivocally illus-
trated to be effective. If you deliberately bend the rules of photography—as 
is often the case in artistic architectural shots—you have to make sure that 
this artifice is clear at first glance so that the viewer isn’t led to believe that 
the photographer simply wasn’t in control of the situation. 
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Fig. 66: A modern architectural photograph that includes elements of the building’s surroundings in its composition

A great documentary architectural photo captivates the viewer and com-
municates a clear, uncluttered message that immediately conveys familiarity 
with the building, even if the viewer doesn’t actually know it. It will also be 
composed entirely to serve the purpose of observation and to emphasize 
the quality of the building’s design (fig. 65). 

Modern documentary photography often includes aesthetic elements 
that are designed to soften the otherwise sterile look of the photo and to 
give the viewer the opportunity to develop a more authentic, personal feel 
for the building (fig. 66). 
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Fig. 67: An artistic architectural photo with a message that is independent of the structure of the building 

An artistic architectural photo is judged by the strength of its visual im-
pact and has less to do with the inherent qualities of the building itself. Suc-
cessful artistic architectural photography grabs the viewer’s attention, tells a 
story, visualizes contradictions, and raises awareness of an architectural envi-
ronment that would otherwise be only subconsciously perceived (fig. 67).

However, the way an individual image is perceived is still a matter of per-
sonal taste. While an architect may aim to impress the public with a clear-cut, 
shadow-free façade, a photographer may find the interplay of light and 
shade the most interesting part of the design. A viewer who is inexperienced 
in both professions may be impressed by an extraordinary effect on an ordi-
nary department storefront, or may find pleasure in just recognizing a famil-
iar building.
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Architects and Photographers: Different Ways of Seeing

The needs and desires of photographers and architects unavoidably collide in the world 
of architectural photography. Although both professions qualify as arts, architects and 
photographers tend to see things very differently. 

An architect designs and forms three-dimensional spaces, while a photographer 
is concerned with only two dimensions. An architect views a concept and a design as 
a constant that lasts over time, whereas a photographer is more concerned with the 
interplay of light and shade and the subjective effect of a building’s design at one par-
ticular moment.

Architects like to see photos that contain a maximum of visual information and that 
convey the dimensional and tactile effects of the structure in a pure, unadulterated 
fashion. A photographer’s interpretation can use framing and composition to produce 
a very different impression of the same building—an impression that can be seen by the 
architect to have a negative effect on the informational nature of the image. 

The fact is, every architectural photo represents an interpretation that can, from an 
architect’s point of view, endanger the authenticity and informational nature of a build-
ing’s appearance. This contradiction makes it especially difficult for an architectural 
photographer to satisfy both parties with a single photo.
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Fig. 68: In this example, the building is the dominant, central element of the image
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3.2  The Role of Architecture as a Photographic Subject

The central element of every architectural photo is the building. The sheer 
size of buildings makes them very different from almost every other type of 
photographic subject. An architectural photographer can not only photo-
graph the subject from outside, but can also step into the subject and capture 
images of its inner life. Additionally, a building is immovably connected to its 
environment, which means that the photographer always has to make the 
effort to visit the subject. 

Typically, all elements surrounding a building play a secondary role in the 
composition of an architectural photograph, resulting in an image with an 
unequivocal message (fig. 68). The significance of each individual building in 
images that contain more than one major structure can vary. Sometimes, a 
single building will dominate due to its size or central position, while at other 
times, the arrangement of multiple structures can give each a similar weight 
within the overall composition (fig. 69). This is often the case when several 
buildings form a homogenous pattern or are made of similar materials. What-
ever the physical arrangement, the building(s) remain the central element of 
the photo’s message. 

Fig. 69: Multiple buildings as part of a harmonious overall composition
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Fig. 70: In this example, the building and the secondary subject create balanced tension 

One of the major aspects of more artistic architectural photography is the 
inclusion of elements of the surroundings as part of the overall composition. 
This results in a redistribution of the significance of the individual elements in 
an image while the inclusion of trees, people, street signs, etc. increases vi-
sual tension. Here, the building is no longer the sole subject, but shares its 
significance with other subjects of equal value (fig. 70).

Images in which the architecture plays only a secondary role can neverthe-
less be considered as architectural photos—for example, if a building serves 
as a background for a subject or is visible as a reflection (fig. 71). It is even pos-
sible to capture architectural images in which a building, through clever use 
of composition and camera angles, is not actually recognizable as such. The 
result is a graphic image constructed purely from lines and shapes (fig. 72). 

It is therefore necessary to consider just how you want to portray a build-
ing before you begin to take pictures. 
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Fig. 71: Architecture as a secondary subject 

Fig. 72: An abstract architectural image

The Role of Architecture as a Photographic Subject
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Fig. 73: A central positioning of a modern building
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Fig. 74: Including the surroundings of this decrepit building produces an effective architectural tension

3.2.1  What Types of Architecture Make Suitable Subjects?

Generally speaking, any building in any state of repair can make a good photo-
graphic subject. A successful architectural photo doesn’t necessarily depend 
on the condition of the building; rather, the way a building is photographed 
determines whether the resulting image is pleasing. The best approach to 
shooting varies from building to building. A centralized, sunlit composition 
with the building as the dominant theme is often the best way to photograph 
modern office buildings (fig. 73), while the mood in a photo of an old building 
can be positively influenced by including some of its surroundings in the com-
position (fig. 74) or by dramatic weather conditions.
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An important exercise is to consider the various ways architecture is pres-
ent in everyday life. These range from ancient landmarks such as churches, 
castles, and palaces to strictly functional new buildings such as industrial 
production plants or warehouses. Spectacular public buildings are no more 
or less part of the architectural infrastructure than long-forgotten, con-
demned buildings (fig. 75), ruins out in the country, or ordinary urban apart-
ment complexes (fig. 76). Bridges, temporary construction sites, pyramids, 
bunkers, water towers, radio towers, and public restrooms are all part of the 
architectural whole that surrounds us (fig. 77). If a photographer is sufficient-
ly creative, all of these, and more, can become the subjects of excellent archi-
tectural photos. 

Stepping off the beaten path and exploring areas on foot is the best way 
to discover unconventional subjects for your architectural photography—
subjects different from the obvious tourist and landmark attractions. It’s not 
at all uncommon that a fascinating subject is just found around the next cor-
ner, right where you least expect it (fig. 78). 

Doing some research at home using websites such as Google Maps to 
view satellite images of your destination can go a long way in increasing your 
chances for discovering enticing subjects. Visiting online photography fo-
rums that make use of geolocation services with up-to-date maps, such as 
Panoramio, is another surefire way to develop a sharper sense of what to 
look for in a specific area and to discover previously unconsidered subjects 
for your work.

Fig. 77: An architectural photo of a bridge

Fig. 75: An old, dilapidated building Fig. 76: The use of a tight angle of view and a long focal length emphasize the repeated patterns 

and shapes in this urban residential building
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Fig. 78: An unconventional architectural photograph  

composed of various structural figures and  

elements piled on top of one another
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Fig. 79: Comparing various shots of a  

single subject 

Fig. 80: Various approaches to a composition 

3.2.2  Learning to See

Every photographer needs to have an innate feeling for particular situations 
and configurations of events in order to successfully identify interesting and 
unusual opportunities while out and about. The static nature of buildings 
makes it especially important to understand the spatial relations between 
various elements of a building. Ideally, you will be able to judge in advance 
which viewpoint will produce the best results, as this is one aspect of a photo 
that you definitely cannot alter later. If the overall composition of an image 
isn’t right during the shoot, even heavy image processing won’t help you to 
transform it into something better. The ability to “see” photographic subjects 
varies enormously from person to person. Some photographers instinctively 
find unusual images and new ways to portray apparently everyday subjects. 
They already have ideas about how to compose an image before others have 
even recognized the subject. But less instinctive people are not necessarily 
destined to be poor photographers, and can find comfort in Ansel Adams’ 
famous saying, “Twelve significant photographs in any one year is a good 
crop.” And remember, it is certainly possible to learn and practice seeing op-
portunities. 

So how should you set about training your photographic eye? One useful 
approach is to visit an area with a variety of architectural subjects on a num-
ber of occasions, and don’t be afraid to use up all of your available memory 
capacity if you are shooting digitally (fig. 79). If you sift through your images 
regularly, you will quickly learn to recognize which are worth keeping and 
which you can delete immediately. Sorting and judging your images helps 
you to learn what you can do differently next time. Revisiting a particular 
place also helps you to learn its strengths and weaknesses, and gives you the 
wherewithal to find new views and perspectives. This way, you are constantly 
honing your photographic skills and improving the quality of your images. 

Another way to sharpen your eye is to shoot a couple of overview shots of 
a subject and analyze them later. In this case, considering which parts of a 
subject would make an interesting photo if they were to be isolated or en-
hanced (fig. 80) gives you a better eye for the potential subjects within a 
broadly-composed image. You can also use image-processing software to 
perform experimental crops and to try out various ways of framing a scene. 
Once you have been through processes like these, it will be much easier to 
find new views of the subject next time you are there in person (fig. 81).

Yet another way to come to grips with the genre is to analyze coffee-table 
books of architectural photos. Ask yourself what is special about how the 
photographer has portrayed a building, or how the image is composed. Con-
sider why the angle of view chosen by the artist works and try to identify why 
you prefer certrain images to others. Most important, ask yourself what you 
would do differently. Studying high-quality, professionally produced images 
is a great way to gain new insights that you can add to your own repertoire 
the next time you are on a shoot. 



63The Role of Architecture as a Photographic Subject

Fig. 81: The results of realizing some of the ideas shown in figure 80
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Photographing Buildings: A Brief  Guide

Once you have chosen your subject, you need to analyze the situation and its specifi c 
characteristics: 

• Which side of the building is best suited to being photographed? Where are 
shadows or backlight positioned? What is the weather like? What other structures 
characterize the surroundings?

• What specifi c physical structures does the building have? Are there any interesting 
(or irritating) refl ections?

• How do you want to portray the building—in a documentary or an artistic style? 
Static or dynamic?

10 Paul Löbe PLOT 2 groß1  1 : 100
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The next step involves a detailed analysis of your subject’s surroundings:

• Which camera angle best emphasizes the building’s strengths?
• Which camera positions will deliver great shots and which are less suitable?
• Which elements of the building’s surroundings should you include in your shot, and 

which should you leave out?
• Do you want to shoot in landscape or portrait format?

The fi nal step involves selecting your camera settings and the accessories you will use 
to make the shot:

• Which accessories (tripod, fi lter, remote release, etc.) do you need?
• Which focal length lens is best for capturing your chosen composition?
• How do you want to compose your image? With the subject in the center? Using 

the Golden Ratio? Or with the subject positioned toward the edge of the frame?
• How will you avoid converging verticals?
• Which camera settings will produce a balanced exposure?
• What is the right moment to release the shutter? Which people, cars, or shadows 

are you waiting for? 
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3.3  Perspective

Taking photographs means capturing a three-dimensional space and convert-
ing it to two dimensions. The most important physical principle governing this 
transformation is the principle of perspective, which represents the effect of a 
subject’s space and depth in a two-dimensional plane. Perspective is funda-
mentally the projection of space onto a flat surface (fig. 82). Photographic im-
ages follow the rules of central projection, also called vanishing point projec-
tion, preserving the natural perception to which the human eye is accustomed.

The perspective effect in a photo is determined by the position the photo is 
taken from and the direction the camera is pointing. In other words, you can 
only change the perspective within an image by changing your viewpoint. The 
widely held belief that the focal length of the lens you use influences the per-
spective in the resulting image is, quite simply, false (fig. 83). The spatial effects 
produced by wide-angle lenses are due to the fact that they capture a wider 
angle of view. The actual spatial relations within a scene don’t change just be-
cause you alter the focal length of the lens you use to capture it.

Abb. 82: An illustration of the central projection 

of a cube with labels for (A) the point of sight, 

(B) the spatial object, and (C) the projection 

surface

A

B

C
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Fig. 83: Comparing perspective in two 

photos taken from the same place 

using two diff erent focal lengths 

[17mm and 32mm]

Perspective
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3.3.1  The Importance of Vanishing Points

Vanishing points play an important role in the portrayal of architectural (i.e., 
geometrical) forms. If parallel lines in three-dimensional space extend into 
the distance, a photographic image will represent them as intersecting on a 
defined vanishing point (Vp). If you point your camera directly at the horizon, 
all the vertical lines within the frame will appear vertical in your image. This 
is an effect that we often utilize when photographing buildings. 

The number of vanishing points in an image has a significant effect on its 
appearance. In the case of central perspective (not to be confused with 
central projection), all parallel lines going into the distance end up at a van-
ishing point located in the middle of the picture and at the horizon. You 
need to stand squarely in front of your subject and position your camera 
horizontally (and pointing at the horizon) to take pictures like this. This 
means that the front wall of the building you are photographing remains 
parallel to the image sensor plane, which keeps all the parallel lines within 
the building’s façade parallel in your image (fig. 84). Although this type of 
shot looks pleasing, it is also rather unspectacular. For some subjects it is also 

Vp 1 Vp 2Vp 1

Fig. 84: A building 

photographed using 

central perspective

Fig. 85: A building  

photographed using 

two-point perspective



69Perspective

Fig. 86: Worm’s-eye view 

Fig. 87: Bird’s-eye view

too two-dimensional and flat looking because the building’s heft can hardly 
be seen. 

Two-point perspective, which furnishes an image with two separate 
vanishing points on the horizon, is equivalent to photographing a building 
from a corner rather than head-on (fig. 85). Here too, the camera has to be 
positioned horizontally, but in this case, only vertical lines appear parallel in 
the resulting image. Two-point perspective images have a vivid, dynamic ap-
pearance that clearly illustrates the volume of a building but which can also 
distract the viewer from the finer points of the architecture itself.

Images shot from a worm’s-eye view (i.e., from below; fig. 86) or from a 
bird’s-eye view (i.e., from above; fig. 87) usually have three vanishing points. 
Here, the camera is no longer pointed at the horizon but instead at an imag-
inary point above or below it. These types of perspectives come into play 
when conventional camera positions no longer allow you to capture the en-
tire subject without tilting your camera. In this type of image, vertical lines 
also converge at a point above or below the horizon. 
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3.4  Converging Verticals

Converging verticals don’t bother us when we are walking along a street, due 
to the close cooperation between our sense of balance and our visual percep-
tion. However, things look different when we view converging verticals in two-
dimensional images, as our brain immediately signals that something is wrong. 
If converging verticals approach each other at a mild angle, a picture can cre-
ate a restless impression, and a depicted building’s aesthetics may be compro-
mised (figs. 88 and 89). This can confuse the viewer and produce a jarring im-
pression of a building that is sometimes severe enough to make it look as if it 
is tipping over backwards. An unwritten rule dictates that architectural pho-
tographers generally try to keep vertical lines vertical in their images. This 
helps to avoid unwanted tension and keeps the composition (and the appear-
ance of the architecture) clear and uncluttered. 

Fig. 88: The source photo with slightly converging verticals

 

Fig. 89: The same shot corrected using a tilt/shift lens



71Converging Verticals

But are converging lines always a bad thing? In some cases, subtly converg-
ing vertical lines in architectural photographs produce a harmonious effect 
(figs. 90 and 91). Furthermore, photographic depictions with modestly con-
verging lines in some ways better replicate our natural perception of buildings, 
because tall structures appear to taper to the naked eye as well. And to extend 
this line of thinking even further, strongly converging verticals can be used 
deliberately to add drama or artistic impact to an image—an effect that is of-
ten used in photos of skyscrapers (ideally with textured façades) or in situa-
tions where the photographer is located very close to the building and is 
shooting almost directly upward (fig. 92). The effect of converging lines, in 
other words, becomes a central element of the photograph’s composition.

Fig. 90: This high rise has a rigid feel to it due to the perfectly corrected 

converging verticals

 

Fig. 91: Many viewers find subtly converging verticals easier on the eye 

and closer to reality
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Fig. 92: Converging verticals used deliberately 

as a dominant stylistic device  

[focal length: 28mm]

3.4.1  How to Avoid Converging Verticals in Your Photos

To represent a building without converging verticals is not always easy. The 
closer one is to the building, the more difficult it is to avoid converging verti-
cals. This is because the camera has to be tilted upward in order to fill the 
frame. The following sections detail a selection of techniques for working 
around the problem.
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Increase the subject distance: If the situation allows, 
simply move back and use a longer lens to reframe the 
subject (fig. 93). This simple measure can help to partially 
or even completely eliminate converging verticals if you 
are careful to point the optical axis of your lens directly 
at the horizon. You can fine-tune any remaining anoma-
lies later on a computer. Unfortunately, there is often not 
enough space surrounding a building to get far enough 
away. Also, the greater the distance between camera and 
subject, the greater the risk of other objects getting in the 
way and spoiling your composition. Furthermore, increas-
ing the subject distance also compresses perspective (sec-
tion 3.5.5).

Fig. 93: Avoiding converging verticals by shooting from a great distance [focal length: 70mm]
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Use a raised camera position: A camera position halfway 
up the subject stops vertical lines from converging (fig. 94) 
and “automatically” frames the subject around the horizon. 
You will, of course, need access to a bridge, a pedestal, or 
the upper floors of a building in the vicinity to make use of 
this technique. A tall tripod or a super high camera stand is 
also sometimes enough to use this strategy.

Fig. 94: Avoiding converging verticals by  

shooting from a raised standpoint  

[focal length: 24mm]
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Use a short lens and shoot in portrait orientation: If you 
have to shoot from quite close, it can help to use a wider-
angle lens than would otherwise be required to make your 
shot. Simply set up your camera in portrait orientation, par-
allel to the ground. The resulting photo will not contain any 
converging verticals, but the subject will appear at the top 
of the frame and large portions of the ground in front of 
the building will be visible in the lower part of the image. 
This imbalance is easily corrected by cropping the image 
later (fig. 95), but will produce a smaller finished image with 
a non-standard format.

Fig. 95: Avoiding converging verticals by shooting in portrait format 

using a wide-angle lens and cropping the results [focal length: 17mm]
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Employ digital perspective correction: You can also 
use post-processing software on a computer to correct 
converging verticals. This involves distorting your image 
to form a trapezoid and then stretching the entire image 
upward to counteract the resulting compression effect 
(fig. 96). This technique can cause irregularity in the sharp-
ness across the image and requires the computer to create 
artificial image data in the upper portion of your image. As 
a consequence, it quickly reaches its technical limits if the 
lines you want to correct converge too strongly. If in doubt, 
it is always preferable to use this method in combination 
with one or both of the other methods described above to 
keep converging verticals to a minimum while shooting. 

Fig. 96: Software-based perspective and converging vertical correction [focal length: 32mm]
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Use a tilt/shift lens: This is the best, but also the most 
expensive way to produce original images without con-
verging verticals. Use of a tilt/shift lens will allow you to 
capture vertical lines correctly, even from a relatively low 
camera position (fig. 97), and it will keep the required 
post-processing (and consequent image quality loss) to a 
minimum. The technique also allows you to shoot directly 
using your desired framing, rather than having to crop your 
image later.

Fig. 97: Perspective correction performed using a tilt/shift lens [focal length: 35mm]
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3.4.2  How Do Tilt/Shift Lenses Work?

Tilt/shift lenses allow you to shift the optical axis of the 
lens in relation to the film/sensor plane (fig. 98). Theoreti-
cally, this would cause extreme vignetting in a standard 
lens, but the enlarged image circle in a tilt/shift lens makes 
it possible to shift the optical axis by up to 12mm without 
adverse effect. The special construction of these lenses 
means that they have no autofocus functionality and, if you 
are using them with an adapter, no automatic aperture 
control. These are, however, only minor disadvantages. 

A medium format lens’s larger image circle (e.g., Pentax 
645 and 67, Mamiya 645, Contax 645, as well as Hasselblad 
lenses) makes it possible to use it as tilt/shift lens with con-
ventional 35mm SLRs by way of a special shift adapter 
(fig. 99). Thanks to the longer flange focal distances of me-
dium format lenses (compared to normal 35mm SLR lenses), 
there is sufficient space to insert the very useful shift mech-
anism. However, vignetting caused by the camera’s mirror 
box limits the shifts you can perform as well, and therefore 
the amount of convergence you can correct using an adapt-
ed lens. Yet another variation of using a shift adapter in-
volves pairing a standard full-frame lens (with a preferably 
very large image circle) with a mirrorless camera (fig. 100). 
Because the mirrorless camera has a very short flange focal 
distance, there’s enough room for the shift adapter. Espe-
cially when using a smaller image sensor, such as the APS-C 
or the Four-Thirds format, the entire image circle from the 
full-frame lens allows for generous lens shifts. And there are 
even full-frame lenses around, which allows for (minor) shift 
movements with full-frame mirrorless cameras. 

So how is a tilt/shift lens actually used? First, use a spirit 
level or a tripod with a built-in level to position your camera 
horizontally. It is useful to line up recognizable features of 
the building at eye level with the AF area markers in the 
center of the viewfinder, and then set focus with your lens 
in a neutral shift position, ideally using live view and your 
camera’s monitor magnifier function. You should also me-
ter exposure now, as your camera’s focus system will no 
longer deliver accurate results once you have shifted the 
optical axis of the lens. Alternatively, you can meter expo-
sure more precisely in live view mode with the lens shifted 
and the camera’s mirror raised. You can now shift the opti-
cal axis upward (fig. 101), which moves the horizon down 
and makes parts of the subject that were previously o utside 

Fig. 99: Using a medium format lens and a shift adapter 

to shift the optical axis and correct perspective

Fig. 98: Using a tilt/shift lens to alter the vertical position 

of the optical axis helps to physically correct perspective 

errors

Fig. 100: A tilt-shift adapter in use with a full-frame lens 

and a mirrorless camera
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Fig. 101: Using a tilt/shift lens to shift the optical axis within the image circle
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Fig. 102: This photo was shot with the  

optical axis shifted downward  

[focal length: 55mm]

the upper edge of the frame visible in the viewfinder. The camera and lens re-
main in a horizontal position. This technique produces an image with no con-
verging verticals and can be performed in exactly the same way in the opposite 
direction (i.e., moving the optical axis downward in order to photograph lower 
portions of a building; fig. 102). Shift lenses also allow you to shift the optical axis 
sideways, which can be useful if you want to photograph a building using central 
perspective from a non-central viewpoint (figs. 103 and 104) or if you want to 
avoid capturing your own reflection in the building’s façade. 

Shifting the optical axis also allows you to alter your composition—for ex-
ample, to remove an irritating foreground and include more sky in the frame 
(figs. 105 and 106). In addition, tilt/shift lenses can be used to aid shooting pan-
oramic images (section 3.6.3).

Using shift lenses always produces a certain amount of vignetting and corner 
blur at the extreme ends of the shift range, so avoid using the maximum shift 
settings, if you can. If your lens doesn’t provide sufficient shift, you can also tilt 
the camera slightly to increase the shift effect, which keeps digital corrections—
with their inherent loss of image quality—to a minimum.

The tilt function in a tilt/shift lens allows you to alter the plane of focus of the 
lens according to the Scheimpflug principle. The uses for this capability in archi-
tectural photography are limited but can, for example, be used to keep an entire 
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Fig. 103: An object in the center of the foreground (the 

car) spoils the overall composition  

[focal length: 24mm]

Fig. 104: Moving the camera slightly to the right 

changes the perspective (check out the red circles) and 

makes the desired shot possible [focal length: 24mm]

Fig. 105, 106: Different effects produced using differing shift settings [focal length: 24mm]
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façade in focus if you are shooting downward from a close distance. Tilt func-
tionality can also be used to create a miniature model effect in photos of real-life 
scenes (section 3.13.7). If you are using just the shift function, make sure that the 
tilt function is locked in its zero position. Otherwise, you may end up unwittingly 
shooting images with extensive unfocused areas. 

3.5  Camera Standpoint

Since camera position and direction alone are the factors that influence perspec-
tive in a photo, making a careful choice of standpoint is essential to the success 
of a shot. Even slight changes in standpoint can have a strong influence on the 
look of a photographed building. 

3.5.1  The Ideal Subject Distance

The ideal distance between camera and subject depends largely on the type 
and size of the building, the nature of its immediate environment, and the pho-
tographer’s visual concept for the image. 

If the three-dimensional depth of the building is important to the final image, 
select a standpoint that is close by. The farther you are from a building, the flatter 
it will appear in a photo (section 3.5.5). If the building’s environment is cluttered, 
you will have to move closer to get a clear view, but in order to produce an undis-
torted, realistic-looking image, the laws of optics dictate that you need to move 
farther away. The larger a building, the farther away you will have to be to cap-
ture it with natural-looking proportions.

Extreme standpoints (i.e., those that are unusually close or very distant from 
the subject) provide specific challenges of their own. Shooting from close up 
produces pronounced perspective effects, and the low viewpoint emphasizes 
the effects of protruding or sunken elements of a façade, especially in the upper 
floors (fig. 107). If you shoot from too near, the resulting converging verticals can-
not be corrected later. If the situation forces you to shoot from close up, you will 
simply have to incorporate the altered perspective in your composition. Extreme 
perspective in photos of skyscrapers can produce additional tension that con-
tributes to the dynamism of the image, even if the building looks less realistic as 
a result (fig. 108). The farther you are from your subject, the smaller the role con-
verging verticals will play, and the easier it will be to correct them if they do ap-
pear. The disadvantages of greater subject distances are the risk of extraneous 
objects spoiling your composition and the two-dimensional look that buildings 
take on when photographed from farther away (fig. 109). 

A useful rule of thumb for exterior architectural photography states that the 
best subject distance lies somewhere between one and three times the height 
of the building. This is one of the reasons architectural photographers often re-
sort to the use of wide-angle lenses in the course of their work. 

Fig. 107: Here, the camera is too close to the 

subject, producing an unfavorable  

representation of the balconies  

[focal length: 24mm]
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Fig. 108: Dramatic perspective produced by shooting from very close up [focal length: 14mm] 

Fig. 109: In this example, a greater subject distance compresses the perspective and produces virtually no converging  

verticals [focal length: 85 mm]
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3.5.2  The Eff ects of Viewpoint on  Perspective

Diff erent viewpoints can provide you with very diff erent  
 compositions, even if you are photographing a single 
building. Usually, you can compensate for the changes in 
framing that changes in distance produce by using a dif-
ferent focal length lens. Experienced photographers can 
use subtle changes in composition to emphasize partic-
ular aspects of a building and its design (fi gs. 110 and 
111), or to conceal its less attractive characteristics. A 
carefully considered standpoint also helps to clarify the 
relationships between diff erent elements of a design or 
to give emphasis to various parts of the structure (fi gs. 
112, 113, 114). 

Fig. 110: Photo-

graphed from afar, 

the building appears 

rounded and attrac-

tive [focal length: 

200mm]

Fig. 111: Photo-

graphed from close 

up, the building 

appears narrower 

and more pointed 

[focal length: 

100mm]
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Fig. 112, 113, 114: The different proportions  

and moods that a change of standpoint can 

produce [focal lengths: 17mm, 35mm, 50mm]

Camera Standpoint
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1

3

2

A single building can appear calm and clear from one 
angle or dramatically proportioned from another (fi g. 115). 
A façade can be made to appear transparent and welcom-
ing from one point of view or shuttered and secretive 
from another (fi gs. 116 and 117). Sometimes, moving the 
camera just a few meters can produce a completely diff er-
ent eff ect. 

Using techniques like these, a photographer can exer-
cise considerable infl uence on the eff ect of a photo with-
out that infl uence being obvious to the viewer. Before you 
start a shoot, it is important to have a clear idea of just 
how important your choice of standpoint is and how this 
choice can aff ect your original concept and the results. If 
you shoot from the wrong place, no amount of image pro-
cessing will improve the results.

Fig. 115: On the left, a medium  subject distance produces a natural-looking image with a realistic feeling of depth. In the center and on the right, 

increasing proximity to the subject produces increasingly dramatic spatial eff ects [focal lengths: 50mm, 24mm, 12mm].
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Fig. 116: Here, the camera angle compresses the space between the individual elements of the building’s framework and 

gives the glass façade a forbidding, closed look

Fig. 117: A slight change of standpoint completely alters the effect of the façade, making it welcoming and transparent

Camera Standpoint
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3.5.3  Standpoint and Surroundings

A change in standpoint also means that other elements of the immediate 
environment will be captured and portrayed differently, which can have pos-
itive or negative effects on the overall look of an image. It is easier to concen-
trate on photographing a freestanding building than one that is located 
close to other buildings in a busy environment. A theoretically interesting 
viewpoint is not of much use if the view of the building itself is obscured by 
trees or bushes. In cases like this, a small change of camera position can make 
all the difference (figs. 118 and 119). A change of standpoint can also provide 
a different view of a building’s surroundings, producing an image with a 
completely different mood (figs. 120 and 121). Last but not least, moving the 
camera can alter the weight of a building and its surroundings, thus convey-
ing a very different message (figs. 122 and 123). The art of successful architec-
tural photography lies not only in finding the right view of a building, but 
also in the skillful integration of its surroundings in the overall composition. 

Fig. 118: The cluttered foreground spoils this composition … Fig. 119: … but a slight change of camera position produces a  

successful image 
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Fig. 120: In this image, the street dominates the composition and visually 

separates the viewer from the building. The forecourt plays only a  

secondary role [focal length: 24mm]. 

Fig. 121: Once again, changing the camera position completely alters the 

impact of the scene. The forecourt appears larger and wider, and gives 

the viewer a feeling of inclusion in the building [focal length: 24mm].

Fig. 122: In this image, the building and the courtyard dominate the 

composition, with the sculpture playing an ancillary role  

[focal length: 24mm]

Fig. 123: Changing the camera position gives the sculpture the dominant 

role in this photograph of the same subject [focal length: 24mm]

Camera Standpoint
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3.5.4  Standpoint and Symmetry

Symmetry, too, can be used to great effect in architectural photos, but it is 
important to differentiate between architectural and photographic symme-
try. A symmetrical building doesn’t have to appear symmetrical in a photo, 
although a coincidence of structural and visual symmetry can create impres-
sive effects. Most viewers find symmetrical architectural images pleasing, 
due to their monumental and often slightly artificial look (fig. 124).

In order to use symmetry successfully as an element of a photographic 
composition, the photographer has to align the camera precisely along the 
axis of symmetry of the building. Even the smallest movement away from 
this axis can create unnecessary tension and spoil the effect. Ideally, objects 
external to the building itself will either adhere to the basic symmetry in the 
image (fig. 126) or not be of sufficient significance to spoil the overall effect. 
Photos shot along the diagonal axis of square buildings create especially in-
teresting visual dynamics, as they produce a great feeling of depth in addi-
tion to the symmetry the image is based on. Photos of courtyards and round 
or elliptical buildings are perfect subjects for close-range, symmetrical archi-
tectural photos, too.

The strength of a symmetrical effect depends on the degree to which the 
physical depth of the building is made visible. If you photograph the side of 
a building head-on, the effect will be less dynamic, and the special effect 
that symmetrical vanishing points have will be lost (fig. 125). 

Fig. 124: The camera‘s position on the diagonal axis of the building gives the resulting image a monumental look

Fig. 125: An unimpressive, flat symmetry effect 

caused by the head-on viewpoint
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Fig. 126: A strictly symmetrical composition
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3.5.5  Spatial Depth

The feeling of depth in an architectural photo is related directly to your chosen 
standpoint. If there are several objects located far away from the camera, the 
space between them seems compressed (fig. 127). On the flip side, if the dis-
tance between the subject and the camera is very short, the foreground ap-
pears more prominent than the background. Close objects will appear very 
large, and objects farther away will appear much smaller, giving the image a 
feeling of openness and space. 

Practically speaking, you will need to use a telephoto lens to properly frame 
distant subjects and wide-angle lenses to capture subjects that are close by. 
Perhaps this gives rise to the myth that the perspective depth perception is a 
function of focal length. In fact, it can be just as simple to use a wide-angle lens 
to capture distant subjects and crop the results to achieve your desired fram-
ing. The flip side of the same idea is to use a telephoto lens at a short distance 
and shoot a sequence of images that you can later merge into a panorama—
the perspective and perception of depth (not to be confused with depth of 
field) in both images would remain the same.

Extreme distances give subjects a two-dimensional look reminiscent of 
collage-type effects, with the rear elements of a building appearing only 
slightly smaller than the front elements. The apparent compression of space 
gives a building a flat, almost cardboard look. This type of effect can be used 
to produce abstract-looking images that heavily disguise the real nature of a 
subject’s depth (fig. 128).

Fig. 127: A compressed perspective established by a large subject distance [80mm focal length, dis-

tance of 160 meters]
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Fig. 128: Here, the 

large subject dis-

tance strongly com-

presses perspective 

[180mm focal length, 

distance of 350 

meters]

Camera Standpoint



94 Shooting Techniques

Documentary photographers usually try to keep the depth effects in their 
images as realistic-looking as possible, and they tend to use moderate wide-
angle lenses to achieve this. Full-frame focal lengths of around 40mm produce 
images with a feeling of depth that is very similar to that of human visual per-
ception, and the viewer of such an image can accurately judge the spatial rela-
tions of objects within the frame on the basis of real-world experience (fig. 
129). If you shoot closer to the same subject using a shorter focal length lens, 
you can give otherwise cramped-looking architecture a slightly artificial, wide-
open look (fig. 130). Objects close to the camera appear disproportionately 
large, while distant objects appear smaller than they really are. Overall, photos 
shot at close distances using short focal lengths produce a greater feeling of 
depth that communicates either spatial depth (fig. 130) or extreme perspec-
tive distortion (fig. 131). Photos shot from afar give the viewer very little spatial 
information, whereas wide-angle shots provide a feeling of depth that is often 
exaggerated, but nevertheless interpretable. 

Fig. 129: The camera position and the moderate 

focal length produce a realistic-looking spatial 

effect [focal length: 40mm]

Fig. 130: In this case, an ultra-wide-angle lens 

and a shooting position very close to the sub-

ject give the building and its surroundings an 

unnaturally wide open look 

[focal length: 17mm]
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Fig. 131: Here, the short subject distance 

produces strong perspective distortion 

[focal length: 17mm]
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3.6  The Effects of Focal Length

The choice of focal length is closely related to the camera standpoint, although 
there are various possible approaches to finding the right combination of the 
two factors. Some photographers stick to a predetermined camera position 
and select an appropriate focal length, while others prefer to use a particular 
lens and move about until they find the viewpoint and composition that best 
matches it. 

Using a zoom lens is a more flexible approach, as it allows you to adjust focal 
length smoothly without having to move the camera. If you use a fixed focal 
length lens, you will have to move around a bit more to find the right position. 

Extreme focal lengths (less than 16mm or greater than 200mm equivalent) 
produce extreme effects that are seldom useful in an architectural context and 
are not frequently used by professionals. They should really be used only on 
rare occasions when such optics allow you to capture images that would oth-
erwise be difficult or impossible to realize. Ideally, every architectural photog-
rapher should have access to a broad range of lenses that allow an unrestricted 
choice of camera position.

3.6.1  Long Focal Length Lenses

As already mentioned, the fact that long telephoto lenses compel the photog-
rapher to shoot from a large distance restricts their use to special situations. 

Long focal length lenses are great for emphasizing details and the materials 
used in a building’s structure (fig. 132; section 3.8.3), but give you significantly 
less depth of field to work with than wide-angle lenses. It is therefore impor-
tant to use relatively small apertures when using long lenses; otherwise you 
run the risk of blurring important details. 

The narrow angle of view of a telephoto gives you the opportunity to em-
phasize details by isolating them from the background (fig. 133). 

Fig. 132: A modest telephoto lens can be used to 

accentuate construction details  

[focal length: 80mm]
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Fig. 133: Using a telephoto lens emphasizes details in a 

building‘s surface against a monotone background  

[focal length: 100mm]
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Fig. 134: A long lens and a large subject distance produce strongly compressed perspective [focal 

length: 150mm]

Due to the compressed perspective produced by the large distance from 
the subject, telephoto lenses also allow you to portray multiple subjects that 
inhabit large spaces in a single image (fig. 134), giving them a mutual context 
that is otherwise not obvious to the viewer (fig. 135). The same effect can also 
be used to isolate shapes and produce artistic images of a much more abstract 
nature (fig. 136).
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Fig. 135: In this image, a long lens was used to establish a relationship between two buildings that are actually located a great  

distance apart [focal length: 100mm]

Fig. 136: Here, tight framing and a long lens produce an image dominated almost completely by abstract shapes [focal length: 120mm]
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3.6.2   Short Focal Length Lenses

Medium wide-angle lenses with equivalent focal lengths of between 24mm 
and 35mm are perfect for producing realistic-looking images of buildings and 
are fi rm favorites among architectural photographers.

Ultra-wide-angle lenses are often used if the circumstances force the pho-
tographer to shoot from very close to (or inside) a building (fi g. 137), and they 
make it possible to capture photos that would otherwise be impossible to 
shoot. But take care: Ultra-wide-angle lenses and short subject distances al-
most always produce strong perspective distortion and an overemphasized 
feeling of three-dimensional space. Such eff ects defi nitely belong to the more 
artistic side of architectural photography and can be used to produce dynam-
ic, but not necessarily realistic, architectural photos (fi g. 138). 

Fig. 137: An ultra-wide-angle shot made necessary by the close proximity of the neighboring buildings [focal length: 14mm] 
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Fig. 138: The combination of an ultra-wide-angle lens and an unusual camera position produces an extremely 

dynamic overall effect [focal length: 17mm]
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If you are using a wide-angle lens for the first time, you will quickly find that 
even the smallest movements of the camera away from the horizontal axis pro-
duce strongly converging verticals (fig. 139). It is therefore extremely important 
to ensure that your camera is aligned correctly if you want to prevent this from 
happening. Additionally, wide-angle zoom lenses tend to produce pronounced 
barrel distortion. Correcting these types of effects requires additional cropping 
during post-processing, so make sure you leave sufficient space around your 
main subject while shooting (section 4.3.1).

Fisheye lenses, with their ultra-short focal lengths and extremely wide angles 
of view, are rarely used in an architectural context due to the extreme distortion 
they produce. Fisheye effects are often fascinating at first glance and are great 
fun to experiment with, but can become quite irritating if they are overused. 
Nevertheless don’t neglect to experiment creatively with fisheye lenses and 
their unusual angles of view (fig. 140). There are software programs capable of 
reducing the prominence of fisheye effects, or in some cases of removing them 
entirely, although not without significant losses in quality around the edges of 
the image. This method, however, could allow you to create overview shots of an 
area that simply wouldn’t be possible with a normal lens (figs. 141 and 142).

Fig. 140: Fisheye lenses produce extremely distorted views of architectural subjects [15mm full-frame fisheye lens]

Fig. 139: Rotating the camera slightly down-

ward while using a wide-angle lens produces 

obvious converging verticals [focal length: 

14mm]
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Fig. 141: An overview shot created with an ultra wide-angle lens [17 mm focal length]

Fig. 142: An overview image taken with a fisheye lens and then subsequently edited to replicate a more natural visual impression 

by minimizing the fisheye effect [15mm focal length]
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3.6.3  Increasing the Angle of View Using Planar and Shift 
Panorama Techniques 

If the focal length of your lens is not short enough to capture the entire sub-
ject, you can always shoot a sequence of partial images and merge them to-
gether during post-processing (fig. 143; see also section 4.4.1). In order to pro-
duce realistic-looking results, it is usually best to stitch your images together to 
form a flat, or planar, panorama instead of a cylindrical panorama. The latter 
often have extreme formats and obvious distortion of straight lines outside of 
the image center. The usable angle of view of a planar panorama is less than 
180 degrees. 

If you are shooting a panorama handheld, try to rotate your camera around 
its nodal point (section 3.7.1) rather than around your body’s own central axis. 
This will give you maximum flexibility and a minimum of difficulty when align-
ing and merging your images later, especially if you are photographing your 
subject from close up. Of course, it’s even more effective and precise to use a 
panoramic tripod head.

Panorama techniques not only help to increase the realizable angle of view 
but also can be used to increase image resolution severalfold, which is of par-
ticular interest to photographers who want to produce large-scale prints of 
their work. 

A more precise way to increase the angle of view in your photos is to use a 
shift lens. Simply shoot two (to four) source images using opposite or rotated 
directions of shift and stitch them together on a computer (fig. 144; see also 
section 4.4.2). It is extremely important to leave sufficient overlap at the edges 

Fig. 143:  

A planar panorama constructed from three 

portrait format source images  

[focal length: 17mm] 
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Fig. 144: A photo constructed from two source images shot using different shift settings [focal length: 2 x 24mm] 

The Effects of Focal Length
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of panorama source images. Common sets of panorama source images in-
clude two landscape format images merged to produce a 5:2 wide-screen 
 panorama or three portrait format images merged to make an approximately 
5:3 panorama. It is also possible to shoot four source images with the lens ro-
tated through 30 degrees up or down. The shooting sequence would then be 
as follows: top left, bottom right, rotate through 60 degrees counterclockwise, 
top right, bottom left. The resulting image will have an aspect ratio of about 
3:2. For portrait images, rotate the entire system 90 degrees correspondingly. 
The advantage of this technique is that, unlike when you rotate the camera, 
the alignment of the camera itself doesn’t change, making it easier to merge 
the resulting images even when outside. However, the objects in the image 
should be as distant as possible, because even the minimal shift of the lens axis 
has a negative effect on the appearance of objects close to the lens. The con-
sequence is a slight shift of the image elements, which of course complicates 
the stitching process: the closer the elements of your subject are to the cam-
era, the more significant the perspective offset will be, which makes the stitch-
ing process complicated and labor intensive. Especially when indoors (fig. 211), 
you can quickly reach the limits of this method. Small so-called parallax errors 
can cause real headaches when stitching images together, but they aren’t al-
ways easy to detect when working onsite and you usually don’t discover them 
until you’re at home working on your computer—and it’s too late to take prop-
er counter measures.

To end up with component images that are free from parallax error, use a 
shift lens or shift adapter with an integrated or attached tripod socket, which 
enables you to shift the camera position while keeping the lens static: the opti-
cal axis of the lens remains unaltered, while only the exposure surface (i.e., the 
sensor or film) shifts through the image circle parallel to the lens plane. Some 

Fig. 145: A camera with a shift adapter affixed 

to a tripod using an L-bracket, allowing the 

camera to be freely shifted horizontally

Fig. 146: A lens attachment bracket for a shift 

lens with similar functionality
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shift lens adapters allow you to fix the lens in place by using special tripod 
mounts permitting you to shift the camera freely within certain limits (fig. 145). 
Lens attachment brackets designed specifically for individual shift lenses are 
another option (fig. 146). These methods enable you to produce source images 
with precise overlaps. If your tripod head has a movable quick-release plate, 
you can achieve the same effect by moving the camera in the opposite direc-
tion to the shift that you apply to the lens (horizontal shift), or, if your tripod 
has a telescopic center column, retracting or extending it against the shift (ver-
tical shift).

For both flat and shift panoramas, use the manual exposure mode to ensure 
that your exposure settings remain constant when shooting both types of 
panoramas. Differences in exposure between shots cause differences in image 
brightness in the overlap areas that then have to be corrected manually.

3.7  Image Formats

The image format you use can have a significant influence on the way an im-
age is perceived. Landscape format is the most commonly used in architec-
tural photos, as it most closely represents the way we see our surroundings. 
Portrait format images are used less often, while a square format (fig. 147) is 
calmer, and emphasizes neither the vertical nor the horizontal dimension. 

The camera’s image sensor or film format determines the format of the RAW 
image data (usually 3:2 or 4:3), although cropping allows you to change the 
basic dimensions of an image later. Extreme formats and framing that is not 
aligned with the lines within the subject immediately attract the viewer’s at-
tention and signal an unconventional image. 

Fig. 147: Landscape, portrait, and square format images of a single subject

Image Formats
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3.7.1   Extreme Formats and Panorama Images

A panorama is an image in which one dimension is many times longer than the 
other, offering the viewer an unusual view of a scene that doesn’t correspond 
to conventional ideas of visual perception (fig. 148). This unusual view also has 
an effect on the way the subject is perceived. While a heavily cropped image 
(fig. 149) reproduces a situation in a relatively undistorted fashion, panoramas 
constructed from multiple source images often portray improbably large ver-
tical or horizontal angles of view (fig. 150).

In contrast to planar panoramas (section 3.6.3), cylindrical panoramas can 
cover angles of view as large as 360 degrees and visually distort all horizontal 
lines that are not located on the horizon (fig. 151). Spherical panoramas are 
designed for interactive presentation on computer monitors. They cover not 
only a 360-degree horizontal angle of view, but also 180 degrees vertically and 
show even more distortion than cylindrical panoramas. Printed spherical pan-
oramas are visually more similar to fisheye photos than to ones shot using ul-
tra-wide-angle lenses, and as such present an unrealistic view of the subject. In 
architectural situations, this type of panorama is not used to accurately repro-
duce the proportions of a building, but serve more to squeeze a complete 
overview of a broad scene into a single image. The major characteristics of 
successful panoramas are invisible seams and a composition that effectively 
uses the entire available space within the elongated frame. 

So how do we go about creating a panorama? A tripod is an essential tool 
for the creation of cylindrical panoramas made up of multiple source images. 
Precise horizontal camera alignment makes it easier to merge the source im-
ages later and avoids converging verticals. Shooting in portrait format helps to 

Fig. 149: A single image formatted by means of heavy horizontal cropping

Fig. 148: The human field of view: approxi-

mately 170 degrees horizontally and 130 

degrees vertically
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cover the maximum possible vertical angle of view, and the best way to do this 
is using either a simple L-bracket (section 2.5.3) or a custom panoramic head 
designed for use with your specific combination of camera and lens. A high 
quality panoramic head can be adjusted to rotate around the nodal point of 
one or a number of camera/lens combinations. The nodal point is the point 
around which you need to rotate your camera to produce precisely superim-
posed overlaps between the individual source images. A tripod head with a 
built-in spirit level and 360-degree scale is a great aid to producing precisely 
aligned and overlapped panorama source images. Some DSLRs have grids that 
can be displayed in the viewfinder or on the monitor, and these too, help to 
align the camera during a panoramic shoot. Accessory focusing screens with 
etched-in grids are available for digital and analog SLR cameras. The focus area 
indicators in your camera’s viewfinder also make a useful impromptu align-
ment aid. Panoramic source images should be shot using the same exposure 
values, but if the light conditions vary too much, you can also use exposure 
compensation values to counteract the effects. Keep in mind, that this will 
make it more difficult to stitch the images together manually. However, 

Fig. 150: A planar panorama constructed from four source images [focal length: 4 x 24mm]
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 stitching software is quickly becoming increasingly powerful, and many pro-
grams offer compensation functionality that automatically balances the light-
ing in a stitched image. Remember that clouds moving across the sky can 
shade the sun during a shoot and cause significant differences in exposure 
between shots. Make sure that no moving objects lie in the overlap areas be-
tween shots, as these are sure to produce anomalies that are difficult to re-
touch later.

3.7.2   Image Orientation

Every rectangular image has an aspect ratio that determines whether it is 
viewed in landscape or portrait format. Buildings that are broader than they 
are high are therefore usually photographed in landscape format, while those 
with a dominant vertical orientation are generally portrayed in portrait format. 
This means that the image format is usually a function of a building’s form and 
is intended to produce an image that portrays it without imposing any visual 
constraints. 

However, if the photographer wishes to include additional elements of a 
building’s surroundings in the image, this can reduce the dominance of the 
building itself within the composition and alter the required image format. A 
second major element in an image can completely change its perceived orien-
tation (fig. 152).

If you deliberately use a format that doesn’t mirror the structure of the sub-
ject, you will create an image with additional tension that can significantly al-
ter the way the subject is perceived. The image format can be used to inten-
tionally provide a counterpoint to the architecture itself (figs. 153 and 154). 
Using this type of technique, the photographer can influence the composition 
and emphasize relationships and contradictions within the frame. In such cas-
es, the architecture can even take on a role that is secondary to the composi-
tion of the image itself, once again indicating an artistic approach to architec-
tural photography. 

Fig. 151: A cylindrical panorama: horizontal 

lines not located directly on the  

horizon are visibly distorted
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Fig. 154: The vertical nature of the building’s structure is counteracted by the landscape format  

of the image

Fig. 153: Overview

Fig. 152: In this example, an additional compositional element (the aircraft) determines the format of the finished image



112 Shooting Techniques

3.8  Composition and Framing

Every photographer should consider the composition and framing of an im-
age before shooting. You can, of course, crop an image later, but the corner-
stone of a successful image is always laid before the shutter button is pressed. 
It is essential to consider how the interplay between objects, shapes, lines, 
and spatial relations in an image can be brought together to form a sus-
penseful but effective whole. The aim of a great photo should be to captivate 
the viewer using a composition that complements the overall effect of the 
image. This means that an image can contain obvious visual contradictions 
without losing its overall effectiveness. On the other hand, a failed composi-
tion can make even the most spectacular building look dull or even unat-
tractive.

3.8.1  Composition

There is no simple formula for composing a great photograph. Locating the 
subject in the center of the frame produces a balanced, but often static-look-
ing image. This type of composition is often used by documentary architec-
tural photographers (fig. 155). A central location is essential if you want to pro-
duce a precisely symmetrical view of a building (section 3.5.4). 

As in other genres, architectural photographers often choose non-central 
compositions in order to produce more interesting images. The Golden 
 Ratio and the Rule of Thirds are two rules of thumb often used to aid 

Fig. 155: A calm, static composition enhanced by the central position of the building within the frame
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Fig. 156: A dynamic, suspenseful composition that follows the golden  

ratio rule

Fig. 157: Here, an extremely one-sided composition provides us with  

a very unusual image

 successful image composition (page 116), and which produce balanced but 
interesting images (fig. 156). But sometimes, the most impressive images are 
those that simply ignore the rules of photography, aesthetics, and artistic 
proportions (figs. 15 and 157). Extreme images like these have to be very 
carefully composed in order to be effective, and the difference between a 
sophisticated and a failed composition can be very fine. Architectural photos 
portray physically large subjects that take up a large proportion of the avail-
able space within the frame, and it’s all too easy to spoil the visual balance in 
an image by putting too much emphasis on a single part of the frame. 

In a photo, a building doesn’t always have to be visible in its entirety. Parts 
of a structure that are less relevant to the overall effect can be completely left 
out. Even a partially visible façade can deliver sufficient information to en-
able the viewer to interpret the building correctly, and a carefully chosen 
viewpoint can often reveal a more interesting view than a conventional 
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 full-frontal shot (fig. 158). In such cases, you can do well to remember Robert 
Capa’s famous quote: “If your pictures aren’t good enough, you’re not close 
enough.”

The importance of the use of space within a composition is often underes-
timated. Space is an important part of all architectural structures, and a pho-
to of a building needs room to breathe. If an architectural photo is too tightly 
cropped, it will create a cramped, unfavorable impression (fig. 159). Always 
try to see emptiness as unconfined space and actively incorporate it into 
your compositions (fig. 160).

Fig. 158: A composition with  

partially visible façades 
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Fig. 159: The extreme crop gives this  

image a cramped feel

Fig. 160: Composing around empty space
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The Golden Ratio and the Rule of Thirds

The Golden Ratio is a ratio (1 : 1.618) that is widely used in the arts and architecture 
to symbolize ideal proportions and harmonious aesthetics. Compositions that 
adhere to the Golden Ratio are the basis for many successful architectural photos.

The Rule of Thirds is a similar rule of thumb that conceptually divides the area 
of an image vertically and horizontally into thirds, resulting in nine equal parts.  
If you compose your image so that important details or features lie on the  
imaginary dividing lines between the segments, the result is usually pleasing 
and balanced.

a : b = b : c = c : d = 1,618
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3.8.2  Composition and a Subject’s Surroundings

Architecture and its surroundings influence each other to equal degrees, so it’s 
important to consider in advance whether or not you want to include a build-
ing’s surroundings in a photo (fig. 161). The elements in question include static 
objects such as trees, streetlights, walls, and signs, as well as moving objects 
such as people, cars, and clouds. Including such elements makes it easier for 
the viewer to interpret an image of a building, but can also have the opposite 
effect by making it appear too cluttered. 

Fig. 161: Elements of the surroundings 

influence the overall impression  

made by a building
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Fig. 162:  

A clearly structured 

composition with no 

additional elements 

produces a clean, cli-

nical-looking image

Fig. 163:  

Surrounding objects 

breathe life into  

this image
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Stationary Image Elements

It’s important to have an idea of how you want to portray a building before 
you begin a shoot. If you want to create a clear, clinical look, you will need to 
reduce all distractions to a minimum and exclude any extraneous objects 
from the frame (fig. 162). Such an image has a clear message but can appear 
distanced. On the other hand, it is easy to positively influence the message 
communicated by a photo by selectively including external elements in your 
composition, which convey the character of a location (fig. 163). Including 
parts of a building’s surroundings in an image is by no means just a compro-
mise necessitated by a lack of space (section 3.5.3). Rather, it can be a deliber-
ate technique of composition. For example, the purpose of an airport control 
tower only becomes evident when its surroundings are visible too, and a 
bridge only has meaning if it is photographed with the space it spans. Addi-
tional objects can also breathe life into an otherwise sterile image and pro-
vide accents that give the viewer more information about the subject’s con-
text. External objects can also serve as a yardstick for judging the size of a 
building (fig. 164). Artistic architectural photographers often use additional 
visual elements to emphasize the relationships between a building and its 
surroundings (fig. 165).

Fig. 164:  

Additional objects give 

clues regarding the scale 

of the subject

Composition and Framing

Fig. 165:  

A silhouetted Image that 

includes elements of the 

surroundings in the 

composition 
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Fig. 166: People used as an additional compo-

sitional element

Fig. 167: The same composition, but with peo-

ple deliberately left out

People and Other Moving Objects

People, cars, and other moving objects only appear for a very short time in a 
subject’s surroundings, making it relatively simple to deliberately include or 
exclude them from a composition (figs. 166 and 167).

The inclusion of people in architectural photos is the subject of much de-
bate, as they can influence the dynamics of an architectural scene in both 
positive and negative ways. Historically, people were usually deliberately left 
out of architectural compositions, particularly in the genre’s infancy because 
of the technical limitations imposed by the long shutter speeds used by the 
equipment of the day. The fact that a building has no purpose without the 
presence of people makes this practice particularly ironic, although the pres-
ence of people in architectural images can distract the viewer from the main 
subject. 

Contemporary architectural photographers generally leave people out of 
their compositions less often than their predecessors did. People are often 
used to add movement and vitality to a scene (fig. 168) and can be used se-
lectively to make context and scale easier to interpret (fig. 169). If people are 
to be visible in an architectural photo, they should be located close to the 
building to ensure that the proportions in the finished image are realistic. 
Human subjects that are portrayed too close to the camera appear dispro-
portionately large and tend to distract the viewer’s attention from the build-
ing itself. 
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Fig. 168: In this example, people liven up the overall image
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Fig. 169: Selective use 

of a human element 

to illustrate scale



123Composition and Framing

Fig. 170: An image 

showing an interac-

tion between a man 

and a building
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The interaction between people and buildings is a characteristic of the ar-
tistic side of architectural photography. In such photos, the building alone is 
no longer the center of attention (section 3.2), and the photos illustrate rela-
tionships between people and objects rather than just the objects themselves 
(fig. 170). Examples of this type of photo are ones that clearly illustrate the dif-
ference in size between a person and a building or ones that show unusual or 
odd situations (fig. 171). Other examples of this type of counterpoint are pho-
tos that show well-dressed people in front of ruined architecture or persons in 
Halloween costumes standing in front of a modern skyscraper. Such photos 
represent a mixture of architectural and portrait photography, so if you are in 
any doubt, you should always obtain permission to publish from any people 
who appear in your photos.

In the case of other moving objects, such as cars or clouds (fig. 150), it is of-
ten worth waiting to see if the situation changes for the better. Parked cars 
often block the view of a building and are impossible to remove in post-pro-
cessing. In such cases, you can either regard a car as a stationary object and 
use it as part of the overall composition (fig. 180) or revisit the same location 
later (figs. 172 and 173). For business locations, early mornings and weekends 
tend to be ideal times because you can avoid commuter traffic. The only other 
alternative is to select a different location altogether. Like stationary objects, 
moving objects are an additional stylistic element often used by artistic archi-
tectural photographers (fig. 174).

Fig. 171: A moment captured: the mix of a  

person and architectural objects  

complete the composition
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Fig. 172: Parked vehicles block the view of the building Fig. 173: The same building, photographed later

Fig. 174: Deliberate use of a moving object as a stylistic device in an architectural photo [1.5 sec. at f/11 and ISO 100, ND filter]

Composition and Framing
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Fig. 175: A tight crop accentuates the nature of the building materials [focal length: 100mm]

3.8.3  Selective Framing

A photographer can use tight or selective framing to emphasize particular 
details or characteristics of a building. This eliminates subsidiary information 
regarding the size and overall shape of a building and draws the viewer’s at-
tention to specific architectural details. This way, the material nature of a fa-
çade (fig. 175) and the precise construction of particular features are much 
easier to discern, while the overall structure of the building takes on a sec-
ondary role (fig. 176).
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Fig. 176: Substructures within a building’s overall shape are accentuated by tight framing [focal length: 24mm]

Composition and Framing
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3.9  Camera Settings

The three variable camera settings involved in every photo are shutter speed, 
aperture, and ISO (film or sensor) sensitivity. The optimum combination of all 
three ensures correct exposure. As a genre, architectural photography offers 
little space for experimentation in regard to exposure, and it is essential to ex-
pose your photos according to the lighting on site if you want to produce us-
able images that are easy to process.

3.9.1  Shutter Speed

Due to the static nature of buildings, shutter speeds (or exposure times, as 
they are often referred to in digital circles) play only a secondary role in archi-
tectural photography. Buildings are not subject to motion blur like many other 
subjects, so if you use a tripod, your shutter speed will be your most flexible 
camera setting. If you use long shutter speeds, moving objects such as people 
or cars end up looking like blurred stripes, which makes them less of a distrac-
tion in the finished image. Moving objects can help make an architectural 
photo look more dynamic and less sterile (fig. 177), and the inclusion of mov-
ing people can help illustrate their interaction with the architecture. Moving 
people create visible blurs and are differentiated from people who are stand-
ing still. The longer the shutter speed, the fainter the traces of movement be-
come, so using extremely long shutter speeds is an effective way to make 
moving objects completely invisible. 

3.9.2  Aperture

In architectural situations, it is usually advisable to use a medium to small aper-
ture to ensure sufficient depth of field and to keep lens errors to a minimum. 
Most wide-angle lenses produce their best frame-wide sharpness at apertures 
between f/8 and f/11, while very bright lenses (i.e., those with very large maxi-
mum apertures) produce their best sharpness at around f/4. 

Standard and telephoto lenses often require the use of very small apertures 
to produce sufficient depth of field. The problem here is that small apertures 
cause diffraction-based artifacts. This diffraction blur is directly related to the 
physical size of the aperture opening—the smaller it is, the more likely it is that 
diffraction blur will occur. The density of pixels on a digital image sensor also 
plays a significant role in image sharpness. Diffraction blur is more likely to oc-
cur in photos shot using a sensor made up of small pixels because the circles of 
confusion produced by diffraction are more likely to intersect with multiple, 
neighboring pixels. The smallest aperture that doesn’t cause diffraction-based 
blur is referred to as the ”diffraction limit” and lies between f/8 and f/11 for 
DSLRs with high pixel-density image sensors, while most full-frame DSLRs and 

Fig. 177: Long shutter speeds make movements 

visible [0.8 sec. at f/8 and ISO 100].



129Camera Settings

medium format digital cameras can be stopped down to f/11 or f/16 without 
causing a visible reduction in sharpness. 

Every architectural photo involves finding the right compromise between 
the maximum possible depth of field and a minimum of diffraction blur and 
lens errors. This generally means using an aperture of f/8 or f/11.

Departing from these guidelines in specific instances, however, can be advis-
able. You may want to use a wide aperture and a shallow depth of field as a 
deliberate technique to highlight a specific part of a building while letting other 
parts disappear into blur. You generally have to be relatively close to your sub-
ject in order to create this effect (fig. 178), however, you should understand that 
architecture often appears unusual and even strange when subjected to this 
treatment. On the other hand, it can sometimes be advantageous to exploit the 
diffraction blurring that occurs with narrow apertures when shooting problem-
atic subjects with fine geometric textures to avoid moiré effect—especially 
when using an image sensor that doesn’t have a low-pass filter. You can also 
deliberately stop down the lens to create starburst effects when working with a 
scene containing reflections of the sun off of glass surfaces or when shooting a 
nighttime subject that contains bright points of light. Using apertures of f/16 
and narrower tend to produce defined starbursts (fig. 179).

Fig. 178: Large apertures produce shallow depth of field. Here, the viewer’s attention is automatically drawn to the joint 

between the stones [focal length: 21mm, 1/60 sec. at f/2.8 and ISO 100].
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Fig. 179: A starburst effect produced in a glass 

facade with a significantly stopped-down lens 

[24mm focal length, 1/60 sec. at f/18 and ISO 100]
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3.9.3  ISO Sensitivity

I recommend that you use the minimum possible ISO value in your architec-
tural photos, regardless of whether you are shooting digitally or using an ana-
log camera. Low-sensitivity analog film produces maximum sharpness with 
minimum grain, theoretically making it possible to generate large prints of 
heavily cropped image details. However, in practice it is cheaper and more 
practical to use high-quality ISO 100 or 200 film, and you should only use more 
sensitive film if you want to use visible grain as a stylistic device in your images 
(fig. 180). Slide films are generally not good at reproducing strong light/dark 
contrasts and are not particularly useful in architectural situations. 

Fig. 180: An image that uses the grain effect of 

high-sensitivity black-and-white film as an 

intrinsic part of the composition
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Using low ISO values with digital image sensors reduces the risk of noise 
artifacts spoiling your images and gives you the greatest possible dynamic 
range and headroom for adjusting incorrectly exposed images later on. 
Some DSLRs offer super-low ISO settings that are theoretically a whole f-stop 
lower than the default value, but which are only achieved using electronic 
trickery without producing real increases in image quality. The process in-
volves recording an image that is deliberately overexposed by one f-stop 
and then automatically corrected by the camera’s firmware. This reduces the 
available dynamic range and should be avoided in high-contrast situations. 
If you need to use long shutter speeds, it is always better to use a neutral 
density filter.

3.9.4  Exposure

A camera’s automatic exposure metering system uses the selected ISO value 
as a basis for calculating the optimum combination of aperture and shutter 
speed for the center-weighted, spot, or matrix area being metered. Generally, 
architectural photographers aim to produce photos that are consistently ex-
posed across the entire frame, with no obvious burned-out highlights or 
blocked-up shadows. To achieve this, it is best to use center-weighted or ma-
trix exposure metering, as these—in contrast to spot metering mode—meter 
for the entire frame. However, automatic systems aren’t perfect, and it is 
sometimes necessary to make manual corrections to automatically calculated 
exposure settings. Even small reflections can cause the camera to underex-
pose the whole image. Most digital cameras include histogram functionality 
to help you judge exposure (page 157). This is often much more accurate than 
using the camera’s monitor, which is only capable of displaying low-quality 
images and is subject to color shifts at acute viewing angles. 

The prevailing weather and the position of the sun have a significant influ-
ence on the exposure values you can use. Contrast is generally low in overcast 
situations, and it is often advisable to increase contrast artificially for photos 
taken in such situations—in other words, to “stretch” the histogram. The con-
trast between the darkest and lightest parts of an image is much greater in 
direct sunlight. If the sun is behind you, it is relatively simple to produce cor-
rectly exposed images. The direct lighting causes some shadows, but leaves 
buildings showing pleasantly high contrast against relatively dark skies 
(fig. 181). It is easier to find the right exposure values for the entire frame in 
situations like this than it is in backlit situations. The façade of a backlit build-
ing will be in the shade and will often display very low contrast (section 3.12.2), 
while the sky is often overexposed to a degree that overshoots the camera or 
the film’s available dynamic range, producing large, washed out areas in the 
finished image (fig. 182). Many automatic exposure systems compensate au-
tomatically for backlight, but end up underexposing the main subject as a 
result. Again, you can compensate for such anomalies manually, but there are 
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Fig. 181: The position of the sun behind the photographer produces a high-contrast façade against a dark sky [1/125 sec. at f/11 and ISO 100]

Camera Settings

Fig. 182: In this image, backlight gives us a low-

contrast façade and an overexposed sky [1/60 

sec. at f/11 and ISO 100]

Fig. 183: A DRI image constructed from a brack-

eting sequence mitigates the problems caused 

by backlighting [1/10, 1/40, and 1/160 sec. at f/11 

and ISO 100]

Fig. 184: Using a graduated filter to counteract 

the problems caused by backlighting [1/40 sec. 

at f/11 and ISO 100]

limits to what you can effectively achieve as contrast remains high whatever 
you do. If you cannot avoid shooting into the sun, shoot a bracketing se-
quence (section 3.9.5) and use the results to create a super-high-contrast HDR 
or DRI image later during post-processing (fig. 183). A graduated filter can also 
help in some backlit situations (section 3.10 and fig. 184).
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Fig. 185: Using DRI techniques enabled us to 

produce balanced exposure across  

the entire frame
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Fig. 186: The tone mapping effect in this image is too strong

Camera Settings

3.9.5  Using Bracketing Sequences to Create HDR or DRI Images

HDR (High Dynamic Range) or DRI (Dynamic Range Increase) images are con-
structed from multiple source images taken using varying exposure values 
and then merging those images to create a single image using proprietary 
software. This makes it possible to reproduce a dynamic range greater than 
what your camera can normally capture in a single image (also section 4.5). In 
professional architectural photography, HDR or DRI images shouldn’t be im-
mediately recognizable as such and should provide evenly lit representations 
without obvious under or overexposure (fig. 185). If you overdo HDR or DRI 
effects, you run the risk of producing an artificial-looking image that looks 
more like a painting—with pronounced microcontrast, exaggerated colors, 
and unnatural brightness profiles—than a photograph, with the subject tak-
ing on a role that is subordinate to the effect itself (fig. 186). Ideally, you should 
use a tripod to ensure that the source images in your sequence are identically 
framed. Select exposure increments of –1/0/+1 or –2/0/+2 LV (1 LV = one f-stop) 
depending on the situation. These values represent underexposure, normal 
exposure, and overexposure and are called a bracketed sequence. Always 
shoot bracketed sequences using a fixed aperture value and a variable shutter 
speed. If possible, shoot bracketed sequences in continuous shooting mode—
this ensures that your source images are taken within the shortest possible 
space of time and reduces the risk of objects within the frame moving be-
tween shots. If you are shooting at night, use mirror lock-up to prevent the 
movement of the camera’s mirror from causing camera shake. 
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Fig. 187: Use of a circular polarizing filter: the 

sky remains bright, and there are no visible 

reflections in the façade

Fig. 188: Rotating the polarizing filter through 

45 degrees darkens the sky but makes the 

reflections in the windows visible

3.10  Using Filters

Filters can be used to produce, enhance, or prevent certain optical effects 
(section 2.5.6). Rotating polarizing filters are used to prevent unwanted re-
flections in smooth, nonmetallic surfaces or to intensify the blue of the sky 
(figs. 187 and 188). Graduated filters are a great aid to producing balanced 
exposures in extreme high-contrast situations; they function by partially 
darkening part of the image area (usually the sky). They are only really effec-
tive in situations where the exposure between two clearly differentiated 
bright and dark areas needs to be equalized (figs. 189 and 190). Neutral den-
sity (ND) filters are color neutral and reduce the amount of light entering the 
lens by a preset factor. This makes it possible to use much longer shutter 
speeds than would otherwise be possible in brightly lit situations, which 
means you can depict moving cars or people with deliberate blur, for exam-
ple (fig. 191), or you can let them pass entirely out of the image composition 
with very long shutter speeds.
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Fig. 189: An exposure without graduated filter: the foreground is cor-

rectly exposed but the brightly-lit building is overexposed, which is 

clearly visible in the histogram [aperture 9, 1/160 sec, ISO 100] 

Fig. 190: An exposure using a graduated filter: The filter was turned 

slightly to the right so that it didn’t affect the bottom quarter of the 

image. The slightly longer exposure time rendered the foreground only 

slightly brighter, while the filter darkened the upper part of the image 

enough to create a well-balanced exposure  

[aperture 9, 1/100 sec, ISO 100].
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Fig. 191: Using an ND filter while shooting during the day in order to achieve motion blur by slowing down the shutter speed [2 sec. at f/11 and ISO 80,  

ND2 neutral density filter]
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Working Deliberately

Digital photographers don’t incur any additional costs to take additional pho-
tographs. This simple fact all too often means that quantity takes precedence 
over quality. We often neglect to take a step back and think through a shot be-
cause we succumb to the pressure of hunting down yet another perspective or 
subject—there is, after all, no cost for doing so. But this habit often leads us to 
work less deliberately, leaving us with a larger number of images but few that 
actually have compelling compositions or thoughtful messages. Take the time 
before you shoot your first exposure to consider what angles of view are abso-
lutely essential to achieve your desired purpose. Once you’ve invested the time 
to analyze the spatial qualities of your subject, you’ll be able to eliminate some 
perspectives that would be less successful than others. You might come to the 
conclusion, for example, that while one perspective might theoretically result in 
an extraordinary image, in reality it might only produce mediocre results due to 
distracting surrounding elements, undesirable lighting, or the inability to frame 
a certain facade desirably.

The time you save up front by eliminating some angles of view can then be 
invested in the productive tasks of giving thoughtful consideration to your com-
position, fine-tuning your camera’s orientation, and waiting for the best possible 
moment to release the shutter. With more time allotted for each of your shots, 
you’ll be able to experiment with extra techniques such as using ND filters. All 
of these recommendations apply to indoor photography as well, where you can 
also make use of your extra time to arrange the interior furnishings perfectly for 
the specific angle of view you choose.
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Fig. 192: Interior photography  

captures an enclosed space  

and the objects within it
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3.11  Interior Architectural Photography

An interior shoot differs from an exterior shoot in various fundamental ways. In-
doors, the space in which the photographer can move is limited, and it is impos-
sible to communicate information about the size, shape, or exterior form of a 
building. Exterior shots portray a solid body that fills space, whereas interior 
shots portray the space enclosed by an external structure. In interior situations, 
the volume, sequence, and intersection of the room(s) determine the nature of 
the photo (fig. 192). 

3.11.1  Interior Subjects

Interior architectural photos portray enclosed space within a building, and the 
architecture that encloses the space is usually complemented by functional fur-
nishings or ornamental interior decoration (fig. 193). It is rare that photographers 
are offered the opportunity to photograph unfurnished interiors. Interior archi-
tectural photos no longer revolve around the overall structure of the building 
and accents provided by the fixtures and fittings take on greater significance. 

Fig. 193: This shot illustrates a successful interplay between architecture and interior design
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Fig. 194: Everyday objects immediately attract the viewer’s attention

Fig. 195: An interior shot, where superfluous furniture and many everyday objects have been removed
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The complexity and condition of the fixtures and fittings have a significant 
effect on the overall mood of the image. The emphasis on the architecture will 
be less in a photo of a room that is obviously lived-in and looks as if someone 
has only recently left. These types of photos are more often found in lifestyle 
magazines than in architectural publications. Familiar everyday objects such 
as newspapers, paintings, fruit bowls, or potted plants immediately grab a 
viewer’s attention (fig. 194), so it is no surprise that purely architectural interior 
shots often appear almost clinically uncluttered (fig. 195). Qualities such as liv-
ability and coziness are not crucial for capturing purely architectural elements. 
A misplaced plant that detracts from the intended effect of the room’s design 
is like a red rag to a bull for most architects. Superfluous furniture and every-
day objects are removed from purely architectural interiors before a shoot, 
and only a very few objects that set subtle accents become part of the final 
image (fig. 196). Generally, any object that doesn’t help illustrate a room’s pur-
pose should not find its way into the shot. 

It is essential to consider how you want to portray a space and how a photo 
will be used before starting a shoot. You can then arrange the space and its 
contents—there is sure to be something in a room that doesn’t fit into the 
overall concept. Carry a cleaning cloth for removing dust and grease, as there 
will always be fingerprints or smudges on smooth or polished surfaces. It is 

Fig. 196: An interior shot with few visual accents
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much easier to remove these blemishes before a shoot than it is to retouch 
them digitally. The same is true for dust and dirt on floors. Once your scene is 
clean, you can arrange the remaining objects to suit your particular purposes 
(fig. 197). Chairs that aren’t quite aligned with a vanishing point axis or tables 
that are not quite aligned with a wall can cause unwanted tension in an image 
and quickly make a scene look cluttered. You have to either arrange every-
thing perfectly or break all the rules by deliberately arranging things out of 
kilter to attract attention. For example, a photo of a dining table and chairs can 
be enlivened by moving a single chair slightly to face the camera. However, if 

Fig. 197: An interior shot that includes a number of carefully arranged props
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Fig. 198: An unconventional subject often makes for an interesting image

you are in any doubt, leave things tidy—a badly placed accent can spoil an in-
terior image to a much greater degree than a nonexistent one. 

By now, you will have realized that a photographer not only has to success-
fully bring the architecture to the fore, but also the relationship between the 
building and the objects and fittings within it. As is the case with exterior situ-
ations, in photos of interiors it is not the nature of the subject, but rather the 
feeling communicated by the image, that determines whether a photo is suc-
cessful. Unusual subjects often make exceptional photos (fig. 198) but tend to 
appear rather abstract.

Interior Architectural Photography
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3.11.2  Perspective and Standpoint

In interior situations, the photographer is located within the space that is to 
be photographed—a situation that severely limits movement and the num-
ber of potential locations for the camera. In order to produce sufficient sub-
ject distance and a realistic-looking image, you will often have to stand with 
your back against a wall or shoot through doors or other gaps in the architec-
ture. 

Interior spaces usually have square or rectangular floor plans, giving the 
photographer the basic choice of shooting with a central or a two-point per-
spective (also section 3.3.1). A central perspective photo (fig. 199) involves 
positioning the camera along the room’s central axis and shooting in the di-
rection of the far wall. The wall is oriented parallel to the sensor/film plane, 
limiting the depth, and preventing the appearance of converging lines with-
in the wall. This type of composition works well in small rooms, although the 
overall effect is not particularly dynamic. The larger a room, the more dis-
tance you have from the camera to the far wall and the more accentuated the 
feeling of depth will be. In very large rooms, the walls’ strongly converging 

Fig. 199: Central per-

spective gives this 

shot a clean, unclut-

tered look [focal 

length: 17mm]
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Fig. 200: The same 

room photographed 

using two-point per-

spective. The overall 

effect is much more 

dynamic, and all 

horizontal lines con-

verge toward the 

vanishing points 

[focal length: 17mm]

Interior Architectural Photography

horizontal lines contribute to the dynamic effect of the resulting image. This 
effect is particularly strong in images of symmetrical spaces that are shot to 
emphasize their symmetry. 

In order to create a photo with two-point perspective, we have to shoot 
diagonally into the space. This means that all nonvertical lines converge to-
wards imaginary vanishing points on the (usually invisible) horizon and con-
tribute to the feeling of style and depth (fig. 200). However, this type of im-
age is sometimes too dramatic and can result in inharmonious compositions, 
especially in narrow spaces. The viewpoint you choose will depend not only 
on how you wish the finished image to look, but also on physical limitations, 
such as the arrangement of the furniture or fittings. You may find that it is 
simply impossible to shoot using central perspective because the corre-
sponding parts of the room are full, or because a central viewpoint would 
produce unwanted reflections that require subsequent retouching (figs. 201 
and 202). The direction from which light enters the space or the presence of 
mixed light sources will also influence your choice of standpoint. 
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Fig. 202:  

The same space pho-

tographed using 

two-point perspec-

tive. This version con-

tains no unwanted 

reflections but pro-

duces a very different 

perspective effect. 

Fig. 201:  

Overview of a space 

photographed using 

central perspective. 

This results in 

unwanted reflections 

of the camera  

and tripod.
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Converging verticals are less of a problem in interior situations than they 
can be when shooting outdoors. This is because the difference between the 
height of the space being photographed and the vertical scope of the image is 
much less pronounced compared to an exterior shot. Interior shots contain 
fewer important visual elements in the upper parts of the frame, so it is easier 
to keep the camera level than it is in exterior situations. However, it is just as 
important to ensure that your camera is aligned correctly or that it will be pos-
sible to correct converging verticals later on. Even slightly off-kilter verticals 
quickly make interior shots look strange. In addition to inspecting your vertical 
lines, you also need to ensure that the horizon line, even though it is generally 
not visible for interior shoots, runs level through your image. In other words, 
every point at camera level must maintain the same height on a virtual hori-
zontal line or your image of an interior will feel tilted. If you’re shooting with a 
level camera, any vertical edges or seams will serve as a compositional aide as 
will horizontal lines that are at a right angle with respect to the camera. Take 
care when using furnishings, fixtures, and any potentially movable object to 
orient your camera, however, because these elements are often not properly 
aligned (fig. 203).

Fig. 203: Edges and contours that are useful for orienting your camera (red) and those that are less suitable (blue)

Interior Architectural Photography



150 Shooting Techniques

An exception to this rule occurs when we are photographing the interiors of 
churches and other extremely high-ceilinged spaces. In this case, we encoun-
ter similar problems with regard to converging verticals as we do when photo-
graphing very tall buildings from the outside. A shift lens can be an enormous 
help, and if all else fails, you can simply make the converging verticals part of 
your composition (fig. 204). Some outdoor subjects, such as market squares or 
enclosed courtyards, exhibit characteristics that are more similar to an indoor 
than an outdoor shoot, and need to be handled as such.

 Shooting at eye level (approximately 6 ft above floor level) produces natu-
ral-looking interior shots (fig. 205). The viewer usually instinctively assumes 
that interior shots have been taken from this position, and you can make low-
ceilinged rooms appear more spacious if you shoot from slightly lower (be-
tween about 3 ft and 4 ft above the floor). It won’t be immediately obvious in 
the final image that you have moved the perspective down a bit, making the 
ceiling look relatively higher with respect to the lowered (virtual) horizon. 
However, lower camera positions also increase the risk of some objects within 

Fig. 204: Converging verticals are used as part of the composition in this photo of a high ceiling [focal length: 17mm]
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Fig. 205: Shooting at eye level gives a photo a natural look and feel [focal length: 24mm]

Interior Architectural Photography

the space blocking the view of others. You should also consider, for example, 
whether the view under a table is preferable to the view along its surface. Only 
shoot from above eye level if you have to—for example, to prevent a piece of 
furniture or an architectural feature from spoiling your composition. Shooting 
above eye level can also be necessary if you need to emphasize the depth of 
distant objects within a space. 

3.11.3  Focal Length

Because of the limited space available and the restrictions this makes on your 
choice of camera position, wide-angle lenses are the best choice for shooting 
interior scenes. Their large angles of view combined with short subject dis-
tances often create an impression of space that exceeds that of the room being 
photographed, which can produce photos with misleading proportions. In 
contrast to most exterior situations, in which realistic reproduction of size and 
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space are very important, most architectural photographers accept the dispro-
portionate nature of interior shots, especially as this rarely spoils and can 
sometimes even enhance the effect of the design (fig. 206). Nevertheless, it’s 
important to exercise caution when selecting your lens. A good rule of thumb 
for choosing focal length is: As short as necessary but as long as possible. Our 
aim is not to test the physical limits of our equipment, but rather to produce 
interestingly composed, well-lit images with a clear message. Extreme wide-
angle effects are seldom beneficial to an image. Having said all that, there is, of 
course, nothing to be said against using ultra-wide-angle lenses to produce 
intentionally artistic effects (fig. 207). 

It has often been observed that the higher a room and the less depth it has, 
the wider the angle of a lens should be to produce a balanced composition 
that reflects the proportions of the real, three-dimensional space. The oppo-
site is also true: low, long spaces require longer lenses to produce harmonious-
looking results without tunnel-like effects. Remember, you can exercise sig-
nificant influence on the spatial effects in an image and prevent unwanted 
anomalies with careful use of different focal length lenses. 

Fig. 206: Using a very short lens and a short subject distance produces a feeling of space that is greater than what really exists [focal length: 14mm]
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Fig. 207: The vitality of this image is 

owed to the use of an ultra-wide-angle 

lens in combination with an unusual 

angle of view [14mm focal length]
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Fig. 208: The image format here was chosen to 

accommodate the dominant  

feature of the image

3.11.4  Image Formats

If you want your results to look authentic, the format you choose should reflect 
the overall proportions of the space you are photographing (fig. 208). Gener-
ally, the opportunities to work against this rule are limited by the size and posi-
tions of the elements within the image. Sometimes it makes sense to switch 
from portrait to landscape or vice versa based on the furniture in the room 
(figs. 209 and 210). Experimental formats that don’t reflect the orientation of 
the space you are working in usually produce sub-standard results. Portrait 
format shots of low, wide rooms are rarely satisfying and give too much em-
phasis to the less interesting ceiling and floor areas. Most interior shots are 
taken in landscape format. 
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Figs. 209, 210: Shooting from the 

exact same perspective but 

changing the image format can 

produce significantly different 

results. The landscape-oriented 

photo here emphasizes the expan-

siveness of the interior space and 

presents a neutral, realistic repro-

duction of the room. In contrast, 

the portrait-oriented photo high-

lights the desk and skylight, mak-

ing these objects the dominant 

elements of the scene. The latter 

photo seems more like a product 

shot, and it doesn’t convey much 

information about the dimensions 

of the room.

Interior Architectural Photography
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Especially under cramped conditions, ultra-wide-angle lenses and panora-
ma techniques can be used to capture images of large spaces (fig. 211). If you 
are shooting indoor panoramas, remember that the relatively close proximity 
of the subject matter will increase the degree of potential optical shifts from 
source image to source image, making it essential to plan and execute your 
shoot very accurately.

Fig. 211: A shift panorama constructed from multiple source images [focal length: 2 x 24mm]
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Histograms

A histogram is a graphical representation of the distribution of brightness levels 
within an image. The higher a peak, the more often the corresponding bright-
ness value occurs within the frame. A broad histogram curve represents a high-
contrast image, while a narrow curve represents one with less overall contrast. 
Histogram functionality is designed to help photographers judge image expo-
sure. It is an integral part of most image processing programs and is also built into 
most digital cameras. A histogram allows you to accurately judge the exposure of 
an image, even if your camera’s monitor is quite small or the ambient light is too 
bright for you to properly see the monitor image. Some cameras even have live 
histogram functionality, which allows you to see the histogram that your selected 
exposure values will produce for the scene currently displayed on the monitor or 
in the viewfinder. An overexposed image will produce a histogram curve that is 
biased toward the right-hand end of the scale, while an image that is too dark will 
have more peaks toward the left. If the curve intersects with the ends of the scale, 
your image is likely to contain burned-out highlights or blocked-up shadows.

Some digital cameras include functionality that displays separate histogram 
curves for each RGB color channel, enabling you to analyze your images even 
more precisely. 
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3.11.5  Framing and Composition

The same rules that apply to producing interesting and effective exterior shots 
also apply to interior situations, although in this case, the photographer’s room 
to maneuver is noticeably limited. Including elements of the surroundings or 
the sky is impossible, and composing a shot to include just one specific part of 
a room quickly reduces the magnitude of the photo to a scale at which the 
building is no longer recognizable as such (fig. 212). Here, individual architec-
tural details or aspects of the interior design take on the role of the main sub-
ject. However, these limitations also present opportunities for taking a more 
artistic approach to your photography (fig. 213) without having to resort to 
using two-dimensional or monotonous compositions. Skylights, staircases, 
and mirrors are great features for experimentation.

Fig. 212: A tight angle of view compels  

the viewer to pay attention to  

the details of a scene
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Fig. 214:  

An interior shot com-

posed according to 

the Golden Ratio

Interior Architectural Photography

Fig. 213: An artistic 

image of a building 

interior relying on a 

vertical perspective 

pointed directly 

upward
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It is important to analyze each room individually and to look for ways to ac-
cent its best features. The rule of thirds and the golden ratio (fig. 214) are both 
useful guidelines for producing well-proportioned images, while creative use 
of doorways, arches, and other gaps in the surrounding structure often helps to 
produce interesting and unusual photos. Portraying the transition from an inte-
rior to an exterior view also offers a whole range of new photographic possi-
bilities (fig. 215). 

In interior shots in which architecture is meant to be the center of attention, 
people are rarely included because they have the unwanted effect of dominat-
ing the scene. People also take the emphasis away from the structural side of 
the image and give it an overly personal touch.Because the size of the windows, 
doors, and other fittings are implicit within the space being photographed, hu-
man subjects are also rarely required to illustrate scale. 

To liven up an interior architectural shot, however, you can integrate moving 
people. The motion blur of human figures brings life to an otherwise static 
scene (fig. 216). Because interior photos are generally shot with longer shutter 
speeds to begin with, you can generally dispense with an ND filter. Shutter 
speeds between 1/4 second (for quick movements across the camera) and 2 
seconds (for leisurely movements toward or away from the camera) are suitable 
for this purpose. If a precise representation of the design is less important, you 
can even extend this method to use artistically blurred human subjects (fig. 217) 
or even their shadows to emphasize the feeling of space in an interior shot.

Fig. 215: An interior 

shot illustrating the 

transition from inte-

rior to exterior space 
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Fig. 217:  

Using movement to 

add artistic flair to an 

interior shot [0.8 sec. 

at f/10 and ISO 100]

Fig. 216:  

Blurred human 

figures bring life to 

architectural scenes 

that are otherwise 

relatively static  

[0.5 sec. at f/9 and 

ISO 100]
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3.11.6  Camera Settings and Lighting

The ideal camera settings are generally the same for interior and exterior 
shots. Because it is usually darker inside a building than outside, a tripod is 
absolutely essential for preventing the camera shake that longer shutter 
speeds would cause. The differences in interior and exterior lighting are par-
ticularly obvious in and around windows, which often produce extreme rang-
es of contrast that neither digital nor analog cameras can capture in a single 
exposure. You can counteract the resulting overbright highlights or detail-
free shadows in a number of ways. 

The simplest approach is to simply accept that windows will appear ex-
tremely bright and detail-free and focus on producing a balanced exposure 
for the rest of a room (fig. 218). It is often the case that objects and elements 
outside the room are irrelevant or distracting anyway. All you have to do is 
take a matrix or center-weighted meter reading for an average bright area 
that contains no windows. Once you have either selected your exposure val-
ues (in manual mode) or saved the meter reading (refer to your camera’s man-
ual to identify the appropriate button), you can reframe the image to include 
the overbright areas and release the shutter. Always use the histogram dis-
play to make sure you have captured the maximum possible range of tonal 
values—the histogram curve should reach but not intersect with the left-
hand (shadow) end of the scale and should cross the right-hand (highlight) 
end at as low a level as possible. If your camera has exposure modes that ex-
tend the dynamic range in a way that also carries over to the RAW image data, 
you should activate them now.

Another way to balance interior and exterior lighting is to use wirelessly 
controlled flash units positioned to produce no obvious shadows while mak-
ing sure they are themselves not visible within the frame. Ideally, the resulting 
effect will make it look as if the darker areas of the scene are lit by natural light. 
Unfortunately, the powerful, flexible flash units necessary to create this type 
of effect are beyond the budget of many hobbyist photographers. In place of 
these flash units, they can use one or more of the dedicated flash units sold by 
major camera manufacturers that have built-in infrared or radio-based con-
trol functionality. Some systems also allow your camera’s built-in flash unit to 
be used as a “master” unit to control additional off-camera “slave” units. 

The larger the room and the brighter the light entering the windows, the 
more difficult it is to produce adequate lighting using conventional flash 
equipment. One way to work around this type of problem is to deliberately 
underexpose to keep details beyond the windows visible and to light the rest 
of the frame by firing several indirect flashes in different directions while the 
shutter is open. If the shutter speed you are using makes it impossible to fire 
multiple flashes during the exposure, you can always use a sequence of im-
ages to produce the result you are looking for. Position your flash for each 
image so that it illuminates a different part of the scene without itself being 
visible in the frame, but try to avoid positioning it behind or to the side of the 
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Fig. 218: This image was exposed for the interior, which in turn causes the window areas to appear excessively bright as a result of the marked contrast

Interior Architectural Photography
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camera. One option is to use very powerful LED flashlights (>1600 lumens) 
with LED conversion filters (e.g., from LEE Filters) that provide continuous il-
lumination, making the effects of the artificial lighting easier to judge. It is 
then relatively simple to use layers and masks during post-processing to 
merge a sequence of source photos into a single, well-exposed image. There 
is also specialized software available for performing light-balancing tasks, 
such as HDR ReLight by Oloneo, which allows you to control the impact of the 
light sources in your source images individually. This technique can also be 
used to photograph unlit rooms with no windows at all (fig. 219). And 

Fig. 219: A photo of a dark interior created by merging several source images illuminated using an 

off-camera flash
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 remember, it is virtually impossible to exactly reproduce the mood of the 
lighting built into a building’s design if you use flash as a subsidiary light 
source. 

Another effective way to produce interior shots with balanced lighting is to 
shoot a bracketed sequence and merge the resulting images using HDR or 
DRI software (or to do it manually with layers and masks). This ensures that the 
finished image contains detail across the entire frame and that deep shadows 
and bright highlights are not clipped (fig. 220). It is important not to overdo 
HDR and DRI effects, as they can quickly produce unrealistic-looking results. 

Fig. 220: An interior shot created using subtle DRI effects

Interior Architectural Photography
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Don’t attempt to darken your highlights so much that they could pass for 
midtones, as this only produces photos that look like paintings. Always aim to 
keep contrast realistic-looking while preserving visible detail in both high-
light and shadow areas. A bracketing sequence should consist of at least three 
exposures or, in situations with an extreme range of contrast, five source im-
ages with exposure values ranging between a total of at least +2 and –2.

If you want to be able to adjust white balance after shooting, you will have 
to shoot using your camera’s native RAW format. This is especially important 
in situations where the color temperatures of the interior (warm) and exterior 
(cold) light sources differ widely. If you use additional flash to brighten a room 
that has little or no artificial light, you can use special blue-colored filter gels 
(for example from LEE Filters) attached to the flash to adjust the temperature 
of the flash light to match the immediate environment. There are also filters 
available that warm flash light to match a dominant artificial light source if 
there is little or no exterior light. Bright room lights strongly accentuate the 
differences between the color temperatures of artificial and incident natural 
light. Additional lighting challenges include multiple artificial light sources 
with different color temperatures such as LED, incandescent, halogen, and 
energy-saving bulbs; the simplest workaround here is simply to switch off any 
lamps whose color temperature differs widely from the dominant light source. 
Some photographers even attach colored gels to windows in order to match 
the outside light to the artificial indoor light, but this is a very complex and 
time-consuming approach. A simpler solution is to shoot after it gets dark 
(fig. 221) because then most light from outside will be artificial. But take care 
not to take your photos too early: The light is still extremely cold during the 
blue hour (section 3.12.5). Correcting the blue cast from outside lighting is 
possible in post-processing to a certain extent, where bluish areas are select-
ed and then saturated with a warmer color tone. If you are using HDR or DRI 
techniques and your image contains a significant amount of natural light, you 
can use cooler white balance settings to “develop” the overexposed source 
images and warmer settings for the underexposed ones. This technique as-
sumes that brighter image areas are lit by daylight and that darker areas are lit 
artificially. Yet another method is exposing your image twice: once with and 
once without artificial lighting. During post-processing, you can layer the two 
versions so that color values from the image without artificial light are used 
along with the brightness values from the version with artificial light. These 
are effective methods to attenuate strong differences in color temperature, 
even if they cannot eliminate them entirely. 

There are no hard and fast rules governing the number and strength of 
lamps you can use to light a room. Bright overall lighting is better in some 
situations, while selective use of individual accents is better in others. If, for 
example, the sun is low in the sky and its light enters the room via a window, 
the best solution can be to do without artificial light altogether (fig. 222). If in 
doubt, the best solution is to give yourself a choice by taking multiple shots of 
a single scene using as many different lighting setups as possible. 
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Fig. 222: An artistic 

interior shot created 

without the use of 

artificial light

Interior Architectural Photography

Fig. 221: This photo 

was shot late enough 

in the day so that no 

natural light seeped 

in from the outside to 

mix with the room’s 

artificial lighting
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3.12  External Factors That Influence a Shoot

These are the factors influencing a shoot that you can do little or nothing 
about. The photographer’s approach to dealing with these factors is critical 
to the success of an architectural photo.

3.12.1  The Perfect Moment

Realizing an idea for a photograph demands a lot of a photographer: prep 
work for the shoot, a thoughtful perspective, the technical knowhow to pro-
gram the best camera settings, and above all, the patience to wait for the 
right moment to take a picture.

Only after all of the movable elements that affect a photo’s composition 
are in the right place is it time to release the shutter—for example cars, pe-
destrians, and clouds must all be out of the way or in their ideal positions 
with respect to the main subject. Weather can be even more of a critical fac-
tor. One can’t always count on cloudless skies, which means that even with 
scattered clouds, your architectural subject will end up obscured in shadows 
from time to time during the day. Depending on how cloudy and windy it is, 
these windows of blocked sunlight may last for a while. In these situations, 
photographers have to exercise patience to wait for the sun to break through 
and for the reflections and shadows to take on the desired appearance for 
the shot.

The window of time for the perfect moment of exposure can range from 
fractions of a second to several minutes. This fact alone makes working with 
a tripod essential, because it’s not practical to stand around with the camera 
in your hand for indefinite periods. Working with a tripod has other advan-
tages too: It’s not uncommon that some elements of your scene will be in the 
right position while others are not. A tripod allows you to capture several it-
erations of the same scene with an identical frame, allowing you to selec-
tively meld the best moments of various photos into one image during post-
processing.

Perceptiveness is of the utmost importance for photographers to be able 
to spot the ideal time to release the shutter. They have to observe and ana-
lyze the setting for their shot. Ideally, photographers should be aware of the 
environmental variables or lighting conditions that could positively or nega-
tively influence a photo shoot well before the actual work of exposing im-
ages takes place. Some photographers prefer to work intuitively, relying 
largely on spontaneous feelings; others lean on a wealth of experience re-
lated to specific shooting circumstances to sense exactly when the ideal mo-
ment is nearing (fig. 223). Sometimes this critical moment emerges quickly—
don’t ever let your guard down!—and other times it can be a long time com-
ing. Perseverance is often rewarded with exceptional results.
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Fig. 223: Perfect timing: a cloud fleetingly passed through 

the upper right area of the image to provide some  

texture to the otherwise flat sky
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A

B
B

The Effects of Shadows

In architectural photography, one often deals with various manifes-
tations of shadows. They are usually caused by nearly parallel rays 
of light coming from the main light source present in almost all ar-
chitectural photographs: the sun. A cast shadow is the shadow of an 
object (A) projected onto a surface or other objects. An object will also 
create its own shadow, which covers the surface facing away from the 
light source (B). This area is only lit indirectly by reflections coming 
from the surrounding area. It is interesting to note that the edge of 
the cast shadow is originated by the edge of the object’s own shadow 
(represented by the dotted red line).
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3.12.2  Shadows and Reflections 

Shadows and reflections caused by the sun can have positive and negative 
effects on the look and feel of an architectural photo. 

Shadows cast by other buildings or objects produce silhouettes on a build-
ing’s façade, walls, roof, or the surrounding ground, while their nature is influ-
enced by the position of the sun. A hard shadow that falls across the entire 
front of a building can spoil the aesthetics of the architecture and makes cal-
culating the correct exposure values extremely difficult. However, this type of 
situation is relatively easy to work around using either a graduated filter or 
HDR/DRI imaging techniques. Shadows can also have positive effects on the 
appearance of a building, especially if it has an otherwise monotone or two-
dimensional look. In this case, a shadow can form a compositional element of 
its own and add to the dynamics of the image (fig. 224). Protrusions and 

Fig. 224: The obvious shadows have been deliberately used to enliven this image
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 depressions in a building’s façade often produce short, dark shadows that are 
an integral part of the look of the architecture. If the sun is low in the sky and 
positioned behind you, you run the risk of including your own shadow or that 
of your camera/tripod in the image. In such situations, the best solution is to 
alter your standpoint until your own shadow is covered by that of another 
building or object (fig. 225). Failing that, you will simply have to look for an 
alternative camera angle. 

Façades that fall within a building’s own shadow exhibit much lower con-
trast than parts of the building that are directly lit, and appear dull and two-
dimensional as a result. However, directly lit parts of a building often display 
less detail than shaded parts due to the effect of the very dark shadows and 
extremely bright highlights they include (fig. 226).

Reflections can cause effects similar to shadows, with similarly positive 
(fig. 227) or negative results. They are more or less pronounced, depending 
on the material of the façade—for example, modern glass often reflects near-
by buildings (fig. 228), thereby emphasizing the nature of the material. This 
type of effect can be so dominant that it actually overshadows the effect of 
the architecture itself.

Fig. 225: Here, a carefully selected viewpoint prevented 

the photographer’s own shadow from entering the frame

Fig. 226: A façade located in the building’s own shadow (left) 

and directly lit (right)
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Fig. 228: The nature of the material in the foreground produces an additional visual level reflected in the façade

Fig. 227: Reflections enhance the dynamic aesthetics of this image
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Fig. 229: Direct 

sunlight produces 

tactile images with 

intense colors and 

strong shadows

Fig. 230: A cloudy sky  

gives the same scene 

a low-contrast look 

with soft shadows
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3.12.3  The Effects of Weather

The weather is a factor we have no influence on but which can have a signifi-
cant effect on the appearance of a building. Direct sunlight with few or no 
clouds produces dark shadows, bright reflections, high image contrast, in-
tense colors, and a highly tactile overall look and feel. Such conditions can 
produce very aesthetic images and show the building in its best light, so to 
speak (fig. 229). 

On the other hand, cloudy skies produce much lower contrast with soft 
shadows and a much more diffuse overall look. With an overcast sky, the light 
is scattered over a wide area, and the transitions between bright and dark ar-
eas are much softer (fig. 230). Reflections, too, are less intense. Cloudy situa-
tions give architecture a generally less vivid look—an effect that is not neces-
sarily a disadvantage. In the northern hemisphere, north-facing façades are 
much easier to photograph under cloudy conditions, due to the reduced in-
tensity of the backlight implicit in such situations (fig. 231).

Wait for the most neutral weather conditions possible if you are shooting 
for documentary purposes—i.e., try to shoot in typical local conditions. Un-
usual weather conditions, such as a beach hut surrounded by snow, produce 
an unauthentic look. If you are shooting for artistic purposes, you can, of 
course, include as many contradictions in your image as you like, and dra-
matic weather is great for attracting a viewer’s interest. The time during or 
just after a shower of rain is perfect for capturing otherwise nonexistent re-
flections (fig. 232). Snow and fog (fig. 233), too, are elements that can be used 
in the creation of surreal but interesting architectural photos. 

Fig. 232: A recent shower of rain provides an 

additional reflective element

Fig. 231: Clouds reduce the strength of the backlight and make it easier to expose this shot of a 

north-facing façade
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Fig. 233: Fog tends to make architectural photo-

graphs feel surreal while simultaneously  

endowing them with an air of intrigue
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3.12.4  The Sky and Clouds

The sky makes up the background of the top portion of nearly every outdoor 
architectural photo and it has a significant influence on the overall effect of an 
image. Structures in the sky may have a subtle and restrained look or they may 
appear striking and chaotic, thus dramatically affecting the appearance of a 
building either for the better or the worse.

Clouds are the primary structural element of the sky, and vapor trails from 
passing airplanes fall into this category too. In addition to these elements, 
however, are rays of sunlight visible because of atmospheric moisture (so-
called crepuscular rays or “God’s rays”), birds and other flying objects, precipi-
tation, rainbows, and even lightning, all of which can influence your photos. 
Viewers tend to find these visual elements out of the ordinary, so architectural 
photos featuring them usually take on a charged quality.

In contrast, clear blue skies don’t have nearly as much influence on photos 
of architecture. The large, uniform surface produces a highly neutral back-
ground for the subject, and the portion of the image area devoted to a cloud-
less sky does nothing to increase the sense of depth of a photograph. In some 
cases, though, a subtle gradation just above the horizon line resulting from 
atmospheric conditions endows photos with a certain sense of depth. Using 
ultra-wide-angle lenses with graduated filters is a productive way to bring 
some more plasticity to pictures featuring cloudless skies (fig. 234).

Fig. 234: A subtle  

gradation in this 

cloudless sky contrib-

utes to the photo’s 

sense of depth

External Factors That Influence a Shoot
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The presence of clouds immediately makes architectural photographs more 
dynamic, because their structural shapes invite the viewer’s gaze into the im-
age. That doesn’t mean clouds are always an improvement: if the right cloud 
finds itself in the right position in your photo, the upside for the architectural 
subject can be tremendous (fig. 235); on the other hand, clouds can become a 
dominant feature that detracts from your intended subject. Reflections from 
glass facades and windows can also be positively and negatively influenced by 
the presence of clouds. In some cases, a gentle cirrostratus cloud can pleas-
antly accent a large surface of glass, and in others, a billowing heap cloud may 
mar an otherwise pristinely uniform reflective building front.

It’s also important to consider the representation of clouds in certain special 
photographic situations. For example, if you’re working with a strong ND filter 
(section 3.10) during the day to allow for the use of slow shutter speeds (>5 
seconds), then you can effectively capture cloud movements in your images. 
This effect produces dynamic images with cloud structures blurred in the di-
rection of the wind—an appearance that contrasts markedly with our natural 
perception of the scene. When this blurry cloud movement is captured as the 
background of an architectural photo shot from an upward perspective, the 
results are often fascinating and abstract. Shooting during the beginning of 
the blue hour (section 3.12.5) can also dramatically benefit architectural photo-
graphs featuring high cirrus or cirrocumulus clouds. These clouds function as 
projection surfaces for the last rays of a sun that has already sunk below the 
horizon and is no longer visible from the camera’s perspective, producing a 
dramatic play of color (fig. 236). 

Fig. 235: Fine cloud structures very high up in the atmosphere enliven this image and provide the 

scene with spatial depth
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Fig. 236:  

The gentle, pastel 

colors of this calm 

evening sky contrast 

effectively with the 

geometric façade of 

this building
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Fig. 237: Cirrus (left of the image center),  

cirrostratus (right of the image center),  

and cirrocumulus clouds (smaller spotted  

area, far right), as well as manmade  

vapor trails (left)

Fig. 238: Expansive altostratus clouds  

produce a relatively diffuse light

Fig. 239: Altocumulus clouds establish the  

background for this architectural photo
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Below, you’ll find an overview of the different types of clouds that can form 
in the sky and their relative effects on architectural photography:

Cirrus: Cirrus clouds are high-level formations that generally improve archi-
tectural photographs through their wispy, thread-like appearance that en-
livens the background and creates a feeling of lightness in the composition. 
High-altitude winds tend to cause cirrus clouds to appear frayed or unraveled, 
making these bright white figures have a relatively thin but nonetheless pow-
erful shape capable of making the sky glimmer in certain areas. Sheet-like 
cirrostratus clouds and cirrocumulus clouds (sometimes called herringbone 
clouds) take on different shapes from their cirrus counterparts, but they also 
belong to the same class of high-level clouds and generally produce positive 
results in architectural pictures (fig. 237).

Vapor Trails: These artificial cloud formations, also known as contrails, are 
composed of ice crystals resulting from aircraft exhaust. Despite their man-
made origins, they fall into the same category as cirrus clouds, because they 
form at a similar altitude (> 8km) and they have a similar appearance. Con-
trails can pose some problems for photographers if they appear in otherwise 
cloudless skies because they usually form in a straight line; and this geometric 
quality tends to command the viewer’s attention, detracting from the photo’s 
main subject. But conversely, they can also produce positive effects when 
such lines or crosses artfully break up an otherwise uniform sky.

Altostratus: These specimens are middle-altitude clouds and they generally 
lack a definite shape, instead forming a broad layer with a gray-blue color 
(fig. 238). The sun usually still penetrates altostratus clouds, but it takes on the 
appearance of a vague area of brightness. When these clouds scatter sunlight, 
the result is a soft, diffuse light that produces subtle shadows, if any at all. 
While photos shot in these conditions often take on a pleasant atmospheric 
look and feel, others tend to come off as somewhat bland. Other weather 
conditions are often better suited for depicting a building in its best light.

Altocumulus: The middle-altitude area is also home to altocumulus clouds, 
but these formations differ from their altostratus counterparts in that they 
have a torn, frayed, and relatively fine texture (fig. 239). It’s easy to mistake 
them as cirrocumulus and stratocumulus clouds, but if you extend your arm 
and measure their thickness with your fingers, altocumulus clouds are gener-
ally between one and three fingers wide. Depending on their appearance and 
thickness, these clouds can have positive or negative influence on architec-
tural images, because they have a more dominant presence than clouds that 
form at higher altitudes.

External Factors That Influence a Shoot
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Cumulus: Classic cumulus clouds are heaping formations that occur at low 
altitudes. They’re often described as puffy or cotton-like, featuring a flat un-
derside and a billowy top. Cumulus clouds often form defined shapes with a 
significant thickness, which makes them very dominant features in architec-
tural photographs. Unlike plain blue skies, these clouds can overwhelm the 
architectural subject visually, appear to grow out of the building at hand, or 
visually detract from key details in a building (fig. 240). Furthermore, they’re 
capable of blocking the sun from your photographic subjects for extended 
periods of time depending on the number of clouds in the sky and the speed of 
the wind, which may result in long periods of waiting while shooting, especially 
if your composition depends on direct sunlight.

Stratocumulus: Clouds in this class form at low altitudes. Their undersides 
tend to blur together and their tops are flatter and less discrete than cumulus 
clouds. Stratocumulus clouds often make for subtle but powerful accents in 
architectural photos.

Fig. 240: A cumulus cloud dominates the sub-

ject here, because it appears to grow out of 

the building, compromising the emphasis on 

the architectural details

Fig. 241: The Flatiron building beneath a thick cover of clouds. The local contrast in the sky area was boosted to accentuate the narrow subject.
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Stratus: Stratus clouds are the third type to form at low altitudes. Similar to 
altostratus clouds, they generally form in layers rather than distinct shapes, and 
they can practically reach down to the earth’s surface (high fog). They are not 
generally useful for architectural photos on account of their expansive surface 
area and tendency to block out sunlight. In fact, they are often accompanied 
by a light drizzle. That’s not to say that they can’t at times play a decisive role 
in effective architectural photos (fig. 241). Photographers do well to watch the 
cloud cover closely when stratus clouds are about because they frequently 
burn off as the day goes on.

Finally, there are also nimbostratus and cumulonimbus clouds. But these 
formations often mean rain (fig. 242) or thunderstorms, and such weather 
conditions are beneficial to architectural photographers only on the rarest of 
occasions.

External Factors That Influence a Shoot

Fig. 242: Nimbostratus clouds support the dramatic feel of this photo, which was exposed just before rain started to fall
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Fig. 243: A dramatically backlit scene owing to the time of day [1/100 sec. at f/16 and ISO 80]

Fig. 244: A building illuminated by the special light of the blue hour [8 sec. at f/10 and ISO 100]
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3.12.5  Choosing the Right Time of Day

The time of day is the factor a photographer can influence 
most (fig. 243). Under cloudy skies, the differences be-
tween morning and afternoon light are negligible, where-
as bright sunlight can produce a wide variety of lighting 
situations through the course of a day—façades that are in 
the shade in the morning can be directly lit at midday. The 
time of day also influences the shape and intensity of shad-
ows cast by other objects, and some buildings are only lit 
by sunlight for a short phase of each day. It is always a 
good idea to research your planned location in advance of 
a shoot using maps or online satellite images. Apps for 
smartphones and tablets such as The Photographer’s 
Ephemeris are also excellent tools for preparing to shoot in 
a specific location. These apps can give you critical infor-
mation about the sun’s path, including the specific sunrise 
and sunset times for any location in the world. Other infor-
mation about sun height, shadow length, start and end 
times for the blue hour, and many other details are also 
available.

An especially interesting time for architectural photog-
raphers is the so-called “blue hour” that occurs just after 
sunset when the sky is still indirectly lit by the sun and arti-
ficial light begins to have an effect on a scene (fig. 244). 
Photos shot at this time of day are well known for the color 
of the sky and their intense overall mood. In contrast to 
night shots, the unlit areas of blue hour photos are still in-
directly brightened (figs. 245). The same effect—caused by 
the stray light emanating from the invisible sun—also oc-
curs in the early morning hours.

During and after nightfall, the lighting emphasis in 
most architectural scenes is reversed, and a building’s inte-
rior, which is difficult to see in daytime, becomes the glow-
ing central subject at night. Windows, which are often the 
darkest and most reflective elements of a façade during 
the day, become blazing transparent surfaces at night 
(fig. 246). In contrast, darker parts of a building often ap-
pear formless in the dark. Using HDR or DRI techniques is a 
great way to produce balanced contrast in night shots. The 
pronounced contrast between light and dark areas makes 
exposure bracketing extremely practical for night photog-
raphy where the merged exposures exhibit a balanced dis-
tribution of brightness with no one area too overexposed.
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Fig. 245: This building was shot right before the 

end of the blue hour: the illuminated areas stand 

out dramatically while the unlit areas fade into 

the background [10 sec. at f/9 and ISO 100]
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Fig. 246:  

A classic night shot with 

an impressively glowing 

subject [20 sec. at f/6.7  

and ISO 100]
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3.12.6  The Effects of the Seasons

The season is the external factor that you will least be able to influence, and 
the appearance of the vegetation surrounding a building will change signifi-
cantly in the course of the year. Leafy trees can block the view of a building in 
summer, but present no problem in winter. Autumnal colors give an image a 
completely different look than springtime green (fig. 247). These types of im-
pressions have an immediate and obvious effect on the look and feel of an ar-
chitectural photo. Cool blue tones will always produce different feelings in a 
viewer than warmer yellow or red tones.

Fig. 247: The seasonal coloring of the surrounding vegetation is an important factor in the overall look of an image
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Fig. 248: Shot in late summer at midday, the sun is high in the sky 

and gives this image strong colors and contrast

Fig. 249: The same scene shot in winter, again at midday. The 

overall look is cooler, and the low sun provides diffuse light.

Fig. 247: The seasonal coloring of the surrounding vegetation is an important factor in the overall look of an image

External Factors That Influence a Shoot

The sun’s path changes with the seasons, too. The light from a low winter 
sun has farther to travel through the Earth’s atmosphere, making it more dif-
fuse than summer sunlight. Winter sunlight also produces long shadows and is 
often the cause of backlit situations, making a balanced exposure more diffi-
cult to achieve. The summer sun is high in the sky and casts short shadows that 
give buildings a more immediate, accented look (figs. 248 and 249).
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3.13  Creative Tips and Tricks

The following sections offer detailed tips and tricks for taking creative archi-
tectural photos. 

3.13.1  Extreme Framing

Clever composition combined with tight framing accentuates detail and 
gives a building a completely new, stylized look (fig. 250). An extension of 
the same idea involves layering multiple details to form complex, almost 
completely abstract images that can be quite difficult to interpret (fig. 251). 
Tight crops that contain no guides as to scale can also appear quite abstract 
(fig.  252). You can use techniques like these to alter the appearance of a 
building so as to make it unrecognizable. The textures and patterns within its 
design become a part of a graphical whole, while the actual architecture 
takes on a background role (fig. 253). 

Fig. 251: Using multiple visual layers produces 

an abstract effect [focal length: 88mm]

Fig. 250: Tight framing adds emphasis to the shapes and structures within the building 

[focal length: 70mm]
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Fig. 252: A lack of reference objects makes it impossible to judge the scale of the subject

Fig. 253: Extreme framing brings shapes, patterns, and colors to the forefront in this image [focal length: 40mm]
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Fig. 254: The unusual  

camera position looking 

straight upward gives this 

image an interesting but 

unfamiliar look [focal 

length: 14mm]
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3.13.2  Shooting Upwards

Human beings generally perceive their surroundings on a horizontal plane by 
looking forward, and we rarely allow the horizon to leave our field of view. 
Looking upward produces an unusual, unfamiliar view of a building that lacks 
context and confuses our perception of spatial relations (fig. 254). This type of 
view, especially in interior situations, can convince the viewer that a wall is a 
ceiling or vice versa. The sky suddenly becomes a large, uniform background 
that is perfect for setting off the features of the subject. A vertical view also 
allows you to rotate the frame in any direction without breaking any funda-
mental rules of composition (fig. 255).

Fig. 255: Large areas of sky set the stage for the receding skyscrapers in this overhead shot [focal length: 14mm]

Creative Tips and Tricks
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3.13.3   Image Sequences

Another way to photograph buildings creatively is to shoot a sequence that 
gives multiple images a mutual context. My example shows a sequence with 
a “doors” theme (fi gs. 256 and 257). As long as the theme is clearly recogniz-
able, materials, colors, lighting, and exposure can vary widely from image to 
image. Selecting the right images to display together is an integral part of 
shooting a successful sequence—one of the more artistic approaches to ar-
chitectural photography.

Figs. 256, 257: Two image sequences: Combining multiple images that have a common theme gives individual photos a new and interesting context
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3.13.4  Extreme Use of Reflections

Reflections are particularly effective if they produce a second, separate visual 
layer within an image. Again, clever composition in combination with reflec-
tive materials can produce images with a deeper message or a symbolic feel—
for example, by combining elements of old and new, light and heavy, or trans-
parent and opaque (fig. 258).

Reflections can be so abstract that the viewer no longer comprehends what 
he/she is seeing. Extreme compositions created using layering or sequential 
techniques can be used to create crazy mixtures of shapes, textures, and de-
tails. In such cases, the architecture itself becomes a mere background on 
which you can project your own personal message (fig. 259).

Fig. 258: An example of implicit symbolism through reflection: here, 

wood is simultaneously reflected in its original form and used in  

processed form as a building material

Fig. 259: Ambiguous spatial relations produced by strong reflections

Creative Tips and Tricks
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3.13.5  Selective Over- and Underexposure

Using selective under- or overexposure is another way to give your architec-
tural photos a unique creative edge. Deliberate underexposure emphasizes 
brighter details within the frame while further darkening midtones and 
shadows, creating a surreal, bleak look (fig. 260). Selective overexposure has 
the opposite effect. All zones that contain brightness above a certain level 
are reproduced in white and give an image a frameless, floating look (fig. 261). 
The emphasis on form and texture makes this type of photo less authentic 
and more artistic. This is why under- and overexposed images often remind 
the viewer of computer-generated or graphic illustrations. 

3.13.6   “Before and After” Views

Comparing views of a building at different times is an effective way to illus-
trate the passage of time. In an architectural context, this technique can be 
used to show a building from the same viewpoint but at different times of 
year, or at various stages in the course of its construction (fig. 262 and 263). 
Other examples are views of a building before and after renovation or a 
change of owner (fig. 264 and 265).

3.13.7   Fake Miniatures

The tilt function of a tilt/shift lens can be used to create so-called “fake minia-
tures.” This technique involves tilting the plane of focus so that just a very small 
portion of the potential depth of the image remains in sharp focus while all 

Fig. 260: Creating a particular look using deliberate underexposure ... Fig. 261: ... or using deliberate overexposure
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Figs. 262, 263: “Before and After” views of a subject are real eyecatchers

Figs. 264, 265: Side-by-side comparison of a room interior before and after remodeling
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Fig. 266: Using a tilt/shift lens to create a fake miniature effect

other details recede into blur (fig. 266). The resulting shallow depth of field 
(normally associated with close-up photography) makes photos of life-size 
subjects look like miniature scale models. Optically, this effect can only be pro-
duced using tiltable lenses, with longer lenses producing a stronger effect 
than shorter ones. Even at wide apertures, regular lenses produce too much 
depth of field to create this type of effect.

Fake miniature effects are most effective in shots taken from a raised view-
point, such as a bridge or a tower. The more individual objects in the scene and 
the greater the subject distance, the more striking the effect will be. Objects 
that are too close to the camera tend to spoil the overall effect. Fake miniature 
effects can also be produced digitally (section 4.6.4).
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3.14  Solutions to Common Problems

Shooting HDR source images without a tripod: Merging a bracketing se-
quence into an HDR/DRI image is an effective way to capture high-contrast 
subjects that exceed your camera’s normal dynamic range. It is still possible to 
shoot usable sequences of source images, even if you don’t happen to have a 
tripod with you. 

HDR and DRI source images have to be framed identically to be effective. If 
you try to merge images that are framed slightly differently, some details will 
not overlap correctly and the merged image will be spoiled. The closer your 
subject, the more obvious slight differences in perspective become, so it is es-
sential to keep camera movements between shots to a minimum if you are 
shooting without a tripod. Combined with bracketing functionality, continuous 
shooting mode allows you to shoot a sequence of differently exposed images 
handheld in a very short space of time and with only minimal shifts of camera 
position. Make sure that the longest exposure of your sequence isn’t so long 
that it includes visible camera shake. But remember, you will still have to align 
your source images digitally, making handheld bracketing sequences at best a 
makeshift solution that only works if the scene you want to capture is brightly lit. 

Shooting shake-free photos without using a remote release: If you are 
shooting in low light using a tripod, it is always preferable to use a remote 
shutter release to prevent camera shake. If you don’t have a remote release 
on hand, your camera’s self-timer can help you avoid camera shake caused 
by human contact with the camera. Using the camera’s mirror lock-up feature 
improves the situation further by ensuring that the movements of the mirror 
aren’t transmitted to the camera body while the shutter is open. 

The self-timer’s built-in delay means that you cannot precisely determine the 
moment at which the shutter is released, so if you cannot live with this limita-
tion you will have to release the shutter by hand. This is not usually a problem 
in daylight, but the longer shutter speeds required in low light make things 
more difficult. You can reduce vibration if you support the hand pressing the 
shutter button with your other hand, and the heavier your tripod, the less of a 
problem camera shake will be. 

Preventing blurred images and camera shake: Bad weather and low light 
quickly extend shutter speeds to a point at which you can no longer shoot 
handheld. A simple formula—1 / (Focal Length x Crop Factor)—provides you 
with the shortest usable shutter speed for most situations. For example, a cam-
era with a Four Thirds sensor (crop factor 2) and a 200mm lens requires the use 
of a minimum shutter speed of 1 / (200 x 2) = 1/400 second. This rule was origi-
nally formulated in the analog age to cater to small-scale prints. If you are using 
a camera with a particularly high-resolution sensor, or if you want to make very 
large prints, camera shake may become visible sooner. If you are in any doubt, 
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always select a shorter shutter speed. Many contemporary DSLRs and lenses are 
equipped with built-in image stabilizing functionality, although these systems, 
too, have physical limits beyond which they are not completely reliable. 

When using a modern DSLR in low light, you can increase the ISO value, but 
remember that higher ISO values nearly always increase the amount of visible 
noise and reduce the available dynamic range in your images.

Opening the lens to a medium aperture value will help to reduce the risk of 
camera shake, but it is generally inadvisable to shoot architectural photos with 
the maximum aperture, especially if you are not using a high-end lens. Wide 
apertures produce more visible lens errors, so use your maximum aperture only 
if you have already exhausted your other options, such as increasing your ISO 
value as far as the visible image noise is acceptable for you. A correctly exposed 
image using a high ISO value (fig. 267) nearly always looks better than one with 
edge blur, chromatic aberrations, vignettes, or too little depth of field.

One of the simplest ways to prevent camera shake is to use found objects 
such as walls, balustrades, ledges, tables, chairs, or even parked cars as a kind of 
emergency tripod. Use a soft cloth or bag to prevent your chosen surface from 

Fig. 267: A handheld night shot taken using a high ISO value [focal length: 24mm, 1/25 sec. at f/4,and ISO 3200]
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scratching your camera, or vice versa. A beanbag made of cloth or leather also 
provides a soft, flexible support for your camera that allows for slight camera 
adjustments, and absorbs vibrations. If there is no horizontal surface at hand, 
you can even use the walls of a building to support your camera (and a fingertip 
to support the lens) while taking portrait format shots. 

A real old-school method of preventing camera shake involves tying a non-
elastic string between the camera body and one of your feet. Shorten the string 
to a length at which it is taut when you are holding your camera in its normal 
shooting position. This is a simple but effective way to reduce the camera shake 
caused by minimal hand tremble. 

If none of the above options apply to your situation, you will simply have to 
rely on the steadiness of your hand. Leaning against walls is a useful way to keep 
your body steady when you are shooting handheld. Breathe steadily and try to 
release the shutter between breaths. In critical situations, taking multiple shots 
of a subject increases your chances of producing at least one shake-free image.
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Comments by  
Marcus Bredt 

On architectural photography in general

At first glance, architecture appears to be an easy subject—buildings don’t 
move, don’t need to be given instructions, and are available at all hours of the 
day and night (fig. 268). The tricky part of the job is endowing an inanimate 
object with life. Architectural photography is not about simple documenta-
tion. It comprises much more than merely capturing buildings and structures 
photographically. Photographers have to get to know their subjects well 
enough to make familiar objects appear extraordinary. We walk past count-
less unobtrusive office buildings every day. We usually use railway stations for 
their intended purpose without giving them a second glance. We do not gen-
erally consider factories and warehouses to be works of art. Our job is to make 
normally ignored objects interesting. To succeed in this task, architectural 
photographers can accentuate geometric form to the point at which its intrin-
sic aesthetic grace suddenly becomes apparent or they can capture tiny de-
tails of a subject’s surroundings in a way that tells a story or portrays the 
charm of an otherwise plain-looking building (fig. 269). But remember, a great 
architectural photo has nothing to do with clever effects or disguising the 
subject’s true nature.

On taking your first steps as an architectural photographer

It is, of course, a lot of fun to try out new effects, especially when you are start-
ing out. Experimentation with technical tricks and clever techniques is the 
only way to find your own style. But the subject itself is always more impor-
tant, and a great building often guarantees a great photo. In this respect, our 
first assignments for Daniel Libeskind were a real blessing. His spectacular 
architecture cries out to be photographed under a multitude of lighting con-
ditions and from a variety of adventurous viewpoints. I still like the images 
that we produced back then, even if we have progressed a great deal since. It 
takes a long time to develop your own personal style, and while good tech-
nique helps, style still has a lot to do with gut feelings and intuition.
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Fig. 268: Oriental Sports Center, Shanghai; photo: Marcus Bredt

Fig. 269: Warehouse, Osnabrück; photo: Marcus Bredt
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On architectural photography as a profession

In earlier years, I would have said that the subject forms the image, but today I 
would say that I’m the one who forms the subject. In a sense, I create the build-
ing again from scratch through my photography methods so that I establish 
how the viewer perceives the subject. This ability to creatively explore a design 
is a favorite aspect of my work. The perspective, the lighting conditions (either 
coincidental or deliberate), the inclusion or exclusion of surrounding elements, 
the possibilities of post-processing—these are the variables under my control. 
My clients have the final say over which images to use, of course, but I have the 
creative flexibility to bring less conventional shots to the table (fig. 270).

Architectural photography is anything but simply taking snapshots of a 
building. Only once technical questions are no longer an issue can you start to 
perceive a building as a congruent whole. You need to have the chance to en-
ter into a dialog with the building, and once you do, the building will no longer 
be simply an object standing in front of you. My own depictions of architec-
tural structures emerge only when I start to work with my subject. This task 
involves including the weather, the surroundings, and the building’s intended 
function and life as a whole in my overall view. It is very important to me to 
show that we not only live within our environment, but also with it. Just the 
same way as we affect urban planning, natural processes, and the people we 
meet, these things affect us too in equal measures.

My photography has changed over the past several years, because I myself 
have changed. My earlier work still pleases me, but I would approach the same 
buildings differently now, and the same buildings would affect me in different 
ways. As I work, I constantly observe the perpetual communication between 
people and materials, technology and nature, stasis and flux, perception and 
experience, and I attempt to unite and capture these tensions with a click of a 
button (fig. 271). Living in that moment when I anchor both myself and every-
thing else in my shot is the real payoff for my work.

Travel

Travel is an integral part of my job and it continues to be particularly enjoyable 
whether I find myself in Europe, the United States, China, or South America. I’m 
always on the road and I inevitably carry with me many impressions about the 
various cultures and societies I have visted. The architects whom I work for are 
primarily from Germany, but they build structures around the world: Africa, 
Azerbaijan, Brazil, China, Poland, and Vietnam. The locations where I work are 
incredibly varied, as are the conditions under which I must work at each of 
these sites. The design may be drafted by a German hand, but the structures 
are erected on site in foreign locales, a fact that requires me to get to know my 
shooting location before starting my work in earnest.
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Fig. 270: Estádio Nacional de Brasília; photo: Marcus Bredt

Fig. 271: Maritim Museum, Lingang; photo: Marcus Bredt
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Every location has its own specific circumstances, which is why I don’t have 
a defined process that I always follow. There are, nonetheless, a few general 
rules I tend to follow. For example, I usually start by observing my subject from 
a distance and I try to take in as many different perspectives as possible 
(fig. 272). I try to get to know the surrounding area a bit, so I can develop a 
sense of my subject’s situation within a broader context. That may sound a bit 
pompous, but my goal is to have some spontaneous interaction with the area 
and I frequently end up discovering a unique setting for a shot (fig. 273). What’s 
most important is to have your camera on hand at all times, because a great 
photo opportunity rarely presents itself twice.

After these initial steps, my process depends on whether I’m working alone 
or with others, and whether I need to adhere to a specific schedule or I have 
the opportunity to return at different times of the day or to wait for weather 
and lighting conditions to change. Some countries present a fairly rigid frame-
work that I have to work within, while in others agreements can change from 
one minute to the next. Flexibility is therefore always a virtue, which suits my 
style perfectly. I’m not someone who depends on structure and am much hap-
pier to react to circumstance and the everyday surprises that life always has in 
store for us (fig. 274).

Fig. 272: The Denver Art Museum; photo: Marcus Bredt
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Fig. 273: Hanoi; photo: Marcus Bredt

Fig. 274: Hanoi; photo: Marcus Bredt

Travel
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From analog to digital

The art of photography fundamentally changed for me when digital equip-
ment overtook film. I tried to hold out for a while with my film camera, but 
eventually I came to the conclusion that my client’s needs, as well as my own 
priorities, had changed. My analog camera was significantly heavier, and crawl-
ing under the dark cloth was simply behind the times even if it was a quaint 
exercise. In the days of film, 20 exposures was a lot for one day, and those had 
to do the job. And the crazy thing was that they usually did do the job. There 
was hardly any opportunity to alter the images after they were exposed. To-
day, it’s unimaginable not to make use of the possibilities of digital post-pro-
cessing. I generally eschew producing images that are obviously altered, but a 
modest touch-up here or there is always welcome. 

The biggest change that accompanied the digital revolution was the time 
costs at the various steps of the process. The work required after the actual 
shooting is complete has dramatically increased. In the old days, you handed 
your film over to a developing lab, received the final images, and then were left 
to choose the standouts. Today, I inspect the results while I’m shooting, drive 
to my office, and then make the first pass of selections from at least 100 pic-
tures. And after I make the final selection of images, the actual post-processing 
begins. The whole process consumes an immense amount of time. Being con-
stantly confronted with the images is a dramatic change from being forced to 
spend some time apart from them. In fact, it’s often important to distance 
yourself from your work, or to solicit a second opinion from other photogra-
phers and completely independent parties, to win some perspective.

I usually know when a picture is a good one as soon as I make the exposure, 
but the upside of shooting digitally is that I can inspect the image on site to 
confirm whether my impression is accurate. With analog photography, excite-
ment built as I waited for my images to be developed and then reached a peak 
when I finally got to inspect the results. Nowadays, these treasured moments 
occur while I’m shooting. 

Stadium Photography

Stadiums are highly complex buildings. Any photograph of a stadium is not 
complete unless it captures the special social significance that the structure 
represents (fig. 275). When confronted with an exterior shot of a stadium, view-
ers must be able to connect the image with the events that transpire within 
the stadium’s walls, and similarly interior shots have to inspire thoughts about 
the goings-on beyond the walls. The challenges of photographing stadiums 
become even more clear when you consider that classic architectural photog-
raphy usually works best when people are completely or mostly absent from 
the scene. But stadiums are buildings for the masses, in which events of near-
religious significance take place. Pictures of empty stadiums therefore have a 
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Fig. 275: Estádio Nacional de Brasília; photo: Marcus Bredt

From analog to digital
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heroic effect on viewers, producing deference to the site of competition 
(fig. 276).

Photographing a stadium requires that I produce a single image that por-
trays the building’s physical structures and functions as well as its social impor-
tance. The task is both photographically and personally challenging. Standing 
on the pristine grass where the best athletes in the world will soon be battling 
for glory and looking up at the empty bleachers is an overwhelming opportu-
nity. The architecture of a stadium can really draw you in, so you have to be 
careful that your image captures not only your feeling of being overwhelmed, 
but the entire complexity of the scene before you..

It’s always interesting to see how stadiums interact with their surroundings 
(fig. 277). Or how they might change the face of a previously undeveloped 
area. Stadiums situated directly within a city are particularly impressive, be-
cause they are obviously integrated with the lives of the people who live near 
them (fig. 278). This scenario is becoming less common, because new stadiums 
tend to be built on the outskirts of town or in outlying areas for reasons related 
to functional infrastructure. The wide-open spaces surrounging these build-
ings are attractive and often allow for engaging photography.

Vita

Marcus Bredt was born in 1968 in Göttingen, Germany, and has lived and 
worked as a photographer in Berlin since 1992. After finishing his profession-
al training at Lette-Verein in Berlin, he co-founded the BitterBredt photo 
agency. Since 2001, he has worked on his own as Bredt-Fotografie shooting 
projects worldwide for renowned architects, businesses, and magazines.

Fig. 276: National Stadium Warsaw; photo: Marcus Bredt
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Abb. 277: Arena da Amazônia, Manaus; photo: Marcus Bredt

Fig. 278: Olympic Stadium Kiev; photo: Marcus Bredt

Vita



212 Comments by Marcus Bredt  



213

4 Image Processing

This chapter deals with the computer-based processing steps that you can ap-
ply to your images after shooting. Before you can begin processing digital im-
ages, you have to load them onto your computer using either the connection 
cable provided with your camera or a memory card reader attached directly 
to the computer. Digital images can be stored and processed in the form of pre-
processed JPEG or TIFF files or as RAW files, which are the digital equivalent to 
analog negatives, and which provide you with the maximum possible amount of 
usable image data. RAW files can also be processed a limitless number of times 
without actually altering or degrading the original image data. If you are shoot-
ing analog originals, these will first have to be digitized using a scanner before 
you can process them. High-end digitizers produce much better quality scans 
than hobby-grade flatbed or film scanners. Once you have scanned them, you 
can process, optimize, and present your analog images in just as many ways as 
you can your digital originals.
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4.1  Digital Image Formats

4.1.1  What Is RAW?

RAW image formats are proprietary not only to each camera manufacturer, 
but also to individual camera models. RAW image data is saved in its purest 
possible form with virtually no intervention from the camera’s firmware. A 
piece of software called a RAW converter is required to perform subsequent 
processing and conversion to universally readable formats. 

4.1.2  The Differences Between JPEG and RAW

In contrast to the popular JPEG format, RAW image data is saved to the cam-
era’s memory card losslessly and at full color depth. Image parameters such as 
white balance, color saturation, contrast, noise reduction, and sharpening are 
saved separately from the actual image data and can therefore be altered later 
without reducing the quality of the original image. The only parameters that 
are “set in stone” are the shutter speed, aperture, and ISO value used when the 
image was shot. 

When JPEG format is used, the data file is processed within the camera im-
mediately after the shot and before storage. While Bayer interpolation replac-
es missing color values with information from neighboring pixels (page 17), 
the subsequent in-camera workflow includes image optimization steps like 
adjustment of internal sharpness and contrast, color depth reduction, and 
data compression (figure 279). Changing these parameters later is possible 
with additional steps in an image-processing program, but keep in mind that 
since the data is no longer original, there will be some loss of quality.

4.1.3  The Advantages of Shooting in RAW Format

The advantages of shooting RAW images begin right away during shooting, 
as you have don’t have to pay detailed attention to as many shooting param-
eters as you do when shooting JPEGs. You don’t have to set white balance at 
all while shooting, and you can usually apply more accurate settings during 
RAW conversion anyway. The fewer parameters that require your attention, 
the better you can concentrate on composing and framing your shot. 

Perhaps the most important of all the benefits of shooting RAW is non-
destructive processing. All processing steps that you perform using a RAW 
converter are saved separately in an additional file and can be undone or 
adjusted at any time, while the original image data remains intact and unaf-
fected during the entire workflow. Should you want to, you can apply identi-
cal processing steps years later to the same digital original with no loss of 
image quality. 



215

Shooting RAW ensures maximum image quality and the greatest possible 
processing flexibility. Today’s computers and RAW converters are much more 
powerful than the firmware built into most cameras and are thus capable of 
more accurate and complex interpolation of color values. Image data con-
version performed on a computer always produces higher quality results 
than in-camera processes (fig. 280).

RAW files contain much more raw image data than JPEG files and give you 
the greatest possible potential for subsequent correction of shooting errors. 
JPEG images have a color depth of just 8 bits per channel (bpc) and are ca-
pable of reproducing just 256 different tonal values. RAW formats offer 12 or 
14 bpc data, which translates to 4,096 or 16,384 reproducible tonal values. 
Their reduced bit depth means that heavily processed JPEG images often 
contain obvious color shifts and anomalies in large areas of uniform or grad-
ed color. The much finer gradation and the presence of all of the original 
tonal values in a RAW image allow you more headroom for making subse-
quent adjustments to exposure. It’s much easier to retrieve “lost” detail in 
under- or overexposed parts of a RAW image than it is for a JPEG. 

RAW conversion process

JPEG conversion process
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Fig. 279: The processes involved in producing JPEG and RAW digital image files
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Bildqualität RAW und JPG-Format:

RAW

JPG

Fig. 280: A comparison of RAW and JPEG image quality 
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Additionally, RAW images allow complete correction of lens errors such as 
distortion, vignetting, or chromatic aberration, and many RAW converters 
have built-in tools that produce much better results than conventional JPEG 
or TIFF correction processes. 

White balance settings adjust the colors recorded by the camera to match 
the color temperature of the ambient light. It can be tricky to adjust white 
balance accurately during a shoot without the use of a gray card, and most 
camera monitors don’t reproduce colors reliably enough to judge color tem-
perature accurately on-camera. The ability to adjust white balance using 
sliders or an eye-dropper tool in a RAW converter is an enormous help. As 
always, this type of adjustment is lossless and can be undone at any time.

Many cameras perform automatic noise reduction, especially if you are 
shooting at high ISO speeds. In almost all cases, this process causes a loss of 
fine image detail and often makes JPEG images look artificially smooth. Im-
age noise is initially more obvious in uncorrected RAW images, but can be 
more effectively reduced using a RAW converter or third-party tools, as these 
are more closely matched to specific types of noise.

Shooting in RAW also obviates the need to specify the final image format 
or color space prior to shooting. These parameters, too, can be specified later 
during the RAW conversion process. 

4.1.4   Disadvantages of Shooting in RAW Format

In addition to its many advantages, RAW also has its downside. RAW image 
files are much larger than JPEG files shot at the same resolution, so writing 
data to the memory card takes longer and you need more disk space to store 
your images. Processing RAW images requires a lot more computer power to 
produce real time image previews and fast conversions, often causing a re-
duction in the overall speed of your workflow. Unprocessed and unconvert-
ed RAW images are not suitable for Web publishing or other forms of distri-
bution, and every new camera has its own individual RAW format, requiring 
the manufacturers of RAW processing software to update their products ev-
ery time a new camera model hits the market. 

4.1.5   Conclusions

If you weigh the advantages and disadvantages of RAW, you will quickly 
come to the conclusion that shooting in RAW is a boon to architectural pho-
tography. I recommend that you use the increased image quality and pro-
cessing flexibility of RAW whenever possible. 

Digital Image Formats



218 Image Processing

Choosing the Best Hardware for the Job

The processor (CPU), the amount of memory (RAM), and, to a degree, the type of graphics 
card (GPU) you use are the three factors that most influence image processing speed. The 
specifications of all the other components in your computer are much less important. 

A fast processor with four or more cores is ideal for ensuring that things go smoothly 
when you are applying complex filters or other adjustments to your images. The larger 
your image files are, the more RAM you will require to work at speed. If your RAM is 
maxed out, programs like Photoshop use sections of the relatively slow hard disk to tem-
porarily store data, which significantly slows down all image processing tasks. Twelve or 
sixteen gigabytes of RAM are a sound investment for every serious digital photographer, 
but only if you are running a 64-bit operating system—32-bit systems can usually only 
handle a maximum of 4 GB. Use a fast hard disk or solid state drive (SSD) as your system 
disk. SSDs contain no moving parts and are much faster than conventional hard disks.  
I recommend that you use two large hard disks in a RAID 1 configuration for image data 
storage. This ensures secure storage by saving duplicate “mirror” images of all your files 
and allows you to continue working, even if one disk should fail. 

Make sure that your computer’s fans are quiet—there is nothing more annoying than 
constant background whir while you are working. 

A high-quality monitor is essential when you are processing digital images. Flat-panel 
LCD models are today’s norm, and have almost completely squeezed conventional CRT 
models out of the market. The quality of the panel built into a monitor determines its 
angle of view, contrast, and color reproduction characteristics. High-quality monitors 
are generally more expensive than mid-market models, but are definitely worth the 
extra cost. Wide-gamut models that are capable of displaying an extended range of 
colors are even more expensive and are useful if you want to process your images using 
not only the conventional sRGB color space but also others with broader color ranges, 
such as Adobe RGB. 

If your image-processing program has built-in color management functionality,  
I strongly recommend that you calibrate your monitor using dedicated software and a 
device called a colorimeter. This device measures the colors produced by your monitor 
and uses the resulting values to create a color profile that you can then use to control 
the way your graphics card reproduces color tones. There are also monitors available 
that can be directly calibrated, but these tend to be very expensive. 
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4.2   RAW Conversion

The following sections illustrate the steps involved in a typical RAW conversion 
workfl ow for an architectural photo. The aim of the initial steps is to produce 
an image that serves as a basis for a range of subsequent adjustments. I use 
 Adobe Camera Raw (ACR), which is an integral part of both Photoshop and 
Photoshop Elements and shares many similarities with Adobe’s Photoshop 
Lightroom all-in-one workfl ow package. 

4.2.1  A Typical RAW Processing Workfl ow

1. Image analysis: This sample image shows the façades of a row of 
modern town houses with varying colors, textures, and material 
characteristics. The original photo was taken in direct sunlight on 
a June morning at a distance of 35 meters. I used a wide-angle tilt/
shift lens to correct converging verticals during the shoot. The ex-
posure displays no serious under- or overexposure. The RAW con-
verter’s sliders are all in their default positions and only the white 
balance setting saved with the image was automatically detected 
and loaded by the software (fi g. 281).

Fig. 281

RAW Conversion
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2. The fi rst step is to adjust white balance. You can select from a range 
of presets that include Daylight, Cloudy, Shade, and Auto, although 
these rarely provide exactly the result you need. White balance 
can be adjusted manually using the Temperature and Tint sliders 
in ACR’s  Basic tab (fi g. 282). To do this, fi rst adjust the Temperature 
slider until you get the basic eff ect you are looking for and then 
fi ne-tune the results using the Tint slider  1 . The semi-automatic 
White Balance tool, which can be found in the upper tool bar  2 , 
is, theoretically, most accurate, but it isn’t ideal for every subject. 
Using the White Balance tool is simple, just click on your image in 
a place that represents neutral gray  3 , or make a selection from 
a separate photo of a gray card. The software then calculates an 
appropriate white balance setting based on the selected color. 
The marked position on the tallest building in my sample image 
worked very well, but not every image contains such an appropri-
ate color. If this is the case, you will simply have fi nd the correct set-
ting using the sliders along with some trial and error. One hundred 
percent perfect white balance is not as important in  architectural 

Fig. 282 
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situations as it is in fashion or advertising photography, and it is 
often better to use a white balance setting that suits the overall 
mood of an image.

3. The next step is to take a look at the   Histogram located above the 
tool panel. This displays the distribution of tonal values within the 
image in graphical form and is a great aid to checking exposure 
(page 157). Because all monitors display colors, highlights, and 
shadows diff erently, a histogram is the only truly reliable way to 
check your exposure. My sample image has a wide range of tonal 
values. The triangular icons in the histogram display are Shadow 
clipping warning and Highlight clipping warning tools  4 . When ac-
tivated, these indicate the places where the image is irretrievably 
under- or overexposed in the preview window. Red-colored warn-
ings indicate  overexposure and blue indicates clipped shadows. 
The clipped areas are relatively minor in my sample image, so it 
should be possible to recover the details in those areas in the next 
step.

4. The next step is to make further adjustments in the Basic panel. 
The Exposure slider eff ectively adjusts the image’s overall bright-
ness and the scale shown corresponds to exposure values of a 
camera. I left this setting unchanged in my example. I then used 
the Shadows and Blacks sliders to adjust the slightly clipped shad-
ows. While Blacks allows you to precisely determine which tonal 
values in the converted image appear completely black, Shadows 
can be used to brighten dark areas without altering the tone of 
deep blacks (fi g. 283). The Highlights slider is designed for retriev-
ing details that appear to be missing in brighter image areas. But 
be warned: using this slider too much produces unrealistic-looking 
results. The Whites slider is the counterpart to the Blacks slider, and 
it adjusts highlight clipping. If the ambient light has produced too 
much contrast in your midtones, move the Contrast slider slightly 
to the left. This compresses the histogram curve and reduces con-
trast for the aff ected areas. If necessary, contrast can be selectively 
increased later on. This adjustment can also be used to increase 
contrast, but remember that it only aff ects midtones. The Clarity 
slider can be used to increase local contrast but quickly produces 
unwanted halos and a slightly “dirty” overall look in an image, so 
take care when adjusting it. Again, I left this particular setting un-
changed for my sample image. The Vibrance and Saturation set-
tings can be left alone at this stage too, and can be selectively ad-
justed later (Vibrance controls the lower-saturated colors without 
aff ecting the rest, while Saturation changes aff ect all image colors 
equally). 

RAW Conversion

Fig. 283 
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5. The  Tone Curve can be used to perform various fi ne-tuning steps 
and is a tried and true way to make targeted tonal adjustments in 
selected image areas. The ACR version of the tool allows you to 
adjust the curve either directly by manipulating control points on 
the curve or indirectly by adjusting the Highlights, Lights, Darks, 
and Shadows sliders located beneath the curve graph. These en-
able you to selectively brighten or darken specifi c tonal values. 
Both methods can be used to achieve the same eff ects and which 
you use is a matter of taste. My sample image required only slight 
brightening in the midtones (fi g. 284). In others cases, it’s often 
a good idea to increase overall contrast or brighten darker tones 
using an S-shaped curve. You can also use the Targeted Adjustment 
tool located in the toolbar and the Parametric curve to directly 
brighten or darken selected image areas by dragging the cursor 
in the preview window. The tool’s handling is simple and intuitive.

6. Image sharpening is generally the fi nal step in a digital image 
processing workfl ow, so I recommend that, at this point, you ap-
ply only slight sharpening in the  Detail tab. If you apply excessive 

Fig. 284 

Fig. 285 
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Fig. 286 

Fig. 287 

sharpening too soon, you will have to deal with unwanted sharp-
ening artifacts later. Use an Amount setting between 10 and 20, a 
Radius value of 1 or less, and a Detail setting between 5 and 15. 
The Masking slider can be left at its low default setting. To check 
image sharpness, select an image area with plenty of detail and 
switch to the 100% or 200% view in the preview window (fi g. 285). 
ACR’s Noise Reduction tool is fairly basic, and there are a number of 
Photoshop plug-ins available that address various specifi c types of 
noise and produce better results. In my example, I deactivated the 
reduction of the slight analog-style  luminance noise by selecting 
a Luminance Contrast value of 0. I only slightly reduced the blotchy 
color noise using the Color, Color Details, and Color Smoothness 
sliders.

7. The  HSL/Grayscale tab off ers a wide range of color adjustment 
tools. HSL stands for Hue/Saturation/Luminance, and the Hue tab is 
great for making fi ne color corrections. I used it to correct the typi-
cal (digital) red cast in the sky (fi g. 286). The Saturation tab is used 
to make adjustments to color intensity, and I used it to strengthen 
the color of the sky (fi g. 287). Theoretically, you can use the tool 
to desaturate complete image areas and increase saturation in 
others—eff ects that can produce quite surreal-looking images. 
However, I only usually use it to make corrections that arise from 
other correction processes: While manually brightened shadows 
or darkened highlights automatically appear well saturated, shad-
ow areas that have been further darkened or highlights that have 
been brightened tend to look somewhat desaturated. The Lumi-
nance tab is used to regulate the brightness of individual colors, 
and I used it to darken the blues (to further intensify the color of 
the sky) and to slightly brighten the red and yellow tones (fi g. 288). 
If you want to convert an image to black-and-white, check the Con-
vert to Grayscale box. The three HSL tabs will then be displayed in 
a single tab called Grayscale Mix in which you can adjust the in-
tensity of the various grayscale tones. These allow you to produce 
monochrome images with widely diff ering looks. Here too, the 
same adjustments can be made using the Targeted Adjustment tool.

8. The  Split Toning tab enables you to make separate adjustments to 
highlight and shadow areas. This can be useful, for example, if the 
shadow areas in an image contain color casts but the rest of the 
images requires no correction. This tool can also be used to give 
an image a warmer or cooler overall look, as I did with my sample 
image (fi g. 289), or used for tinting images that you have already 
converted to grayscale. 

Fig. 288 
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Fig. 289 

Fig. 290

9. The  Lens Corrections tab contains tools that are very important 
for architectural photographers. The tool’s Profi le tab contains slid-
ers for correcting distortion and vignetting, as well as the selec-
tion parameters for a wide range of lenses for which specifi c errors 
can be corrected automatically (fi g. 290). The Correction Amount 
control section allows you to reduce or increase the strength of 
each individual adjustment. If your particular lens hasn’t yet been 
profi led by Adobe, or if you’re using an adapted lens whose set-
tings won’t transfer to the Exif metadata and thus can’t be read by 
ACR, you can use the free Adobe Lens Profi le Creator software to 
create your own profi le. Tilt/shift lenses cannot be easily profi led 
because the nature of the errors they produce changes according 
to the shift-settings you have selected. The shift lens used in the 
example produced only subtle vignetting thanks to the optic’s 
large image circle. Also, the lens was only slightly shifted, and the 
exposure was not shot at the maximum aperture. The distortion 
is also insignifi cant, which makes adjusting both of these param-
eters unnecessary. The Lens Correction panel’s second tab, Color, 
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allows you to adjust chromatic aberrations (fringing) automati-
cally (fi g. 291), and you further have the option in the Defringe cor-
rection area to manually remove stubborn purple or green color 
fringes. The Manual tab, which is the third tab in this panel, off ers 
the ability to apply automatic perspective corrections under the 
Upright control section. The eff ectiveness of these adjustments 
highly depend on the subject (fi g. 292). The Auto button applies 
a set of perspective adjustments. Pressing the Level button causes 
ACR to try to ensure that all horizontal details appear perfectly lev-
el. Aside from the Auto button, the Vertical button, which attempts 
to recognize and correct converging vertical lines, is the most 
applicable to architectural photography. The Full button off ers a 
more comprehensive solution comprising horizontal, vertical, and 
automatic perspective adjustments. The Transform control section 
gives you the ability to manually modulate individual parameters 
such as Distortion, Vertical, Horizontal, Rotate, Scale, and Aspect. It’s 
often easier to fi ne-tune these settings precisely using Photoshop 
later on in the workfl ow. 

RAW Conversion

Fig. 291

Fig. 292
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10. The  Eff ects tab includes options for adding analog-style Grain or vi-
gnette eff ects to images that have already been cropped (Post Crop 
Vignetting). I used neither of these eff ects in my example. 

11. The  Camera Calibration tab allows you to select and adjust custom 
camera profi les; for example, to permanently counteract a known 
color cast produced by a particular camera. ACR makes it possible 
to save  Presets with individual settings that can in turn be easily 
applied to other pictures later on. The  Snapshots tab enables you 
to take “snapshots” of various versions of your image for recall and 
comparison during current or future processing sessions (fi g. 293). 

12. Other ACR tools (fi g. 294) include the  Crop tool  1  and the extreme-
ly useful  Straighten tool  2 , which perfectly aligns your image to a 
horizontal or vertical line that you drag across the preview image. 
If you want to correct distortion later in your workfl ow, don’t use 
either of these tools at this stage, as they can only be applied to 
the entire image. The  Spot Removal tool  3  is intuitive to use and is 

Fig. 293

Fig. 294
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Fig. 296

great for removing fl aws caused by  dust spots on the image sen-
sor. The Adjustment Brush tool  4  is used for making selective tonal 
value corrections (fi g. 295), and the Graduated Filter  5  as well as the 
Radial Filter tool  6  apply highly variable gradients to digital images. 

13. Before clicking the Open Image button to start the conversion, click 
on the blue underlined image data at the bottom edge of the ACR 
preview window to perform a fi nal check of your  Workfl ow Options 
(fi g. 296). Here, you can select a color space—sRGB IEC61966-2.1 is 
usually the best choice for images you want to display on the Web or 
have printed by a lab, while the larger Adobe RGB (1998) color space 
is better for pre-press work or if you are using an output device such 
as an wide-gamut monitor or a high-end inkjet printer that sup-
ports Adobe RGB. Select the 16 Bits/Channel Depth setting to ensure 
that your image retains the maximum possible range of color data. 
This does, however, require additional computing power, so select 
the 8 Bits/Channel option if you are using an older computer. Leave 
the Size setting at its default value unless you are using a large-for-
mat printer or some other special application. In this case, you will 
achieve better results if you reinterpolate the image now, as long as 
the program still has access to the raw image data. You can select 
any Resolution setting, as this doesn’t aff ect absolute resolution and 
only determines the size at which the image can be reproduced us-
ing a specifi c pixel density. If you want to perform pre-output sharp-
ening, the Sharpen For setting includes options for Screen, Glossy 
Paper, or Matte Paper in Low, Standard, and High amounts.
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Adobe Camera Raw Conversion Workflow Overview

 ` Set white balance (individually according to the image being processed)
 ` General image optimization (overall exposure, contrast, highlights and shadows) using the histogram 
 ` Fine-tuning using the Curves tool
 ` Perform moderate basic sharpening
 ` Optional: Select HSL/Grayscale settings
 ` Remove/add color casts as desired using Split Toning
 ` Perform lens corrections and perspective correction as necessary
 ` Add Grain/Post Crop Vignetting effects as desired
 ` Perform final touches: Remove dust spots, crop/straighten, perform selective corrections as desired
 ` Check Workflow Options
 ` Convert image

Fig. 297: Final edited image
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 Exif Data

The Exif (Exchangeable Image File) data format was 
formulated in 1998 and is used by virtually all digital camera 
manufacturers to record ancillary image data tags. These 
tags are written to an image fi le’s so-called “header,” and 
are directly embedded in JPEG and TIFF image data. Exif 
data fi elds include shutter speed, aperture, date, time, focal 
length, ISO value, fl ash settings, white balance, and many 
others. This information can help you to discern why an 
image is particularly eff ective or why it didn’t turn out as 
you expected. 

Many image processing programs can access Exif data 
directly and can use it to sort and analyze individual or 
multiple images. 

Detail of the Exif data associated with a RAW image fi le
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4.3    Post-processing

4.3.1  Image Adjustments

Once you have converted a RAW image, your image data is in the best possible 
state for making individual corrections and adjustments. The following sec-
tions describe a typical image correction workfl ow. The steps I describe and 
the order I perform them in are by no means mandatory, and everyone, sooner 
or later, develops their own personal working style. However, some steps are 
better performed before others if you want to produce consistently good re-
sults. If you are just starting out, the following workfl ow provides a great set of 
basic guidelines.

Workfl ow:  Image Adjustments

1. We have now converted our sample image to 16 bpc (bits per color 
channel) color depth, adjusted its white balance, performed a cou-
ple of minor corrections to tonal values, and reduced the amount of 
visible chromatic aberrations and vignetting (fi g. 298).

Fig. 298

Post-processing
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2. Changes to framing or a correction of converging verticals should 
be done at the same time as, or after, the correction of lens-in-
duced distortions, never before. Distortion correction is only pre-
cise if the entire image is processed. 

Correcting perspective and distortion in Photoshop: If you 
haven’t already corrected distortion using ACR, the Photoshop 
Filter > Lens Correction tool is perfect for making automatic and 
manual corrections to perspective and lens errors. In order to per-
form automatic corrections, the Auto Correction tool requires Exif 
metadata with information about the camera, lens, focal length, 
and f-stop setting, as well as an appropriate lens profile. All you 
then have to do is check the Geometric Distortion option and 
Photoshop will calculate the appropriate correction values and 
apply them to your image (fig. 299). You can also select the Auto 
Scale Image option if desired. Manual distortion correction can be 
performed using the Remove Distortion slider in the Custom tab 
(fig. 300). For my sample image, I moved the slider slightly to the 
right to correct the barrel distortion that is typical in images shot 
using wide-angle lenses  1 . The ideal correction values depend on 
the lens you are using and its focal length. Perspective correction 
and distortion correction influence each other reciprocally, so it is 
easier to find the best settings if you perform perspective correc-
tion at this stage, too. On the one hand, distorted lines are more 
obvious if perspective has already been corrected, while on the 
other hand, it is easier to align straight lines to a perspective grid if 
they have already been straightened. I used the Vertical Perspective 
slider in the Transform panel  2  to correct the converging lines on 
my sample image. The Horizontal Perspective slider is great for cor-
recting errors that occur if the film/sensor plane wasn’t parallel to 
the building’s façade during shooting. The Straighten tool  3  func-
tions in exactly the same way as the ACR version described in the 
previous section, and I used it to correct the very slight rotation in 
my sample image. All perspective and distortion errors have now 
been corrected. Click OK to confirm them and return to the main 
program window.

Using plug-ins to correct distortion and perspective er-
rors: There are also various third-party tools available for correct-
ing distortion and perspective errors, such as PTLens (for PCs and 
Mac) and LensFix (for Mac only). These tools correct errors based 
on a comprehensive database of the anomalies produced by a 
wide range of camera/lens combinations, and are even capable 
of automatically correcting wave distortion and distortions result-
ing from shift lenses (with manual intermediate steps). Here too, 
the software uses Exif data to determine the appropriate correc-
tion parameters. I used the plug-in version of PTLens to correct 
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Fig. 299
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Fig. 300
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Fig. 301

Fig. 302

Fig. 303

my sample image. Once installed, the plug-in can be found under 
Filter > ePaperPress > PTLens. Now go to the Barrel-Pincushion panel 
in the plug-in window (fi g. 301). The software usually detects the 
correct camera and lens models immediately, but some combina-
tions require manual input. If the Preview box is checked and the 
Barrel-Pincushion option is selected in the Correct panel, the cor-
rection values stored in the database will be applied to the image 
in the preview window in real time. The Perspective tab includes 
intuitive tools for correcting converging lines, and activating the 
built-in grid makes aligning your image much easier. You can also 
shift the entire image up, down, or to the side using the four-way 
button in the same tab. It is preferable to correct vignetting and 
chromatic aberrations during RAW conversion, but if you haven’t 
already done so, PTLens includes appropriate tools. Click OK to 
apply your selected settings and return to the main Photoshop 
window. 
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Correcting perspective using the  Transform command: You 
can also correct perspective in images that require no further dis-
tortion correction using the Photoshop Edit > Transform command. 
Either drag Guides across your image or show the grid using the 
commands in the View > Show menu. Convert the background 
layer into a transformable layer by double clicking its thumbnail 
in the Layers menu (fi g. 302) and then clicking OK in the following 
dialog (fi g. 303). The background layer will now be called Layer 0. 
Now use the Edit > Transform > Perspective or Distort commands 
to distort your image to suit your purposes (fi g. 304). If you move 
the upper corners apart during the transformation, it is important 
to move the lower corners closer together in order to prevent the 
fi nished image from appearing vertically compressed. 

Fig. 304
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Fig. 305

Cropping your image: The next logical step is to crop your adjust-
ed image. Drag a marquee around the appropriate area using the 
 Crop tool and confi rm your selection with a double click (fi g. 305). 
In my example, I preserved the greatest possible image area, which 
actually altered the aspect ratio. If you want to use a specifi c aspect 
ratio, use the Rectangular Marquee tool to make your selection, se-
lect the Style > Fixed Ratio option in the toolbar and enter your de-
sired values in the boxes. You can then drag a marquee and make 
your selection using the Image > Crop command. If your selection 
extends beyond the edge of the image in places where image de-
tail is uniform, you can use the Polygon Lasso tool to select the ex-
cess image space and use the Edit > Fill command with the Use > 
Content-Aware option activated to fi ll the blank space. The quality 
of the results will depend on the type of detail you are attempting 
to duplicate. Alternative ways to round out an image are to use the 
Clone Stamp tool or by simply making a tighter crop. 

3. The following section describes various ways of making corrections 
to image brightness.  Selective darkening: I decided to fi rst darken 
the sky in my sample image. If the division between the building 
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Fig. 306

Fig. 307
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and the sky is clearly defi ned, you can use the  Magic Wand tool 
with the Shift key pressed to make multiple selections. If the area 
you wish to select contains complex shapes, such as a tree, it is 
probably better to use a diff erent method. Selecting the Select > 
Color Range command opens a dialog in which you can precisely 
determine which colors to select. Choose the Select > Sampled Col-
ors option, activate the Localized Color Clusters option, and click 
on the sky in the preview window. The selected areas are then 
marked in white and non-selected areas in black (fi g. 306). The Add 
to Sample eyedropper can then be used to add all other tones in 
the sky to your sample. Leave the Fuzziness slider near the left-
hand end of the scale, but check to see if slight movements up or 
down produce better results for your particular image. The same 
is true for the Range slider, although you will probably need to use 
higher base values than for Fuzziness (fi g. 307). The aim of the ex-
ercise is to create a clear transition between the sky and the other 
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elements in the picture. Click OK to view your selection in the main 
preview window. You will notice this technique also selects other 
areas with tones similar to those in the sky. To remove these from 
your selection use the Polygon Lasso tool in Subtract From Selec-
tion mode (fi g. 308) to select all areas that aren’t part of the sky. 
Any minor inconsistencies can be corrected later using the layer 
mask that this step creates. You can now optimize your selection 
using the Refi ne Edge dialog, which you can open either by clicking 
the button in the toolbar or via the Select > Refi ne Edge command 
(fi g. 309). Activate the Smart Radius option in the Edge Detection 
section and set the other options according to the nature of your 
image. Trial and error or using previously successful values are the 
best ways to fi nd the ideal Radius setting. I fi nd that values be-
tween 0 and 5 are generally the most eff ective, and that using the 
Zoom tool helps us to accurately judge the results. Using Radius 
values that are too high for fi nely textured or partially translucent 
objects such as trees produces inaccurate selections. Leave the 
Smooth and Contrast sliders either at the left of the scale or set to 0 
and select a Feather value below 1. Use a Shift Edge value between 

Fig. 309

Fig. 308
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Fig. 311

Fig. 312
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+5% and +10% to prevent fringing at the edges of your selection. 
This enlarges your selection to a minimal degree (fi g. 310). Click OK 
to return to the main program window. Leave your selection active 
and select the  Curves menu either directly from the Adjustments 
panel (fi g. 311) or by using the Layer > New Adjustment Layer > 
Curves command. Regardless of the method, your selection will no 
longer be active, and the program creates a new adjustment layer 
and layer mask called Curves 1 (fi g. 312). A  layer mask is a grayscale 
image used to determine the opacity of the layer it is associated 
with. Black areas are reproduced fully transparent and white areas 
are completely opaque. Layer masks can thus be used to show or 
hide specifi c areas within an image without actually deleting any 
pixels. When you are fi ne-tuning an image, hidden image areas 
can be easily shown by painting in the layer mask using a white 
brush. To do this, simply click on the layer mask with the Alt key 
pressed  1  and paint into the resulting black-and-white image. Be-
fore I adjusted the layer mask, I darkened the sky in my sample im-
age by dragging the curve downward  2 . Thanks to the layer mask, 
all adjustments are only applied to the currently active selection. 

Fig. 310
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 Selective brightening: The next step involves adding another 
adjustment layer. Once again, select the Curves dialog in the Ad-
justments panel, this time with no active selection. To keep track 
of your work, I recommend that you name each layer individu-
ally when you are working with multiple layers. I will now use my 
newly named Lighten layer to selectively brighten parts of my 
sample image (fi g. 313). Theoretically, I could once again select 
the Color Range command, select the Shadows instead of the sky 
and simply blur the layer mask. However, I would like to demon-
strate an alternative method: Activate the Lighten layer by click-
ing on its thumbnail and slightly brighten the entire image using 
the Curves or Levels dialog. Now activate the layer mask and fi ll it 
with black (fi g. 314) using either the Edit > Fill or the Image > Adjust-
ments > Invert (Ctrl-I/Cmd-I) command. The adjustments just made 
will disappear. Now select a large, soft brush using the Brush tool 
(fi g. 315)  1 , set the foreground color to White, and reduce opac-
ity to a low value (30% in my example)  2 . Use the brush to paint 
areas that are too dark in the active black layer mask  3 . This once 
again makes the areas I previously brightened visible. Alternative 
methods for brightening and darkening specifi c image areas are 
described in section 4.3.2. 

4. Now that I have completed my major adjustments to brightness, 
the next step is to reduce  noise for images that have been strong-
ly brightened or that were shot using high ISO values. Photoshop 
includes the Filter > Noise > Reduce Noise command for doing just 
that (fi g. 316). My sample image doesn’t require any noise reduc-
tion, but if you do decide to reduce noise, take care to apply the 
fi lter you use in moderation, as noise reduction always reduces the 
quality of fi ne details. Generally, a slightly noisy image looks bet-
ter than one in which detail has been softened too much. In addi-
tion to the standard Photoshop tool, there are a number of eff ec-
tive noise reduction plug-ins available, including Noiseware, Neat 
Image, Topaz DeNoise, or Noise Ninja, all of which can be worth 
spending a little extra money. 

5. I can now perform any additional  color corrections that I didn’t 
make at the RAW conversion stage. The Selective Color dialog in the 
Adjustments panel (also reachable via Layer > New Adjustment Lay-
er > Selective Color) is great for performing targeted adjustments 
(fi g. 317). The adjustments you can make vary enormously and de-
pend entirely on the subject and the type of image you want to 
produce, so experience and experimentation are once again the 
best yardsticks for fi nding the right settings. I decided to give my 

Fig. 313

Fig. 314
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sample image a slightly cooler look using a new layer (Layer > New 
> Layer) in Hue mode (fi g. 318). I then used a blue tone to fi ll the 
layer and reduced opacity to 8%. The result is an overall slight blue 
tone that can be selectively applied or reduced using a layer mask 
(fi g. 319). An alternative way to produce the same eff ect is using 
the Photo Filter dialog in the Adjustments panel (also reachable via 
Layer > New Adjustment Layer > Photo Filter), which can also be se-
lectively applied or undone at any stage (fi g. 320).

6.  Saturation can be increased or reduced in a similar way using 
the  Vibrance dialog (also found in the Adjustments panel, fi g. 321). 
The Vibrance slider adjusts saturation for less saturated colors to a 
greater degree than for colors that are already well saturated. The 
Saturation slider adjusts saturation irrespective of a color’s current 
level of saturation. 

7. I recommend that you use a slight S-curve created using the 
Curves dialog or the Image > Auto Contrast command to “stretch” 
the histogram for low-contrast images. This makes the darkest ar-
eas black and the brightest areas white. My sample image already 
covers a very broad tonal range, so I only had to slightly increase 
 local contrast in order to improve the detail of the main façades 
in the shadows. To do this, duplicate the background layer (Layer > 
Duplicate Layer) and use the Filter > Sharpen > Unsharp Mask com-
mand with a high Radius value to increase edge and overall con-
trast. Set the Amount value to suit the image you are working on 
(fi g. 322). The disadvantage of this technique is that it can produce 
unwanted “halo” eff ects at high-contrast edges (fi g. 323), although 
these, too, can be removed using a layer mask and a black brush 
(fi g. 324). Alternatively, you can load the selection already created 
for the Darken layer by holding down the Ctrl/Cmd key and click-
ing on the layer mask thumbnail (fi g. 325). You can then apply it to 
the active layer mask on the Local Contrast layer (Edit > Fill > Black). 
After application, reduce the layer’s opacity to keep the eff ect sub-
tle (fi g. 326), as over-the-top eff ects quickly spoil the overall look of 
an image. Once you are done with these steps you can fl atten your 
image to a single layer (Layer > Flatten Image).

8.   Sharpening should always be the last step in the workfl ow. The 
Filter > Smart Sharpen command produces great results if you use 
a medium Amount, set Radius to between 0.3 and 1.0, choose a 
low value for Reduce Noise, and select the Remove: Lens Blur set-
ting (fi g.  327). If you use Amount and Radius values that are too 
high, ugly sharpening artifacts will pop up (fi g. 328). The Advanced 

Fig. 319
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Fig. 326

Fig. 322
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Fig. 327 Fig. 328

Fig. 329
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Fig. 330
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Photoshop Image Adjustment Overview

 ` Distortion correction
 ` Perspective correction
 ` Brightness and contrast adjustments
 ` Noise reduction
 ` Color corrections
 ` Contrast fi ne-tuning
 ` Sharpening
 ` Data storage

 options can be used to apply the eff ect selectively to shadows 
and highlight areas as necessary. Alternative sharpening tools that 
produce very good results include Photoshop’s own Unsharp Mask 
command and a range of high-quality third-party tools that in-
clude Nik Sharpener Pro, Topaz InFocus, or  Focus Magic (fi g. 329).

9. Be sure to save your image before exiting Photoshop. The univer-
sal TIFF format or Photoshop’s proprietary PSD format are best for 
 saving your image losslessly and at high color depth, although 
both produce relatively large image fi les.  TIFF images that contain 
large areas of uniform color can be eff ectively compressed using 
the (lossless) LZW or ZIP compression algorithms. If you are sure 
that you won’t need to process your image any further, you can 
save disk space by converting it to 8 bpc before saving (Image > 
Mode > 8 Bits/Channel, fi g. 330). The 8-bit JPEG format saves even 
more disk space. If you do decide to use  JPEG, select the lowest 
possible compression level, as additional compression apprecia-
bly reduces image quality. And remember, a JPEG image is subject 
to further quality loss every time you open and re-save it. Use a 
Quality setting of 10 or 11 when exporting JPEGs. If you are saving 
images for presentation on the Internet or a mobile device, use 
the Bicubic Sharper interpolation method and a Web-compatible 
image size (Image > Image Size) such as 800 x 600 pixels (or double 
the size for retina displays). Then use the Save for Web & Devices 
command in the File menu, making sure that you select JPEG as 
you export format and High or Very High compression quality. This 
command automatically converts 16-bit images to 8-bit and en-
ables you to optionally remove any remaining Exif data (page 229). 
If you deactivate the Embed Color Profi le option, which I would not 
recommend doing, the color profi le will be deleted.
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Fig.331: The adjustments we performed using Photoshop have greatly improved the overall look 

and feel of our original JPEG image
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4.3.2  In-depth Processing: 
Selective Adjustments to  Contrast and  Brightness

Architectural photos often require selective brightening or darkening in spe-
cifi c image areas to counteract the eff ects of exposure errors or extreme sub-
ject contrast. The previous section (4.3.1) details color range and layer mask 
techniques for performing selective corrections. This section describes some 
alternative methods of achieving similar eff ects, including using the Photo-
shop Shadows/Highlights command, the use of so-called “contrast masks,” and 
the use of specialized plug-ins, such as LightMachine.

Workfl ow: Selective Contrast and Brightness Correction

1. Large portions of the façades in my sample image are too dark 
(fi g. 332). The fi rst option for correcting these is to use the Photoshop 
Image > Adjustments >  Shadows/Highlights command. The default 
dialog shows just two sliders that allow you to adjust the Amount 
for Shadows or Highlights, while checking the Show More Options box 
gives you a much broader choice of options (fi g. 333). To brighten 
dark image areas, use the Amount, Tone, and Radius settings in the 
Shadows section of the dialog window. The Amount setting regu-
lates the strength of the eff ect, but take care not to set it too high or 

Fig. 332

Fig. 333



248 Image Processing

your image will take on an unnatural look. Low Tone settings cause 
the eff ect to be applied only to dark areas, while higher values af-
fect lighter ones. Mid-range values usually produce good results. 
The Radius setting determines the size of the area around a shadow 
that will be aff ected. If you use a value that is too low, it can produce 
bright fringes, but if the value is too high, the eff ect will only be ap-
plied to large areas of uniform color. The dialog also provides Color 
and Midtone sliders in the Adjustments section of the dialog for color 
corrections and adjusting the midtone contrast in the areas you are 
currently correcting. Again, try not to set values that are too high. 
Leave the Black Clip and White Clip values unchanged. 

2. A “ contrast mask” is another eff ective way to brighten dark image 
areas. First, duplicate the background layer (Layer > Duplicate Layer), 
reduce saturation (Image > Adjustments > Desaturate), and convert 
the resulting image into a negative (Image > Adjustments > Invert, 
fi g. 334). You can then apply the Filter > Blur > Gaussian Blur fi lter us-
ing a Radius setting of between 5 and 15 pixels, according to the size 
of your image (fi g. 335). Switch the blend mode to Overlay and re-
duce opacity to between 30 and 50% (fi g. 336).

3.  Plug-ins like  LightMachine (from The Plugin Site) work on a simi-
lar basis but are more precise and off er more individual options 
(fi g. 337). LightMachine’s Shadows/Highlights Pro mode allows you to 
selectively brighten or darken parts of your image, while the Auto 
Mask and Fine-Tune options are designed to help you eliminate fring-
ing while preserving image contrast.

Fig. 334

Fig. 335

Fig. 336
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Fig. 338: Clockwise from 

top left: The unprocessed 

image, adjusted using the 

Shadows/highlights tool, 

adjusted using a contrast 

mask, and adjusted using 

LightMachine

Fig. 337
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 Before and After

Nothing better conveys the potential benefi ts of digitally editing architectural photos 
than before-and-after comparisons. You’ll fi nd two such illustrations below, each con-
sisting of one unaltered image (white balance was only set manually) and one image 
refl ecting all the fi nal edits. The interventions in these examples are not dramatic, 
but they improve the images noticeably. The types of edits are coded by color: blue 
indicates retouching edits; purple, perspective corrections; red, brightness and contrast 
changes; and turquoise, color manipulations.

The door was retouched (by mirroring the left side of the image)
The vertical beam was shifted to restore symmetry
The visually dominating vertical and horizontal contours were precisely aligned
The midtones and highlights in the glass were darkened to reduce refl ections
The brightness was corrected with a tone curve selectively applied to the most 
important layers of the image
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1
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 [aperture 11, 0,5 sec, ISO 100, 24mm focal length]

5
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 [aperture 9, 0,4 sec, ISO 100, 17mm focal length]

Distracting objects such as light switches, signs, and smoke detectors were retouched
The visually dominating vertical contours were precisely aligned
Areas of the room were brightened to establish a consistent quality of light and to create spatial depth
The false blue cast created by a light directly above the camera was desaturated
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4.4  Panoramas

Merging multiple source images to form a panorama is not a regular feature of 
an architectural photographer’s work, but some situations nevertheless make 
it a practical alternative shooting method. Panoramas can take on many forms, 
depending on the original concept for the image and the type and quality of 
your source images. Spherical panoramas are suitable for display in an interac-
tive context—for example, for displaying interiors on a computer. Cylindrical 
panoramas can be used to capture extremely wide angles of view and are thus 
suitable for portraying the complex architectural relationships that exist be-
tween multiple buildings on a single site. Flat (planar) panoramas and shift 
panoramas shot using tilt/shift lenses or shift adapters adhere to the rules of 
central projection and thus display buildings in a more familiar way. The fol-
lowing sections describe how to create planar panoramas for architectural use. 

4.4.1  Creating a Planar Panorama 

My first example shows three images of the German Historical Museum in Ber-
lin, shot handheld in portrait format without the use of any special accessories 
(fig. 339). There are a great many specialized “stitching” programs available for 
constructing panoramas, and the following sections illustrate the process us-
ing both the free, platform-independent Hugin package and Photoshop.

Workflow: Creating a Planar Panorama Using Hugin

1. Before you import your source images into Hugin, you should per-
form a RAW conversion that includes corrections for chromatic ab-
errations and vignetting artifacts, as these types of errors cannot 
be corrected later in the process. It is also advisable to correct any 
lens errors using a plug-in such as PTLens or LensFix before stitch-
ing; then you will no longer have to correct distortion using Hugin. 
Ideally, you should save your prepared source images in TIFF format 
rather than JPEG.

2. There are a few changes you should make to Hugin’s Prefer-
ences when you use the program for the first time. Check the 
Enable rotation search option in the Control Points Editor tab 
(fig. 340) and activate the cpfind + celeste (slower, but no cps on 
clouds) option as the default in the Control Point Detectors tab  
(fig . 341). You’ll get better results if you check the Use alternative En-
blend program option in the Programs tab (Enblend is included with 
the download) and select the path to the location where Enblend is 
stored (fig. 342).
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Fig. 339
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Fig. 343

Fig. 344
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3. Don’t use the Assistant, but instead switch to 
the Expert window (Interface > Expert, fi g. 343). 
I can now load my three source images using 
the Add images button  1 . The next step is to 
select the center image  2  and right click to 
activate the position and exposure anchor but-
tons  3 . For Lens type, select Normal (rectilin-
ear)  4 . You can also manually input the focal 
length and crop factor as needed, which may 
be the case if your camera doesn’t record Exif 
data with the images or if you use an adapted 
manual lens to shoot your images. I now use 
the Create control points button to automati-
cally detect overlaps between the images  5 . 

4. I made no changes to the Masks settings in my 
sample workfl ow. 

5. The settings in the  Control Points tab are an 
important factor in the production of high-
quality results. For my sample images, the 
program detected a large number of corre-
sponding points distributed throughout the 
frame (fi g. 344), but to ensure really accurate 
stitching, you should nevertheless set a few 
manual control points along the major edges 
of your subject. To do this, click on a relevant 
point in the left-hand image. This will then be 
magnifi ed in the preview window (fi g. 345). 
This makes it simple to select a distinctive 
detail—in my case, an edge of the building’s 
façade. The software usually fi nds the corre-
sponding point in the right-hand image, too 
(fi g. 346), although a little manual tweaking is 
sometimes necessary. Clicking Add confi rms 
the new control point and adds it to the list. 
This procedure can be repeated as often as 
necessary. 

6. Pressing the Re-optimize button (fi g. 347) 
prompts the software to align the source im-
ages with respect to all of the control points. 
The results were good for my example im-
age, especially when you consider that my 

Fig. 346

Fig. 345

Fig. 347
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sequence was spontaneous and was shot and panned handheld, 
and has an average control point distance of just 3.846632 pixels 
(fi g. 348).

7. At this stage, it’s worth opening the preview window (View > Pre-
view window, fi g. 349). This allows you to fi ne-tune and align your 
panorama as well as selecting the projection type. To create a 
planar panorama, select  Rectilinear  1 . If the preview image is too 
small, click Fit followed by Update  2 , or use the sliders to create a 
custom fi t  3 . The Straighten command  4  aligns your panorama 
fully automatically, although adjusting it manually usually leads to 
more accurate results. For a manual adjustment, click on a point 
that corresponds to the center of the panorama at camera level  5 . 
The program automatically eliminated the converging lines in my 
example. The preview window can now be closed.

Fig. 348

Fig. 349
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8. The fi nal Stitcher tab (fi g. 350) is where you activate the Calculate 
 fi eld of view  1 , Calculate optimal size  2 , and Panorama Outputs 
options. Select Exposure corrected, low dynamic range and select 
the TIFF fi le format  3  to retain the maximum possible image qual-
ity for subsequent processing. Make sure that you select the  En-
blend Processing option  4 . All that now remains is to click Stitch! 
and select a fi lename and the folder in which you want to save 
your panorama  5 . The program now stitches your source images 
together at full resolution. 

9. Use your favorite image-processing program to crop the fi nished 
panorama and perform any necessary fi ne-tuning steps. 

Fig. 350
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Workfl ow: Creating a  Planar Panorama Using Photoshop

1. Photoshop’s own panorama creation tool is less complex than Hu-
gin, but off ers fewer options in the course of the workfl ow. Open the 
tool using the File > Automate >  Photomerge command. The result-
ing dialog asks you to select your source images and, in contrast 
to many other panorama programs, also allows you to select RAW 
image fi les. Again, if you want to stitch RAW images to make a pan-
orama, perform any vignetting and chromatic aberration correction 
using a RAW converter fi rst. If you are using Adobe Camera Raw, all 
you have to do is click Done, and all changes you have made will 
then be incorporated in the subsequent panorama workfl ow. Once 
you have loaded your source images (mine are TIFF fi les) and se-
lected the Perspective option in the Layout section, click OK to start 
the automatic panorama creation process (fi g. 351).

2. Although Photoshop displays the fi nished panorama as a single im-
age, the individual source images are still stored on separate lay-
ers, making it simple to manually adjust the overlaps if necessary 
(fi g. 352). If you are stitching three or more source images and your 
fi nished panorama is obviously distorted toward one end, make 
sure that the center image is the last in the list when selecting your 
images (fi g. 353).

3. Use the Distort and Perspective options for the Edit >  Transform com-
mand to remove any converging lines (fi g. 354). Turning on the grid 
or rulers from the View menu helps you align your image.

4. Crop your results using the Crop tool (fi g. 355) and fi ne-tune bright-
ness, contrast, color, and sharpness as necessary (fi g. 143 shows my 
fi nished panorama).

Fig. 352

Fig. 351
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Fig. 355

Fig. 354

Fig. 353
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4.4.2    Shift Panoramas

Panorama source images that are shot using   shift lenses have a common line 
of vision. With regular shift lenses, the slightly shifted light path produces a 
very slight diff erence in perspective, which, in many cases, is negligible at the 
kinds of subject distances that are common in architectural photos. Some shift 
adapters are constructed in such a way that the adapter itself is attached to the 
tripod (fi g. 145), making it possible to produce panorama source images with 
perfectly superimposed overlaps. 

Workfl ow: Creating a Shift Panorama Using Photoshop

1. My sample source images were shot in portrait format using a 
24mm shift lens. The lens was shifted to “11 o’clock” in the fi rst im-
age and was then rotated through 60 degrees to “one o’clock” for 
the second. The result is two images with a large overlap. Fig. 356 
shows my identically converted source images opened in Photo-
shop. I then used the Move tool to position the left-hand image over 
the right-hand one (fi g. 357), which merges the two source images 
together. I now close the left-hand image and continue to work on 
the combined right-hand one. 

Fig. 357

Fig. 356
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Fig. 358

Fig. 362

Fig. 360

2. To automatically align the two layers, select both while pressing 
the Shift key (fi g. 358) and apply the  Auto-Align Layers command 
from the Edit menu (fi g. 359). Select the Perspective option in the 
dialog that follows and click OK (fi g. 360). Photoshop then aligns the 
layers and adjusts the size of the canvas appropriately. You can align 
images manually if you want, although this does involve a lot more 
eff ort. First, you have to extend the canvas to the right using the 
Layer > New > Layer from Background command, or by double click-
ing the Background layer in the Layers panel. You then have to use 
the Image > Canvas Size command (with the Relative option deacti-
vated) to select appropriate Width and Height values. Activate the 
right-hand center square as your Anchor (fi g. 361) to ensure that the 
canvas is extended to the left and click OK. Select a 100% view and 
reduce opacity for the upper layer to 50% and use the  Move tool to 
fi ne-tune the alignment—the reduced opacity makes it simple to 
superimpose details using the arrow keys (fi g. 362).

Fig. 361

Fig. 359
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3. A closer look at the automatically aligned image will reveal diff er-
ences in brightness where the two source images overlap (fi g. 363). 
Because lighting conditions are constantly in fl ux, these diff erences 
sometimes arise between the source images of shift panoramas 
(even when identical shooting settings are used). Even a tiny pause 
between photos is enough time for a hazy cloud to change the 
quality of the sunlight. The small movements of the  optical axis dur-
ing the shift process may also be enough for the mirror box to cast 
a slight shadow on one side of the image, or for bright refl ections 
or stray light to reduce the image’s overall contrast. To automati-
cally correct this type of error, use the  Auto-Blend Layers command 
from the Edit menu. Select the Panorama option in the following 
dialog and click OK. This blends the two source images seamlessly 
and creates manually adjustable layer masks for each (fi g. 364). You 
can now use the  Crop tool to iron out any remaining inconsistencies 
in the overlaps (fi g. 365). You can also perform the same procedure 
manually. This involves manually creating a soft overlap to coincide 
with details within the source images and disguise any mismatch 
caused by shifting the lens. Using selected image details for the 
overlap makes it much easier to hide than using an obvious straight 
edge. I created my overlap using a layer mask and the  Magnetic 
Lasso tool (though the  Polygon Lasso tool could be used as well) to 
make a selection that automatically adheres to the outline of the 
selected detail (fi g. 366). The selection can then be fi ne-tuned using 
the  Rectangular Marquee tool (with the shift key pressed) until the 
part of the upper layer that I wish to keep is precisely outlined (fi g. 
367). Clicking the Add Layer Mask button (fi g. 368) produces a subtle 
overlap that follows the textures within the image. The  Dodge and 
 Burn tools can then be used to correct any remaining diff erences in Fig. 365

Fig. 364

Fig. 363
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Fig. 366 Fig. 367

Fig. 368

Fig. 369 Fig. 370

brightness between neighboring image areas. Select a large, soft 
brush tip and a low Exposure value. The Range setting you use will 
depend on the overall brightness of the areas you are correcting 
(fi g. 369). It also helps to blur large areas of uniform color in the layer 
mask (such as the sky) using a large, soft brush tip and a very low 
Hardness value (fi g. 370). Setting a Feather value of between 5 and 
15 pixels is a fi nal touch that helps to make the overlap completely 
invisible.

4. You can now fl atten your image (Layer > Flatten Image), and con-
tinue with your workfl ow. Fig. 144 shows my fi nished panorama.



264 Image Processing

4.5   HDR and  DRI Images

HDR/DRI source images are shot using a bracketed sequence with varied ex-
posure settings. This technique is used to portray subjects whose  dynamic 
range exceeds that which the fi lm or image sensor being used can capture in 
a single image. HDR techniques merge the extended dynamic range encom-
passed in multiple source images into a single 32-bit high-dynamic-range 
(HDR) image which is then compressed using a technique called “tone map-
ping” into an 8-bit or 16-bit format that can be displayed or printed using 
conventional output devices. DRI techniques merge multiple source images 
without increasing bit depth. HDR images are generally less realistic looking 
than DRI images, making the latter preferable for situations in which realism 
is critical. 

There is a wide range of specialized HDR/DRI software available, and the 
following sections demonstrate how to perform the processes using the HDR 
and DRI-capable  Photomatix Pro 5 from HDRsoft, as well as using Photoshop. 
I’ll use Photoshop to perform automated 32-bit HDR processing as well as a 
manual DRI workfl ow. 

4.5.1   Workfl ow: 
Creating an HDR Image Using Photomatix Pro

Although Photomatix Pro is capable of opening a range of RAW formats, 
I converted my bracketed sequence (fi g. 371) in advance to 16-bit TIFF 
format. I took this route because lens-based errors such as chromatic ab-
erration or vignetting are more diffi  cult to correct once HDR processing 
has taken place.

Fig. 371
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1. Click the Load Bracketed Photos and select the images you want to 
merge in any order. It is not necessary to check the Show 32-bit un-
processed image option at this stage. Now click OK (fi g. 372). 

2. Even if you shot your source images using a tripod, you should ac-
tivate the Align source images > taken on tripod and Crop aligned 
images options in the dialog that follows. You only need to select 
the Show options to remove ghosts option if your source images con-
tain objects (such as people or tree branches) that moved between 
shots. This is not the case in my example. I also have no need for the 
Reduce noise on: and Reduce chromatic aberrations options, as these 
are only relevant when I am processing unconverted RAW images. 
Now click Align & Merge to HDR to continue (fi g. 373).

3. The following dialog includes tools for adjusting the parameters 
for both the  Details Enhancer and  Tone Compressor tone mapping 
methods. The dialog also includes a preview window that displays 
the changes you make in real time (fi g. 374) and a histogram dis-
play for checking the distribution of tonal values within your image 
(fi g. 375).

Fig. 374

Fig. 375

Fig. 373

Fig. 372
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4. The Details Enhancer tone mapping method increases local con-
trast and produces results that look more like a painting than a 
photograph (fi g. 186). To obtain a realistic-looking result, don’t 
overdo it with the Strength slider, which controls the extent to 
which the contrast is enhanced, and handle the Color Saturation 
slider on a case-by-case basis (fi g. 376). After that, adjust the sliders 
for Tone Compression (to modulate the dynamic range for the tone 
mapped image—negative values generally produce more realis-
tic-looking images) and Detail Contrast (to modulate how strongly 
detail contrast is boosted). The Lighting Adjustments slider has a 
strong infl uence on how natural or surreal the image appears and 
should generally be set toward the right side. You can further re-
fi ne your image with the Smooth Highlights feature under the More 
Options section. Adjusting this parameter allows you to reduce the 
contrast boost in the image highlights, which is useful if you want 
to remove halos around objects positioned in front of light back-
grounds. The White Point and Black Point sliders allow you to de-
fi ne the maximum and minimum values, respectively, for the tone 
mapped image. Adjustments to the midtones and color tempera-
ture can be made with the Gamma and Temperature sliders. The 
controls within the Advanced Options section are relatively self-
explanatory and off er yet additional ways to fi ne-tune your image. 
None of these additional variables were adjusted for my sample 
image. The optimum settings vary enormously from image to im-
age, so trial and error is the best way to fi nd out which work best. 
My aim was not to produce a dramatically tone-mapped image, 
but rather a natural looking one that forms the basis for further 
processing in Photoshop. Clicking the Apply button tone maps the 
image according to the settings made in the previous steps.

5. The tone-mapped image will now appear in the main program 
window. At this point, it’s still possible to correct contrast, color, 
and sharpness (fi g. 377), although I don’t apply any changes here 
in my example. Pressing the Save Final Image button allows you 
to save your image for further editing in Photoshop or other im-
age editing programs. You can also use the Save Settings button 
to save the settings you used as a preset for later application to 
other images. 

6. It is often useful to produce a second version of an image using 
the  Tone Compressor tone mapping method. This method makes 
global adjustments to contrast and off ers fewer processing op-
tions. It also tends to produce more natural looking results, al-
though detail in particularly bright or dark image areas gets lost 
more easily. Select the Tone Compressor method (fi g. 378) and use Fig. 376
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Fig. 378

Fig. 377

the Brightness, Tonal Range Compression, and Contrast Adaptation 
sliders to make the basic settings for your image. Here too, the set-
tings you make will depend on the type of image you are process-
ing and the results you are aiming for. The method’s other sliders 
are used to adjust image colors and to determine White Clip and 
Black Clip. Click Apply to apply your changes and save your image. 
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4.5.2  Workfl ow: 
 DRI Processing in  Photomatix Pro 

Photomatix Pro’s DRI functionality uses the image detail data stored in the 
highlights and shadows of your source images to create a new, enhanced-con-
trast image without altering the original color space or bit depth (i.e., no “real” 
HDR images are created during the process). 

1. Load your source images as described in the previous sections. 

2. Select the  Exposure Fusion process and the  Fusion/Natural method 
(fi g. 379). You can then use the sliders to adjust your image. The 
Strength slider (which controls how much local contrast is boosted) 
should not be moved too high. The Brightness slider determines 
how strongly each source image is weighted: higher values priori-
tize the brighter images and lower values, the darker ones. Local 
Contrast modulates the image’s detail contrast and overall impres-
sion of sharpness. The functions of the remaining sliders are similar 
to those described above for creating HDR images and allow for ad-
ditional fi ne tuning. Clicking anywhere in the preview image opens 
the Loupe window and gives you a detailed view of the eff ect of 
your adjustments (fi g. 380). Once again, clicking Apply merges the 
source images into one. 

Fig. 379 Fig. 380
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4.5.3  Workfl ow:
 Creating an HDR Image Using Photoshop

1. Photoshop’s own built-in HDR tool is located under the File > Au-
tomate >  Merge to HDR Pro command. Because the entire process 
takes place within the Photoshop environment, you can use any 
RAW format that is supported by Adobe Camera Raw. This tool, 
too, works best if you use it to merge ready-optimized RAW imag-
es, although you can use source images stored in any other com-
mon format as well (fi g. 381).

2. Clicking OK starts the automatic merging process. If your fi les con-
tain no Exif data for shutter speed, aperture, and ISO speed (page 
229), you can enter them manually in the Manually Set EV dialog 
that then appears automatically. The program window then in-
cludes thumbnails for each image that display the exposure incre-
ments used while shooting the sequence (fi g. 382). Removing the 
check mark from the box next to an image deactivates it. 

Fig. 381

Fig. 382
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Fig. 384

3. The correct choice of Mode is very important to the success of the 
procedure. If you select 8 Bit or 16 Bit, you can adjust your HDR con-
version parameters manually (Step 4), whereas if you select 32 Bit, 
the compilation process in this window ends and, assuming Com-
plete Toning in Adobe Camera Raw is checked, you’ll open the 32-bit 
fi le in ACR Converter (fi g. 383). The White Point Preview slider makes 
it easy to view the available tones and adjusts the brightness of 
the central preview image. The settings here alter only the rough 
HDR preview on your screen and not the actual range of contrast 
in your HDR image data. Once you open the image by pressing the 
Tone in ACR button, you can optimize your HDR image using the 
same methods of adjustment that will be familiar from the RAW 
conversion process (especially important are the values for Expo-
sure, Highlights, and Shadows, fi g. 384). And you can convert the 
image into a conventional 8-bit or 16-bit fi le (Image > Mode > 8 
Bits/Channel or 16 Bits/Channel and Method > Exposure and Gamma 
with the values 0.00 and 1.00, respectively). If you don’t check the 
box, you’ll create a 32-bit fi le, which can be saved and opened at 
a later point in time with ACR Converter for further editing. To do 

Fig. 383
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Fig. 385

this, open the already created 32-bit fi le in Photoshop and select 
Camera Raw Filter under the Filter menu.

4. There are various compression options available in 8-bit and 16-bit 
modes. Local Adaptation is the most fl exible (fi g. 385). I can’t make 
any concrete recommendations for the Radius and Strength set-
tings, but the ones shown in my example provided me with very 
good results. One very important factor in the compression pro-
cess is the selection of appropriate adjustments to the Tone Curve. 
Activate the Curve window and shift the ends of the curve itself 
to the ends of the histogram peaks. Giving the curve a slight “S” 
shape increases overall contrast if necessary. Once you have made 
all the necessary changes, click OK to open the compressed HDR 
image for further processing. If you’ve already saved your image 
in the 32-bit format during an earlier step and now would like to 
adjust the dynamic range, open the fi le in Photoshop. After navi-
gating to Image > Mode > 8 Bits/Channel or 16 Bits/Channel you’ll 
fi nd the HDR Toning dialog box, where you can adjust the familiar 
conversion parameters (fi g. 386). 

Fig. 386

HDR and DRI Images
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4.5.4  Workfl ow: 
 DRI Processing in Photoshop

1. Although Photoshop has no dedicated DRI tool, it is nevertheless 
possible to use it to manually merge individual source images 
from a bracketed sequence. To do this, use the File > Scripts >  Load 
Files into Stack command, choose your source fi les (fi g. 387), click 
Ok, and then arrange the layers according to the sequence of ex-
posure (the darkest image at the bottom). 

2. Now hide the upper (brighter) two layers by clicking on the eye 
icons in the Layers panel (fi g. 388) and activate the darkest image. 
Use the Select > Shadows option in the Select >  Color Range dialog 
to create a selection that includes only the darker parts of the low-
er image (fi g. 389). The Fuzziness and Range sliders can be left in 
their default positions, but tweaking them may be useful to carry 
out fi nal adjustments.

3. Activate and show the middle layer and click the Add Layer Mask 
button at the bottom of the Layers panel (fi g. 390). The parts of the 
layer mask that are black become transparent, while the original 
image remains visible in white areas.

4. Click the Mask Edge button in the Masks panel and activate the 
Smart Radius option with a value of between 40 and 80 pixels in 
the dialog that follows (fi g. 391). Set the Smooth and Contrast slid-
ers to 0 and Feather to less than 5. Click OK to confi rm your settings. 

5. Repeat the same procedure (steps 2–4) with the next overlying 
layer. But make sure that the top layer remains hidden. Then ac-
tivate the middle layer and once again select Shadows from the 
Color Range dialog. This time the same selection process will be 
applied to the top level, which will be made visible and adjusted 
with the Mask Edge button.

6. Reduce Opacity and Density (in the Masks panel) for the middle 
layers. I used values of 50% in my example. Proceed in the same 
way with the top layers (fi g. 392). You should treat the values rec-
ommended in this example as a rough starting point. The best set-
tings depend largely on the subject at hand.

7. Optimize your results by setting the Feather value in the Masks 
panel to between 100 and 250 pixels. This increases  local contrast, 
but can produce halos at the transitions between high-contrast 

Fig. 387

Fig. 388

Fig. 389
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Fig. 392 Fig. 393

Fig. 390 Fig. 391

and uniformly colored image areas. These 
can be removed by painting directly into the 
active layer mask using a using a soft, black 
brush with a large radius (fi g. 393).

8. You can further refi ne your results by experi-
menting with diff erent opacities and blend 
modes such as Screen.

9. Once you are done, fl atten your image to a 
single layer using the Layer > Flatten Image 
command.
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4.6    Creative Tips and Tricks

The following sections off er a few ideas for experiments in creative image 
processing. 

4.6.1  Digital  Graduated Filters

A physical graduated fi lter aff ects the amount of light reaching the fi lm or 
sensor during the exposure, whereas a digital fi lter can be applied only to 
the dynamic range of the captured image and is thus not as eff ective. It is 
nevertheless a useful tool that can be applied and removed at will using a 
separate layer. The steps for applying a digital gradient to my sample image 
(fi g. 394) are as follows:

Select black for the foreground color, which can be easily done by press-
ing the D key, a shortcut for resetting the foreground to the default. Create a 

Fig. 394

Fig. 395
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new fi ll layer using the Layer > New Fill Layer > Gradient command (or by click-
ing the Create a new fi ll or adjustment layer button in the Layers panel and 
selecting Gradient, fi g. 395). In the Gradient Fill dialog that follows, select the 
Linear Style option and an Angle value of 90. Now activate the Reverse and 
Align with layer options and make sure that the Scale value is set to 100 
(fi g. 396). Now double click the gradient thumbnail to activate the Gradient 
Editor. Select the Foreground to Transparent preset, and move the top right-
hand preview slider to the left until the Location value is 60% (fi g. 397). Now 
double-click OK to return to the main program window. Select the Soft Light 
blend mode for the new fi ll layer (fi g. 398). The new gradient fi ll can be ad-
justed at any time by double clicking the layer thumbnail. The sequence of 
steps described here can also be saved as a Photoshop action, which you can 
then apply automatically to any other image.

Fig. 398Fig. 397

Fig. 396
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4.6.2  Creating  HDR Eff ects Using a Single RAW Source Image

RAW fi les store much more detail than JPEG fi les, especially in highlights and 
shadows. This wealth of image data makes it possible to create pseudo-HDR 
images out of single RAW fi les with software programs such as Photomatix 
Pro. To get started, open the desired image fi le with the Load Single Photo but-
ton in the Workfl ow Shortcuts panel and confi rm the following window by 
pressing OK. This will convert your image into a pseudo-HDR image that can 
then be tone mapped in the usual way. This type of image displays more over-
bright highlights and more noise than a real HDR image created from a se-
quence of source images (fi g. 399). Photoshop has no built-in pseudo-HDR 
functionality, but can be used to process an (ideally 16-bit) image using the 
Image > Adjustments > HDR Toning dialog. You can also use Adobe Camera 
Raw to create two diff erently exposed versions of a single RAW fi le and manu-
ally merge them into a single DRI image (section 4.5.4). 

Fig. 399: 

Comparing an HDR 

image created from 

a bracketing 

sequence (on the left) 

with a pseudo-HDR 

image created using 

a single source photo
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4.6.3  Converting Images to 
 Black-and-White Using 
Photoshop 

Photoshop includes a simple and eff ec-
tive tool for converting color images to 
black-and-white. It is advisable to apply 
the eff ect on a separate adjustment lay-
er so that you can undo or adjust it if 
necessary. Either select the Black & White 
dialog in the Adjustments panel (fi g. 400) 
or use the Layer > New Adjustment Layer 
> Black & White command. The sliders in 
the dialog window allow you to adjust 
the strength of various tonal ranges for 
the newly created monochrome version 
of your image. The further to the right 
you move a slider, the lighter its corre-
sponding grayscale value will be, while 
the opposite is true for values toward 
the left end of the scale (fi g.  401). The 
tool includes a number of presets that 
simulate the eff ects of analog lens fi l-
ters. The Tint option can be used to give 
your image an overall tint, and the de-
fault tone is  sepia. You can adjust your 
black-and-white settings losslessly at 
any time by clicking on the adjustment 
layer thumbnail. You can also convert 
images to black-and-white in Photoshop 
by applying a saturation value of –100 in 
the Image > Adjustments >  Hue/Satura-
tion dialog, or by applying the Image > 
Adjustments > Desaturate command, al-
though both of these methods are not 
as fl exible as the Black & White tool. 
There are also a number of black-and-
white presets available in the Image > 
Adjustments > Channel Mixer dialog (be 
sure to activate the Monochrome op-
tion). The  Vibrance dialog can also be 
used to desaturate color images and you 
can, of course, perform monochrome 
conversion during RAW conversion, too. 

Fig. 400

Fig. 401
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4.6.4  Creating   Fake Miniatures Using Photoshop

To create a “fake miniature” look using Photoshop, you have to reduce depth 
of fi eld artifi cially by applying two focus gradients to an image. The most ef-
fective results can be produced using source images with relatively large 
depth of fi eld that were taken from a raised viewpoint (fi g. 402) and which 
contain a number of objects for comparing scale (in my example, cars). Ob-
jects in the near foreground spoil the eff ect, so try to avoid including any if 
possible. With version CS6, Photoshop has made it very easy to create minia-
ture eff ects by navigating to Filter > Blur (or Blur Gallery in Photoshop CC), and 
then selecting the  Tilt-Shift fi lter (fi g. 403). Then place the pin at the center of 
the area in your image where you would like the maximum sharpness to occur 
and adjust the two solid lines to modulate how much of your image should 
remain in focus: the area between these two lines will be sharp (a relatively 
narrow area of sharpness will create a more pronounced miniature eff ect). The 
area between the solid lines and dashed lines is a transition area, where the 
blur becomes more signifi cant and the image areas above the top dashed line 
and below the bottom dashed line feature the full blur eff ect. The Blur slider 
determines how pronounced the blur appears (it should be signifi cant). Press 
OK when you’re satisfi ed with the eff ect. The Distortion slider allows you to ap-
ply an element of motion to the blur in the blurred area in the bottom part of Fig. 402

Fig. 403



279

Fig. 406
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the image (and in the top part, too, if you select the Sym-
metric Distortion option). These adjustments are best ap-
plied only to highly abstract images.

It’s also possible to create a miniature eff ect manually. 
First set the foreground color to black. Then activate the 
Gradient Tool, double-click the gradient preview, and se-
lect the Foreground to Transparent preset in the Gradient 
Editor window (fi g. 404). Switch to Quick Mask Mode 
(fi g.  405). You can now create two gradients (marked in 
red), which show the areas of the image that will appear 
blurred in the fi nished version (fi g. 406). Switch back to 
Normal Mode (using the same button)—the red gradients 
will disappear and the area that is to remain in focus ap-
pears as a selection. Keep the selection active and select 
the Filter > Blur > Lens Blur fi lter (fi g. 407). Select a high Ra-
dius value and optimize the results by changing the Shape 
setting and adjusting the Blade Curvature and Rotation 
sliders. You can regulate the appearance of specular high-
lights by selecting appropriate Threshold and Brightness 
values. Leave all other sliders at their default or 0 settings, 
and click OK to apply the new gradients to your image. 
This can take some time, even if you are using a powerful 
computer, so be patient. You can then fi ne-tune the fi n-
ished image and accentuate the miniature eff ect by in-
creasing saturation and contrast as necessary.

Fig. 407

Fig. 405

Fig. 404





Have fun creating your own images in the endlessly inspiring world of  
architectural photography!
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